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Thank you for purchasing the Konica Minolta bizhub C351.

The bizhub C351 is equipped with an integrated printer controller that allows
you to print directly from Windows-compatible computers or Macintosh
computers.

This User’s Guide describes the printing functions, operations, usage, and
safety precautions of the printer controller. In order to ensure that this ma-
chine is used efficiently, carefully read this manual before using the machine.
In order to ensure that this machine is used safely, carefully read “Installation
and Operation Precautions” in the User’s Guide [Copy Operations] before
using the machine.

The illustrations used in this User’s Guide may differ from the actual model.

Trademarks and Copyright

o KONICA MINOLTA, the KONICA MINOLTA logo, and The essentials of
imaging are registered trademarks of KONICA MINOLTA HOLDINGS,
INC.

e PageScope and bizhub are registered trademarks of KONICA MINOLTA
BUSINESS TECHNOLOGIES.

o Netscape Communications, the Netscape Communications logo, Net-
scape Navigator, Netscape Communicator, and Netscape are trade-
marks of Netscape Communications Corporation.

e Novell and Novell NetWare are registered trademarks of Novell, Inc.

e Microsoft, Windows, and Windows NT are registered trademarks of Mi-
crosoft Corporation.

e |BM is a registered trademark of International Business Machines, Inc.

e Apple, Macintosh, and Mac are registered trademarks of Apple Compu-
ter, Inc.

e Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and the
PostScript logo are either registered trademarks or trademarks of Adobe
Systems Incorporated.

e Ethernet is a registered trademark of Xerox Corporation.

e PCL is aregistered trademark of Hewlett-Packard Company Limited.

e All other product and brand names are trademarks or registered trade-
marks of their respective companies or organizations.

e This machine and PageScope Box Operator are based in part on the
work of the Independent JPEG Group.

e Compact-VJE
Copyright 1986-2003 VACS Corp.

e RC4®isa registered trademark or trademark of RSA Security Inc. in the
United States and/or other countries.

C351

Download from Www.Somanuals.com. All Manuals Search And Download.



Welcome

e RSA®isa registered trademark or trademark of RSA Security Inc. in the
United States and/or other countries.

OpenSSL Statement
OpenSSL License

Copyright © 1998-2000 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modifica-
tion, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright no-
tice, this list of conditions and the following disclaimer in the documen-
tation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must
display the following acknowledgment:
“This product includes software developed by the OpenSSL Project for
use in the OpenSSL Toolkit. (http://www.openssl.org/)”

4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used
to endorse or promote products derived from this software without prior
written permission. For written permission, please contact openssil-
core@openssl.org.

5. Products derived from this software may not be called “OpenSSL” nor
may “OpenSSL” appear in their names without prior written permission
of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following ac-
knowledgment:
“This product includes software developed by the OpenSSL Project for
use in the OpenSSL Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND
ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIM-
ITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FIT-
NESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CON-
SEQENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCURE-
MENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young
(eay@crypt-Soft.com). This product includes software written by Tim Hud-
son (tjh@cryptsoft.com).

C351
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Original SSLeay License

Copyright © 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young (eay@crypt-
soft.com).

The implementation was written so as to conform with Netscapes SSL.
This library is free for commercial and non-commercial use as long as the fol-
lowing conditions are aheared to. The following conditions apply to all code
found in this distribution, be it the RC4, RSA, Ihash, DES, etc., code; not just
the SSL code.

The SSL documentation included with this distribution is covered by the
same copyright terms except that the holder is Tim Hudson (tjh@crypt-
soft.com).

Copyright remains Eric Young’s, and as such any Copyright notices in the
code are not to be removed. If this package is used in a product, Eric Young
should be given attribution as the author of the parts of the library used. This
can be in the form of a textual message at program startup or in documen-
tation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modifica-
tion, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list
of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright no-
tice, this list of conditions and the following disclaimer in the documen-
tation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must
display the following acknowledgement:

“This product includes cryptographic software written by Eric Young
(eay@crypt-soft.com)”

The word ‘cryptographic’ can be left out if the rouines from the library be-
ing used are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from
the apps directory (application code) you must include an acknowledge-
ment:

“This product includes software written by Tin Hudson (tjh@crypt-
soft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EX-
PRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AU-
THOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCI-
DENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILI-
TY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
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NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

The licence and distribution terms for any publically available version or de-
rivative of this code cannot be changed. i.e. this code cannot simply be cop-
ied and put under another distribution licence [including the GNU Public
Licence.]

All other product names mentioned are trademarks or registered trademarks
of their respective companies.

Copyright
© 2005 Konica Minolta Business Technologies, Inc. All Rights Reserved.

Note

e This User’s Guide may not be reproduced in part or in full without permis-
sion.

e Konica Minolta Business Technologies, Inc. will not be held liable for any
incidents caused by using this printing system or User’s Guide.

e Information included in this User’s Guide is subject to change without no-
tice.

e Konica Minolta Business Technologies, Inc. maintains the copyright of
the printer drivers.

C351
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SOFTWARE LICENSE AGREEMENT

This package contains the following materials provided by Konica Minolta
Business Technologies, Inc. (KMBT): software included as part of the printing
system, the digitally-encoded machine-readable outline data encoded in the
special format and in the encrypted form (“Font Programs”), other software
which runs on a computer system for use in conjunction with the Printing
Software (“Host Software”), and related explanatory written materials (“Doc-
umentation”). The term “Software” shall be used to describe Printing Soft-
ware, Font Programs and/or Host Software and also include any upgrades,
modified versions, additions, and copies of the Software.

The Software is being licensed to you under the terms of this Agreement.

KMBT grants to you a non-exclusive sublicense to use the Software and
Documentation, provided that you agree to the following:

1. You may use the Printing Software and accompanying Font Programs for
imaging to the licensed output de-vice(s), solely for your own internal
business purposes.

2. In addition to the license for Font Programs set forth in Section 1 (“Print-
ing Software”) above, you may use Roman Font Programs to reproduce
weights, styles, and versions of letters, numerals, characters and sym-
bols (“Typefaces”) on the display or monitor for your own internal busi-
ness purposes.

3. You may make one backup copy of the Host Software, provided your
backup copy is not installed or used on any computer. Notwithstanding
the above restrictions, you may install the on any number of computers
solely for use with one or more printing systems running the Printing Soft-
ware.

4. You may assign its rights under this Agreement to an assignee of all of
Licensee’s right and interest to such Software and Documentation (“As-
signee”) provided you transfer to Assignee all copies of such Software
and Documentation Assignee agrees to be bound by all of the terms and
conditions of this Agreement.

5. You agree not to modify, adapt or translate the Software and Documen-
tation.

6. You agree that you will not attempt to alter, disassemble, decrypt, re-
verse engineer or decompile the Software.

7. Title to and ownership of the Software and Documentation and any re-
productions thereof shall remain with KMBT and its licensor.

8. Trademarks shall be used in accordance with accepted trademark prac-
tice, including identification of the trademark owner’s name. Trademarks
can only be used to identify printed output produced by the Software.
Such use of any trademark does not give you any rights of ownership in
that trademark.

C351

Download from Www.Somanuals.com. All Manuals Search And Download.



Welcome

9.

10.

11.

12

You may not rent, lease, sublicense, lend or transfer versions or copies

of the Software Licensee does not use, or Software contained on any un-
used media, except as part of the permanent transfer of all Software and
Documentation as described above.

IN NO EVENT WILL KMBT OR ITS LICENSOR BE LIABLE TO YOU FOR
ANY CONSEQUENTIAL, INCIDENTAL INDIRECT, PUNITIVE OR SPE-
CIAL DAMAGES, INCLUDING ANY LOST PROFITS OR LOST SAVING,
EVEN IF KMBT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES, OR FOR ANY CLAIM BY ANY THIRD PARTY. KMBT OR ITS
LICENSOR DISCLAIMS ALL WARRANTIES WITH REGARD TO THE
SOFTWARE, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITA-
TION IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT OF THIRD
PARTY RIGHTS. SOME STATES OR JURISDICTIONS DO NOT ALLOW
THE EXCLUSION OR LIMITATION OF INCIDENTIAL, CONSEQUENTIAL
OR SPECIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT AP-
PLY TO YOU.

Notice to Government End Users: The Software is a “commercial item,”
as that term is defined at 48 C.F.R.2.101, consisting of “commercial com-
puter software” and “commercial computer software documentation,” as
such terms are used in 48 C.F.R. 12.212. Consistent with 48 C.F.R.
12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4, all U.S. Govern-
ment End Users acquire the Software with only those rights set forth
herein.

. You agree that you will not export the Software in any form in violation of

any applicable laws and regulations regarding export control of any
countries.

C351
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About this User’s Guide

This User’s Guide contains information for using the printing functions of the
Konica Minolta printer controller. For details on the copy functions, scanning
functions, box functions, and fax functions, refer to the respective User’s
Guide.

This User’s Guide is aimed at users who already have a basic knowledge of
computer and copier operations. For Windows or Macintosh operating sys-
tem and application operations, refer to the operation manual of the respec-
tive product.

C351 User’s Guides

The User’s Guides for this machine are divided by function and consist of the

following:
User’s Guide Details
Print Operations This User’s Guide. Read this guide when using this ma-
chine as a printer.
Printer Operations Quick Guide Read this guide when using this machine as a printer.
Network Scanner Operations Read this guide when using this machine as a scanner.
Box Operations Read this guide when using this machine’s box functions.
Facsimile Operations Please read this guide when using this machine’s fax func-
tions.
Notations
Product Name
KONICA MINOLTA C351 This machine, copier, or printer
This machine
Integrated network controller Network controller
Printer controller, including this Printing system
machine, and printing system
Microsoft Windows Windows

Screen Images in This User’s Guide

Unless stated otherwise, the printer driver functions are described using the
printer driver for Windows XP.

C351 x-17
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Using This User’s Guide

Various Printing Methods 4

4  Various Printing Methods

SUbJeCt titles 41 Printing Operations

For Windows

Data can be printed from an application.

Print jobs are specified from the application software.
Explains the operation ———————> 1 open the datan the application, “Fie",and then ik ‘Print
procedure. >

Check that the printer name has been selected.
If the printer is not selected, click the [¥] and select the printer.

Windows, dialog boxes,
icons, and function names e I

displayed on the screen e —— = ‘

are enclosed in “ .

Drwinps [Pewon

Button names displayed
on the screen are
enclosed in[ 1.

[T P

bl gopms [T 8 ‘

ey GG |

Contents displayed on ————
a screen.

3 Specify the page range and the number of copies to print.

Q.
Additional explanation ——f—> note
Of th e t eXt | s gIV en The Print dialog box differs d epending on the application.

cast 41

(The page shown above is an example only.)
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Download from Www.Somanuals.com. All Manuals Search And Download.



Overview 1

1

1.1

Overview

Printer Controller CD-ROM Configuration

The printer controller CD-ROMs consist of the following:
e User Software CD-ROM
e PostScript Printer Driver CD-ROM (Win/Mac)

Each CD-ROM contains printer drivers (for Windows and for Macintosh) and

utilities as well as screen fonts and documentation, such as the User’s

Guides and release notes.

The configuration of the printer drivers on the CD-ROM is shown below.

Browse through the CD-ROMs for the desired folders and files.

e The folder and file names may not be listed below starting from the root
directory.

e Use all of the files in the EN (English) folder.

C351
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User Software CD-ROM: For Windows

T Readme
BoxOperator —— setup.exe
— DataAdmin Manual
—E setup.exe
UserTool — setup.exe
—Driver ———— Drivers bizhubC351 — EN —— Win2000_XP
F— Win9X_Me
— WiIinNT
— FR —— Win2000_XP
— Win9X_Me
— WiIinNT
— DE —— Win2000_XP
— Win9X_Me
— WiIinNT
—IT —— Win2000_XP
— Win9X_Me
— WiIinNT
— ES —— Win2000_XP
— Win9X_Me
— WiIinNT
—JA —— Win2000_XP
—— Readme — Win9X_Me
——— P2P — WiIinNT
Userlnst.exe
UinsExec.exe
~J2RE —— j2re-1_4_2_06-windows-i586-p.exe
—JobSpooler Manual
—I: PSJS_1.0.1.6_win.exe
~Manual
—Peer2Peer Manual
E Readme
setup.exe
I—ScreenFont Readme
|: Font file
PSNCPIlugin
~Twain HDD TWAIN ————————— EN — setup.exe
— FR — setup.exe
— DE — setup.exe
— IT — setup.exe
— ES — setup.exe
— JA — setup.exe
Real-Time Mode TWAIN —— EN — setup.exe
— FR — setup.exe
— DE — setup.exe
— IT — setup.exe
- WebConnect T Manual — ES — setup.exe
Readme — JA — setup.exe

C351
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+ Driver —

L Screenfonts

PostScript Printer Driver CD-ROM (Win): For Windows

PS-PPD EN Win9x_Me
FR Win9x_Me
DE Win9x_Me
IT Win9x_Me
ES Win9x_Me
JA Win9x_Me
Drivers —— bizhub C351 EN —— WinNT/Win2000_XP

FR —— WinNT/Win2000_XP
DE —— WinNT/Win2000_XP
IT  —— WinNT/Win2000_XP
ES —— WinNT/Win2000_XP
JA — WinNT/Win2000_XP

PostScript Printer Driver CD-ROM (Mac): For Macintosh

T English —

—Japanese —j

—German

— Francais(French)
r— Italiano(ltalian)

— Espanol(Spanish)

Driver 0S 9_x —— KONICAMINOLTAC351Vxxx.ppd
E 0S10_2_X —— KONICAMINOLTA_C351_102.pkg
0810_3_X —— KONICAMINOLTA_C351_103.pkg

Screen Fonts

Driver 0S8 9_x —— KONICAMINOLTAC351Vxxx.ppd
E 0S10_2_X —— KONICAMINOLTA_C351_102.pkg
0S10_3_X —— KONICAMINOLTA_C351_103.pkg

Screen Fonts

* The folders and files for languages other than English and Japanese are
structured in the same way.

C351
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1.2  Printer Controller
The printer controller is a device for performing printing functions and net-
work printing functions with this machine.
Role of the Printer Controller
The printer controller is built into the machine.

You can print from applications on the computer connected to the printing
system. When using this machine as a network printer, you can print from
applications on the computer.

............ Printing system
Machine _ Computer

a

O=
Print 8
ccr:rrwltrecgller —

Available Printer Controller Functions

The printer controller provides the following functions.

e Printing from a computer (using the PCL printer driver or PS printer driver)

e Support of network protocols including TCP/IP, NetBEUI, IPX/SPX, and
AppleTalk

e Direct printing over a network using SMB (Windows), LPR, and IPP print-
ing

e Fax operations using a computer (fax transmission)

e Access to settings for this machine and the printer controller from a client
computer over the network (using a Web browser)

e Control of the number of pages printed (“User Authentication” and “Ac-
count Track” functions)

C351
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Machine Modes

The printer driver settings are mainly set using a computer, however, the font
list can be printed, and the printer controller settings and default print set-
tings can be set using the control panel of this machine. In addition, fax and

scanning operations can be used by switching the mode.

To switch between modes, press the mode keys on the control panel.

= o
2
Accesshilty Mode Memory :
\ Main Power
[Copy]

This machine can be used as a copier.

[Scan]

This machine can be used as a scanner.

[Fax]

This machine can be used for faxing.

[Box]

This machine can be used to store jobs and as a document folder for for-

warding data to a computer over the network.

V...

Note

You can use this machine as a printer in all modes.

Change the default print settings in the Utility mode.

C351
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Printing Flow

When using this printing system as a printer, the flow of the main process is
described below.

Print commands transmitted from the application are received by the printer
driver.

Data is transmitted to this machine over a parallel interface (IEEE 1284) when
this machine is used as a local printer, over a USB interface when this ma-
chine is used as a USB printer, or over an Ethernet interface (TCP/IP, IPX/
SPX, or AppleTalk) when this machine is used as a network printer. The data
is then delivered from this machine to the printer controller, which performs
image rasterization (development of output characters and images to bitmap
data). Finally, this data is printed from this machine.

V...

Note
The parallel and USB interfaces cannot be used simultaneously.

Computer
Used as alocal Used as a USB Used as a
printer printer network printer
‘ Application ‘ ‘ Application ‘ ‘ Application ‘
‘ Printer driver ‘ ‘ Printer driver ‘ ‘ Printer driver ‘
L Parallelinterface || | Jéé 777777 L | [ [Ethernet (TCP/IP, IPX/_|
4 (IEEE 1284) H H SPX, or AppleTalk)
Machine

Print | i

Printer controller

PS/PCL processing (rasterizing)

The copy functions can be used while the printing functions are being used.
To use this machine as a copier, press the [Copy] key on the control panel.

C351
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When a print job is received during copying, the data is stored in the memory
of this machine. When copying is complete, the print job is automatically
printed.

Flow of the Computer Faxing Operation

Conventionally, faxes are sent by loading an original into a fax machine and
sending it.

With computer faxing, you can send a fax directly from your computer with-
out using any paper.

Transmission commands sent from the application are received by the print-
er driver.

Data is transmitted to this machine over a parallel interface (IEEE 1284) when
this machine is used as a local printer, over a USB interface when this ma-
chine is used as a USB printer, or over an Ethernet interface (TCP/IP, IPX/
SPX, or AppleTalk) when this machine is used as a network printer. The data
is then delivered from this machine to the printer controller, which performs
image rasterization (development of output characters and images to bitmap
data). Finally, this data is stored in the memory of this machine and transmit-
ted like a conventional fax job.

Computer
Used as a local Used as a USB Used as a
printer printer network printer
‘ Application ‘ ‘ Application ‘ ‘ Application ‘
‘ Printer driver ‘ ‘ Printer driver ‘ ‘ Printer driver ‘
L Parallel interface 1] L U SB t| LiEthemet (TCP/IP, IPX/ ]
—___(EEE1284) r—  T°7 I SPX or AppleTally
Machine

Print ‘: i

Printer controller

PS/PCL processing (rasterizing)

C351

Download from Www.Somanuals.com. All Manuals Search And Download. 1-7



Overview

1.3 Operation Environment
The system requirements for using this printing system and the interfaces
used for connection are explained below.
Compatible Computers and Operating Systems
Check that the computer being connected meets the following conditions.
Windows
Item Operating Environment
Operating System Windows 98 Second Edition, Windows Me, Windows NT 4.0
(Service Pack 6a or later), Windows 2000 Professional (Serv-
ice Pack 4a or later), Windows XP Home Edition (Service Pack
1 or later), Windows XP Professional (Service Pack 1 or later),
or Windows Server 2003
Processor Pentium or higher
Memory Capacity recommended for the operating system
With sufficient memory resources in the operating system and
application being used
Drive CD-ROM
Web Browser (when using Pag-| Microsoft Internet Explorer 6 or later recommended (JavaS-
eScope Web Connection) cript enabled, Cookies enabled)
Microsoft XML Parser MSXML3.X must be installed when us-
ing Internet Explorer 5.X.
Netscape Navigator 7.02 or later (JavaScript enabled, Cook-
ies enabled)
J2RE (Java 2 Runtime Environment) required
Macintosh
Item Operating Environment
Operating System Mac OS 9.2, Mac OS X 10.2, or Mac OS X 10.3
Processor PowerPC
Memory Capacity recommended for the operating system
Drive CD-ROM
Web Browser (when using Pag-| Netscape Navigator 7.02 or later (JavaScript enabled, Cook-
eScope Web Connection) ies enabled)
C351 1-8

Download from Www.Somanuals.com. All Manuals Search And Download.



Overview 1

Compatible Interfaces

The various interfaces that can be used to connect this printing system to a
computer are described below.

Ethernet Interface
Connect when using this printing system as a network printer.

Supports 10Base-T and 100Base-TX standards. In addition, the Ethernet in-
terface supports the TCP/IP (LDP/LPR, peer-to-peer), IPX/SPX (NetWare),
and AppleTalk (EtherTalk) protocols.

Parallel Interface (optional)
Connect when using this printing system as a local printer.

A computer running Windows and an IEEE 1284 parallel cable are required
for connection. Use a parallel cable that uses a terminal with an Amphenol
36-pin male connector.

The parallel interface supports the compatible, nibble, and ECP modes.

USB Interface (optional)
Connect when using this printing system as a network printer.

The USB interface can be connected to a computer running Windows or to
a Macintosh computer. A USB cable is required for connection. Use a type
A (4 pin, male) or type B (4 pin, male) USB cable. A USB cable measuring 3
meters or less is recommended.

The parallel and USB interfaces cannot be used simultaneously. You can
switch the interfaces in the administrator mode.

C351
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Connection Diagram

The printer cables can be connected to each port at the back of this ma-

chine.

Machine (rear view)

User port

USB
cable

T
M]
A T

TIET
Parallel  Parallel

cable port

gEthernet

(10Base-T or
100Base-TX)

C351
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1.4  Setting Up the System
In order to use this printing system, it must first be set up.
Setup consists of connecting this machine to a computer and installing the
printer driver onto the computer being used.
To set up the printing system
Setup of the printing system as described below.
Connect this machine to a computer. (Refer to “Compatible Interfaces”
on page 1-9.)
Install the printer driver. (Refer to “Installing the Printer Driver” on
page 2-1.)
When using a network connection, set up the network. (Refer to “Set-
ting Up Network Printing” on page 3-1.)
Check the setup by printing a test page. (Refer to “Test Printing” on
page 4-2.)
Install the screen fonts.
— The User Software CD-ROM and the PostScript Printer Driver CD-
ROM contain the Latin TrueType fonts as screen fonts.
— Install the screen fonts after adding the operating system standard
fonts.
— For details, refer to Help of the operating system.
— The CD-ROM “Screenfont” or “Screenfonts” folder contains the
screen fonts.
— The Macintosh fonts are compressed. Install the fonts after decom-
pressing them.
Installation of the printer driver may differ depending on the connection
method used with this machine in addition to the operating system of the
computer and the type of printer driver being used.
Detail
For details on connecting this machine to a computer, refer to “Compat-
ible Interfaces” on page 7-9.
C351 1-11
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N

Note

To update an existing printer driver, delete the existing printer driver first.
For details, refer to “Uninstalling the Printer Driver” on page 2-15 and
page 2-21.

As necessary, set the interface timeout settings and parallel interface
mode (Compatible, Nibble, or ECP) in the Utility mode on the control pan-
el. For details, refer to “Printer Settings in Administrator Mode” on

page 10-21.

When using the parallel or USB local port, you must select the port being
used. For details, refer to “Parallel/USB” on page 10-26.
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[ |1
2 Installing the Printer Driver

21 Printer Drivers and Supported Operating Systems

In order to use this printing system, the printer driver must be installed. The
printer driver is a program that controls the processing of data for output. In-
stall the printer driver onto the computer from the provided CD-ROM.

The printer drivers included on the CD and the supported computer operat-
ing systems are listed below. Install the required printer driver.

Page Description Printer Driver Supported Operating Systems
Language

PCL Konica Minolta Driver Windows 98 Second Edition, Windows Me,
(PCL XL) Windows NT 4.0 (SP6a),

Windows 2000 Professional,
Windows XP Home Edition, Windows XP Pro-
fessional, and Windows Server 2003

PostScript 3 Konica Minolta (PS Windows NT 4.0 (SP6a),

Emulation Visual) Windows 2000 Professional,

Windows XP Home Edition, Windows XP Pro-
fessional, and Windows Server 2003

PostScript PPD Driver | Windows 98 Second Edition, Windows Me

Mac OS 9.2 or later, Mac OS X 10.2, and Mac
0S X 10.3

* The User Software CD-ROM contains the PCL printer driver, and the PostScript Printer Driver
CD-ROM contain the PostScript driver.

C351 2-1
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2.2 When Used With Windows

The installation procedure for the Windows printer driver differs depending
on how this machine is connected to the computer and depending on which
printer driver is used. The installation method also differs depending on the
version of Windows that you are using. Refer to the table below for the ap-
propriate procedure for installing the printer driver on your computer.

Printer Driver | Connection Method Refer To

PCL All connection methods | “Automatic Installation Using the Installer” on
page 2-3

PostScript Network connection “Installing the Printer Driver Using the Add Printer
PCL Wizard” on page 2-7

“For Windows 98SE/Me/2000/NT 4.0” on

page 2-10

“For Windows XP/Server 2003” on page 2-7

Parallel connection “Installing the Printer Driver Using Plug and Play”
on page 2-12

“For Windows 98SE” on page 2-12

“For Windows Me/2000” on page 2-13

“For Windows XP/Server 2003” on page 2-14

“Installing the Printer Driver Using the Add Printer
Wizard” on page 2-7

“For Windows 98SE/Me/2000/NT 4.0” on

page 2-10

“For Windows XP/Server 2003” on page 2-7

USB connection “Installing the Printer Driver Using Plug and Play”
on page 2-12

“For Windows 98SE” on page 2-12

“For Windows Me/2000” on page 2-13

“For Windows XP/Server 2003” on page 2-14

...

Note

For details on installing the printer driver in a network environment, refer
tfo “Setting Up Network Printing” on page 3-1. Because it is necessary to
specify other network settings in advance when installing the printer driv-
er using a network connection, install it using a local connection at this
time.

To install the printer driver under Windows XP, Windows Server 2003,
Windows 2000, or Windows NT 4.0, log on using a user name that is au-
thorized by the administrator.

To connect this machine to a computer using a parallel connection or a
USB connection, the optional local interface kit is required.
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Automatic Installation Using the Installer

With the installer, this machine is detected to determine whether it is con-
nected by USB or is on the same TCP/IP network as the computer, and then
the required printer driver is automatically installed. You can also manually
specify the printer driver to be installed. To specify the printer driver manu-
ally, specify the printer and copier you want to install, and then install it.

...

Note

Since this machine is automatically detected with a network connection,
be sure to set the IP address of this machine before connecting it. For de-
tails on specifying the settings, refer to “Setting the IP Address for This
Machine” on page 3-5.

When installing on Windows NT 4.0, 2000, XP, or Server 2003, adminis-
trator permissions are required.

Ifthe wizard starts up in order to add new hardware with a USB or paralle/
connection, click [Cancel].

For IPP printing, it is not necessary to install the printer driver at this time
since IPP printing setup is performed when the printer driver is installed.
For further details on IPP printing, refer to “IPP Printing (Windows 2000/
XP/Server 2003)” on page 3-12.

Installer Operating Environment

Item Operating Environment

Operating System Windows 98 Second Edition, Windows Me, Windows NT 4.0 (Serv-
ice Pack 6a or later)*, Windows 2000 Professional (Service Pack 4 or
later), Windows XP Home Edition (Service Pack 1 or later), Windows
XP Professional (Service Pack 1 or later), or Windows Server 2003

Processor Pentium 300 MHz or higher recommended

Memory 64 MB or more (128 MB or more recommended)

* With Windows NT 4.0, in order to install a machine that is connected directly to a network using
the TCP/IP protocol, Windows TCP/IP Printing Services must first be installed on the computer
being used.
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To install the printer driver

1 Insert the User Software CD-ROM into the computer’s CD-ROM drive.

The installer starts up.

2 Click “Printer Install”.

The installation of the printer driver starts.
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2

3 Click the [AGREE] button if you agree with all terms and conditions of
the license agreement.

— If you do not agree with the terms and conditions of the license

agreement, the software cannot be installed.
— You can change the display language of the installer box in the low-

er-left corner.
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4 Whenthe setup selection dialog box appears, click the “Install printers/

MFPs” button.

The connected printers and copiers are detected.
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5

Select this machine and proceed with the installation.

Follow the on-screen instructions to complete the installation.
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If the connection of this machine cannot be recognized or for par-
allel connections, the machine will not be listed. When this occurs,
select “Specify the Printer/MFP”, and then specify this machine di-

rectly.
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Installing the Printer Driver Using the Add Printer Wizard

...

Note
For IPP printing, it is not necessary to install the printer driver at this time
since IPP printing setup is performed when the printer driver is installed.

For further details on IPP printing, refer to “IPP Printing (Windows 2000/
XP/Server 2003)” on page 3-12.

V...

Note

For details on installing the printer driver in a network environment, refer
tfo “Setting Up Network Printing” on page 3-1. Because it is necessary to
specify other network settings in advance when installing the printer driv-

er using a network connection, install it using a local connection at this
time.

For Windows XP/Server 2003
1

Insert the Windows printer driver CD-ROM into the computer’s CD-
ROM drive.

— Konica Minolta PCL Driver: User Software CD-ROM

— Konica Minolta PostScript Driver: PostScript Printer Driver CD-
ROM

Click the [Start] button, and then click “Printers and Faxes”.

For Windows XP, click “Add a printer” on the “Printer Tasks” menu.

— For Windows Server 2003, double-click the “Add Printer” icon.
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Windows XP Windows Server 2003
The Add Printer Wizard starts up.
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4 Click the [Next] button.
5  Sselect “Local printer attached to this computer”, and then click the
[Next] button.

— Clear the “Automatically detect and install my Plug and Play print-
er” check box.
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6 The Select Printer Port dialog box appears. Select “LPT1” here, and
then click the [Next] button.

7 Clickthe [Have Disk] button.
8  Click the [Browse] button.

9 Specify the folder on the CD-ROM that contains the printer driver for
the operating system that you are using, and then click the [OK] button.

— Konica Minolta PCL Driver: User Software CD-ROM
“Driver\Drivers\bizhubC351” folder

— Konica Minolta PostScript Driver: PostScript Printer Driver CD-
ROM “Driver\Drivers” folder

10 Click the [OK] button.
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— The “Printers” list appears.
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11 click the [Next] button.

1 2 Follow the on-screen instructions.

— When the Digital Signature message appears, click the [Continue]
button.

— When using a network connection, perform a test print after the net-
work settings have been specified.

1 3 When installation is complete, make sure that the icon of the installed
printer appears in the Printers and Faxes window.

14 Remove the CD-ROM from the CD-ROM drive.

This completes the printer driver installation.
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For Windows 98SE/Me/2000/NT 4.0

1 Insert the Windows printer driver CD-ROM into the computer’s CD-
ROM drive.

— Konica Minolta PCL Driver: User Software CD-ROM

— Konica Minolta PostScript Driver: PostScript Printer Driver CD-
ROM

2 Click the [Start] button, point to “Settings”, and then click “Printers”.

The Printers window appears.

3 Double-click the “Add Printer” icon.
The Add Printer Wizard starts up.

4 Follow the on-screen instructions.

5 On the screen for selecting the printer connection, select “Local Print-
er”.
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6 Click the [Next] button.
7 Clickthe [Have Disk] button.

8 Clickthe [Browse] button.
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9 Specify the directory on the CD-ROM that contains the printer driver for
the operating system that you are using, and then click the [OK] button.

For Windows 98SE/Me

Konica Minolta PCL driver: User Software CD-ROM
“Driver\Drivers\bizhubC351” folder

PostScript PPD driver: PostScript Printer Driver CD-ROM
“Driver\PS-PPD” folder

For Windows 2000

Konica Minolta PCL driver: User Software CD-ROM
“Driver\Drivers\bizhubC351” folder

Konica Minolta PostScript driver: PostScript Printer Driver CD-
ROM “Driver\Drivers” folder

For Windows NT 4.0

Konica Minolta PCL driver: User Software CD-ROM
“Driver\Drivers\bizhubC351” folder

Konica Minolta PostScript driver: PostScript Printer Driver CD-
ROM “Driver\Drivers” folder

10 Click the [OK] button.

The “Printers” list appears.

Add Printer Wizard

=

Frinters:

¥ installation digk, click Have Digk. If pour printer iz not listed, consult pour printer

KOMICA MINOLTA 351 PCL

Click the manufacturer and model of pour printer. IF your printer came with an

documentation for a compatible printer.

< Back | Mext » Cancel

11 Click the [Next] button.

12 Specify the connection port. Select “LPT1” here.

1 3 Follow the on-screen instructions.

When using a network connection, perform a test print after the net-
work settings have been specified.

C351
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14 When installation is complete, make sure that the icon of the installed

printer appears in the Printers window.

15 Remove the CD-ROM from the CD-ROM drive.

This completes the printer driver installation.

Installing the Printer Driver Using Plug and Play

For Windows 98SE

1

After using a parallel cable or a USB cable to connect this machine to
a computer, turn on the computer.

— Do not disconnect or connect the cable while the computer is start-
ing up.

Insert the Windows printer driver CD-ROM into the computer’s CD-

ROM drive.

— Konica Minolta PCL Driver: User Software CD-ROM
— Konica Minolta PostScript Driver: PostScript Printer Driver CD-
ROM

Turn the main power of this machine on.
The Add New Hardware Wizard starts up.

Click the [Next] button.

Select “Search for the best driver for your device (Recommended)”,
and then click the [Next] button.

Select “Specify a location”, and then click the [Browse] button.

Specify the folder on the CD-ROM that contains the printer driver for
the operating system that you are using, and then click the [OK] button.

— Konica Minolta PCL Driver: User Software CD-ROM
“Driver\Drivers\bizhubC351” folder

— PostScript PPD driver: PostScript Printer Driver CD-ROM
“Driver\Drivers” folder

Click the [Next] button, and then follow the on-screen instructions.

The Add New Hardware Wizard dialog box appears again. Repeat
steps 4 through 8.

C351
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When installation is complete, make sure that the icon of the installed
printer appears in the Printers window.

Remove the CD-ROM from the CD-ROM drive.

This completes the printer driver installation.
For Windows Me/2000

After using a parallel cable or a USB cable to connect this machine to
a computer, turn on the computer.

— Do not disconnect or connect the cable while the computer is start-
ing up.

Insert the Windows printer driver CD-ROM into the computer’s CD-
ROM drive.

— Konica Minolta PCL Driver: User Software CD-ROM
— Konica Minolta PostScript Driver: PostScript Printer Driver CD-
ROM

Turn the main power of this machine on.

- For Windows Me
The Add New Hardware Wizard starts up.
— For Windows 2000
The Found New Hardware Wizard starts up.

Select “Search for a suitable driver for my device (recommended)” (for
Windows Me, select “Automatic search for a better driver (Recom-
mended)”), and then click the [Next] button.

For Windows 2000, select “Specify a location”, and then click the
[Next] button.

For Windows Me, select “Specify a Location”, and then click the
[Browse] button.

Specify the folder on the CD-ROM that contains the printer driver for
the operating system that you are using, and then click the [OK] button.
Printer drivers that can be selected:

— For Windows Me
Konica Minolta PCL driver: User Software CD-ROM
“Driver\Drivers\bizhubC351” folder
Postscript PPD: PostScript Printer Driver CD-ROM
“Driver\PS-PPD” folder

C351
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— For Windows 2000
Konica Minolta PCL driver: User Software CD-ROM
“Driver\Drivers\bizhubC351” folder
Konica Minolta PostScript driver: PostScript Printer Driver CD-
ROM
“Driver\Drivers” folder

Click the [OK] button (for Windows Me, click the [Next] button), and
then follow the on-screen instructions.

Click the [Finish] button.

When installation is complete, make sure that the icon of the installed
printer appears in the Printers window.

Remove the CD-ROM from the CD-ROM drive.

This completes the printer driver installation.
For Windows XP/Server 2003

After using a parallel cable or a USB cable to connect this machine to
a computer, turn on the computer.

— Do not disconnect or connect the cable while the computer is start-
ing up.

Insert the Windows printer driver CD-ROM into the computer’s CD-
ROM drive.

— Konica Minolta PCL Driver: User Software CD-ROM
— Konica Minolta PostScript Driver: PostScript Printer Driver CD-
ROM

Turn the main power of this machine on.

The Found New Hardware Wizard starts up.

If the Add New Hardward Wizard does not appear, turn the power of
this machine off, then on again.

When turning the main power switch OFF then ON, wait for 10 seconds
or longer before turning it ON again; otherwise the copier may not func-
tion normally.

Select “Install from a list or specific location (Advanced)”, and then
click the [Next] button.

Under “Search for the best driver in these locations”, select “Include
this location in the search”, and then click the [Browse] button.
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6

10

Depending on the operating system and printer driver that you are us-
ing, specify the folder on the CD-ROM that contains the printer driver,
and then click the [OK] button.

Konica Minolta PCL driver: User Software CD-ROM
“Driver\Drivers\bizhubC351” folder

Konica Minolta PostScript driver: PostScript Printer Driver CD-ROM
“Driver\Drivers” folder

Click the [Next] button, and then follow the on-screen instructions.

— When the Digital Signature dialog box appears, click the [Continue]
button.

Click the [Finish] button.

When installation is complete, make sure that the icon of the installed
printer appears in the Printers and Faxes window.

Remove the CD-ROM from the CD-ROM drive.

This completes the printer driver installation.

Uninstalling the Printer Driver

If it becomes necessary to delete the printer driver, for example, when you
want to reinstall the printer driver, follow the procedure below to delete the
driver.

1

For Windows 98SE/Me/2000/NT 4.0, click the [Start] button, point to
“Settings”, and then click “Printers”.

For Windows XP/Server 2003, click the [Start] button, and then click
“Printers and Faxes”.

In the Printers window (for Windows XP/Server 2003, Printers and Fax-
es window), select the icon of the printer that you want to delete.

Press the [Delete] key on the computer keyboard to delete the printer
driver.

Follow the on-screen instructions.

When the printer driver has been deleted, the printer icon will disappear
from the Printers window (for Windows XP/Server 2003, Printers and
Faxes window).

This completes the uninstallation procedure.

C351
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2.3 When Used With Macintosh
The installation procedure for the Macintosh printer driver differs depending
on the Mac OS version and printer driver being used. Refer to the table below
for the appropriate procedure for installing the printer driver on your Macin-
tosh computer.
Mac 0OS Printer Driver Refer to
Mac OS X 10.2 and | PostScript PPD “Installing the Printer Driver” on page 2-16
Mac OS X 10.3
Mac OS 9.2 or later | PostScript PPD “Selecting a Printer” on page 2-18
Installing the Printer Driver
For Mac OS X
1 Turn the Macintosh computer on.
— Quit all running applications that may have started when the Mac-
intosh computer was turned on.
2 Insert the Macintosh printer driver CD-ROM into the Macintosh com-
puter’s CD-ROM drive.
3 Open the “OS10_2_X” or “OS10_3_X” folder from “English” —“Driver”
on the CD-ROM.
4 Select the Mac OS version being used, and then copy the drive file onto
the desktop.
Mac OS X 10.2: KONICAMINOLTA_C351_102.pkg
Mac OS X 10.3: KONICAMINOLTA_C351_103.pkg
5 Double-click the file copied onto the desktop.
— Enter the requested administrator’s name and password.
— For the administrator’'s name and password, ask your network ad-
ministrator.
— To quit the installation, click the [Cancel] button.
6  Clickthe [Continue] button and follow the on-screen instructions until
the Installation dialog box appears.
C351 2-16

Download from Www.Somanuals.com. All Manuals Search And Download.



Installing the Printer Driver 2

7 Onthe Installation dialog box, click the [Continue] button.
— From the second time the printer driver is installed and thereafter,
the [Installation] button may appear as the [Upgrade] button.

The printer driver is installed onto the Macintosh computer. When in-
stallation is complete, a message appears.

@ il KOMAEA, WWOLTA €141
ViR I g0 chek LORMCA RINOLTA CA50 Insialer
KOMICA MINCOLTA barhaly T35

Prinisr Dviver instafler lor Mac OF X (10.3 or L)
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8  Click the [Close] button.

This completes the printer driver installation.
Next, select the printer.

e e
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Selecting a Printer

For Mac OS X

After connecting this machine to a Macintosh computer, it can be used as a
printer by selecting it in Print Center or the Printer Setup Utility as the printer
to be used.

1 Open Print Center or Printer Setup Utility, located in “Applications” —
“Utilities” of “Hard Disk”.

2 When the Add Printer dialog box appears, click the [Add] button. When
the printer list appears, click the [Add] button.

— If usable printers have already been set up, the Add Printer dialog
box does not appear.

3  Selectthe applicable connection method and printer name.
4 Select “KONICA MINOLTA” from the “Printer Model” drop-down list.

5 Select “KONICA MINOLTA C351 PS(P)”, and then click the [Add] but-

ton.
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The selected printer is registered in the printer list.
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For Mac OS 9.2

After connecting this machine, it can be used as a printer by selecting “Post-
Script printer” under “Chooser” and by specifying the printer description
(PPD) file.

First, copy the printer description (PPD) file onto the Macintosh computer.

1

2

Insert the Macintosh printer driver CD-ROM into the Macintosh com-
puter’s CD-ROM drive.

Open the “OS 9_x” folder in “English” —“Driver” on the CD-ROM.

Select PPD file “KONICAMINOLTAC351JVxxx”, and then copy it into
the “Printer Descriptions” folder in “System Folder” —“Extentions” of
“Hard Disk”.

— Next, select a printer.
The printer driver can use a standard Macintosh LaserWriter.

On the Apple menu, click “Chooser”.

Make sure that “AppleTalk” is set to “Active”, and then click the “La-
serWriter” icon.

From the “Select a PostScript Printer” list, click the applicable printer
for the printing system, and then click the [Create] button.

— If a different PPD file has already been selected, click the [Setup]
button, and then click the [Select PPD] button from the screen that
is already displayed.

The PostScript printer description (PPD) file selection screen appears.

C351
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7 Select the applicable PPD file, and then click the [Open] button or the
[Select] button.
The setting screen for adding Options appears.
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8  Selectthe options that are installed on this machine.

‘ Current Printer Description File (PPD) Selected:
— “KONICAMINOLTAC351V0.0.7.ppd™

Installable Options

Paper Sources: m
Finisher: _
Punch Unit:
Printer HDD: [ Installed | ]

Cancel ] H 0K ]l

9  Click the [OK] button.
The Chooser window appears again.

10 Close the Chooser window.
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Uninstalling the Printer Driver

If it becomes necessary to delete the printer driver, for example, when you
want to reinstall the printer driver, follow the procedure below to delete the
driver.

...

Note
Quit all running applications that may have started when the Macintosh
computer was turned on.

For Mac OS X

1 Open Print Center or Printer Setup Utility, located in “Applications” —
“Utilities” of “Hard Disk”.

2 Select the name of the printer to be deleted, and then click the [Delete]
button.

The selected printer is deleted.

3  Closethe printer list.

4 Drag the following file, which is located in “Library” —“Printers” —
“PPDs” —“Contents” — “Resources” — “en.lproj” of “Hard Disk”, to the
“Trash” icon.

“KONICA MINOLTA C351.gz”

5  Delete the unnecessary files from “Library” — “Printers”.

6 For Mac OS 10.3, drag the “***c351” file, which is located in “Library” —
“Printers” —“KONICAMINOLTA” —“filter”, and the following files, which
are located in “Library” —“Printers” —“KONICAMINOLTA”

—“PDEs”, to the “Trash” icon.
— KONICAMINOLTAC351 Finishing.plugin
— KONICAMINOLTAC351 ImageLayout.plugin
— KONICAMINOLTACS51 Security.plugin
— KONICAMINOLTACS51 Setup.plugin
7 For Mac OS 10.2, drag the following files, which are located in “Li-

brary” —“Printers” —“PPD Plugins”, to the “Trash” icon.

— KONICAMINOLTAC351 Finishing.plugin

— KONICAMINOLTAC351 ImagelLayout.plugin
— KONICAMINOLTAC351 Security.plugin

— KONICAMINOLTAC351 Setup.plugin
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8  Restart the Macintosh computer.

This completes the uninstallation procedure.
For Mac OS 9.2

1 Drag PPD file “KONICAMINOLTAC351JVxxx”, which is located in
“System Folder” —“Extensions” —“Printer Descriptions” of “Hard
Disk”, to the “Trash” icon.

The related printer driver files are deleted.

2 Restart the Macintosh computer.

This completes the uninstallation procedure.

C351 Download from Www.Somanuals.com. All Manuals Search And Download. 2-22



Setting Up Network Printing 3

[ 1111
3  Setting Up Network Printing

3.1 Overview of Network Functions

Network Functions

By connecting this machine to a network through the Ethernet port, this
printing system can be used as a network printer.

Network
=

This printing system supports 10Base-T and 100Base-TX standards. In ad-
dition, the Ethernet interface supports the TCP/IP (LDP/LPR, IPP, SMB), Net-
BEUI (SMB), IPX/SPX (NetWare), and AppleTalk (EtherTalk) protocols.

...

Note
When setting up the network, the administrator password is required to
enter Administrator mode.

Ask the administrator of this machine for the administrator password.

C351
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Features of the Network Functions

This printing system is equipped with the following network functions to flex-

ibly support various network environments.

e Automatic selection of 10Base-T or 100Base-TX (Fast Ethernet)

e Supports multiple network protocols including TCP/IP, NetBEUI, IPX/
SPX, and AppleTalk (EtherTalk)

e Supports SMB printing (Windows printing) from Windows 98SE or Win-
dows Me

e Supports LPD/LPR over TCP/IP from Windows NT 4.0, Windows 2000 or
Windows XP

e Supports Novell NetWare Pserver and Rprinter (Nprinter)

e Supports the Novell NetWare print server functions and supports both
bindery mode and Novell Directory Service (NDS)

e Acquires IP address automatically through DHCP

With SMB printing (Windows 98SE/Me)

SMB printing is a printing method that does not require a dedicated print
server on computers running Windows 98SE or Windows Me.

With LPR (Windows NT 4.0/2000/XP)

You can print with LPD/LPR using Windows NT 4.0, Windows 2000, or Win-
dows XP. Windows 98SE and Windows Me cannot be used.

Q

Detail

LPR (Line Printer Request): This print request system can be used under
Windows NT 4.0, Windows 2000, or Windows XP. Enter the queue name
as [Print].

With NetWare

The Novell NetWare 4.x-6 print server functions are supported.

You can connect this printing system to a network using Novell NetWare
4.x—6 as the network operating system and send print jobs from the client
to the print server (network controller). The three modes supported are as fol-
lows:

e Nprinter

e Pserver

e NDPS
Note

For details on the NetWare functions, refer to the NetWare operation
manual.

C351
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With Macintosh

You can print from your Macintosh computer using LPR or AppleTalk.

You can connect this printing system to print server in an AppleTalk environ-
ment and send print jobs from the Macintosh computer to this machine.
Network Connection Methods That Can Be Selected in Each Windows
Operating System

This chapter describes the settings that must be specified for network print-
ing.

Setting procedures differ depending on the method of networking printing
used (SMB, LPR, or IPP printing). Select the best method of network printing
for your Windows environment.

Network Printing from a Windows Operating System

Proto- Win- Win- Win- Win- Win- Win-
col Used| dows 98 | dows dows dows XP| dowsNT | dows
Second | Me 2000 4.0 Server
Edition 2003
SMB Print- | TCP/IP, @) @) @) @) @)
ing NetBEUI
LPR Printing| TCP/IP O O 'e) O
IPP Printing | TCP/IP O @] O
Reminder

Before setting up network printing, install the printer driver. For details on
installing the printer driver, refer to “Installing the Printer Driver” on
page 2-1.

To perform network printing, change the printer port for the installed
printer driver to one for a network connection, and then change the set-
tings on this machine as necessary. For an IPP connection, it is neces-
sary to install the printer driver first.

C351
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Network Printing in a NetWare Environment

NetWare Version Protocol Used Emulation Service Mode
NetWare 4.x IPX NDS/Bindery Pserver/Nprinter
NetWare 5.x/6 IPX NDS Pserver

TCP/IP NDPS(Ipr)

C351
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3.2 Setting the IP Address for This Machine
Use this machine’s control panel to assign an IP address to this machine.
Reminder
When specifying network settings, follow the instructions of the network
administrator.
Setting the IP Address

Press the [Utility/Counter] key on this machine’s control panel, touch

[Administrator Setting], and then enter the administrator password.

— The administrator password is required in order to enter Adminis-
trator mode. Ask the administrator of this machine for the adminis-
trator password.

Touch [Network Setting], then [TCP/IP Setting].

;:::(i::gitem and enter IP address using the Kevpad.
1/3| |
256. 255. 285.

Specify settings for the following:

IP Address: Set the IP address of this machine.

Subnet Mask: Set the subnet mask for the network to which you are

connecting.

Default Gateway: Set the default gateway address for the network to

which you are connecting.

To apply the settings, restart this machine (turn it off, then on again).

— When turning the main power switch OFF then ON, wait for 10 sec-
onds or longer before turning it ON again; otherwise the copier may
not function normally.

Turn this machine back on to apply the IP address.

C351 3-5
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Q

Detail

Although the IP address is entered without using the DHCP server in the
procedure described here, it is also possible to automatically assign the
IP address from the DHCP server. When “DHCP Setting” is set to “ON”,
the IP address, subnet mask, and gateway address settings are automat-
ically assigned from the DHCP server on the network, so it is not neces-
sary to assign them manually. However, note the following when setting
“DHCP Setting” to “ON”.

Check with the network administrator that the DHCP server exists. If the
DHCP server does not exist, be sure to specify settings for “IP Address”,
“Subnet Mask”, and “Default Gateway”.

If the settings for the IP address and other items have been assigned us-
ing the DHCP server, there is a possibility that they may be automatically
changed. When the settings for the IP address and other items are
changed, if the IP address has been used to specify a printer on the net-
work for printing, there is a possibility that printing may not be possible
because this machine cannot communicate with the network. If “DHCP
Setting” has been set to “ON”, it is recommended that the IP address as-
signed to this machine be fixed in the DHCP server settings.

C351
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3.3

Accessing PageScope Web Connection

Setting the IP address for this machine enables you to access PageScope
Web Connection.

Use your Web browser to directly access PageScope Web Connection.
To access PageScope Web Connection
1 Start up the Web browser.

2 In the “Address” bar, enter the IP address for this machine as shown
below, and then press the [Enter] key.

— http://<IP_address_for_this_machine>/
Example: If the IP address for this machine is 192.168.1.20
http://192.168.1.20/

The initial page of PageScope Web Connection appears.

For further details on PageScope Web Connection, refer to “Using Page-
Scope Web Connection” on page 10-28.

C351
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3.4

SMB Printing

You can use SMB printing (Windows printing) to print directly over the Micro-
soft network from computers running Windows 98SE or Windows Me.
Operations on This Machine

Set the IP address for this machine. For the setting procedure, refer to “Set-
ting the IP Address for This Machine” on page 3-5.

In PageScope Web Connection, specify the settings described below for
Windows printing.
1 Start up PageScope Web Connection.

Click the [Admin Mode] button.

2
3 Enterthe administrator password, and login to the Administrator mode.
4

On the Network tab, click “SMB”, and then click “Print” in the sub-
menu that appeared.
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Specify settings for the following:

SMB Print: Set whether to use the SMB printing service. Select “Ena-
ble” here.

NetBIOS Name: Specify the NetBIOS name (up to 15 alphanumeric
characters).

Print Service Name: Specify the printing service name (up to 31 alpha-
numeric characters).

Work Group: Specify the work group name (up to 15 alphanumeric
characters).

To apply the settings, restart this machine (turn it off, then on again).

—  When turning the main power switch OFF then ON, wait for 10 sec-
onds or longer before turning it ON again; otherwise the copier may
not function normally.

Printer Driver Settings

For Windows 98SE/Me

Click the [Start] button, point to “Settings”, and then click “Printers”.
Right-click the icon of the installed printer, and then click “Properties”.
On the Details tab, click the [Add Port] button.

Select “Network”, and then click the [Browse] button. In the network
configuration window that appears, select the appropriate printer icon.

For Windows 2000/XP/NT 4.0/Server 2003

For Windows 2000/NT 4.0, click the [Start] button, point to “Settings”,
and then click “Printers”.

For Windows XP/Server 2003, click the [Start] button, and then click
“Printers and Faxes”.

Right-click the icon of the installed printer, and then click “Properties”.

Click the [Add Port] button on the Ports tab, double-click “Local Port”
or select “Local Port” and click the [New Port] button, and then enter
“W<NetBIOS_name>\<printing_service_name>".

— Enter the same NetBIOS name and printing service name that you
entered in PageScope Web Connection. For the setting procedure,
refer to “Operations on This Machine” on page 3-8.

Click the [Close] button to apply the setting.

C351
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3.5 LPR Printing

The LPR print service is supported as standard in Windows 2000, Windows

XP, Windows NT 4.0, and Windows Server 2003. TCP/IP is used as the net-

work protocol.

Operations on This Machine

-  Set the IP address for this machine.
— For the setting procedure, refer to “Setting the IP Address for This

Machine” on page 3-5.

Printer Driver Settings

For Windows 2000/XP/Server 2003

1 For Windows 2000, click the [Start] button, point to “Settings”, and
then click “Printers”.
For Windows XP/Server 2003, click the [Start] button, and then click
“Printers and Faxes”.

2 Right-click the icon of the installed printer, and then click “Properties”.

3 Onthe Ports tab, click the [Add Port] button.

4 In the “Available Printer Ports” list, select “Standard TCP/IP Port”, and
then click the [New Port] button.

5 When the Add Standard TCP/IP Printer Port Wizard starts up, click the
[Next] button.

6 In the “Name of printer or IP address” box, enter the IP address for this
machine, and then click the [Next] button.

7 Select “Custom”, and then click the [Settings] button.

8 Select “LPR”, enter “Print” in the “Queue Name” box, and then click the
[OK] button.

9 Clickthe [Next] button, and then click the [Finish] button to apply the
setting.

C351 3-10
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For Windows NT 4.0

1

2
3
4

Click the [Start] button, point to “Settings”, and then click “Printers”.
Right-click the icon of the installed printer, and then click “Properties”.
On the Ports tab, click the [Add Port] button.

In the “Available Printer Ports” list, select “LPR Port”, and then click the
[New Port] button.

— If“LPR Port” is not in the list, click the [Start] button, point to “Con-
trol Panel”, and then click “Network”. Then, on the Service tab, click
the [Add] button and install the Microsoft TCP/IP Printing service.

In the “Name or address of server providing Ipd” box on the Add LPR
Compatible Printer dialog box, enter the IP address for this machine.

In the “Name of printer or print queue on that server” box, enter “Print”.

Click the [OK] button to apply the setting.

C351
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3.6 IPP Printing (Windows 2000/XP/Server 2003)

The IPP (Internet Printing Protocol) print service is supported as standard in
Windows 2000, Windows XP, and Windows Server 2003. TCP/IP is used as
the network protocol.

Operations on This Machine

Set the IP address for this machine. For the setting procedure, refer to “Set-
ting the IP Address for This Machine” on page 3-5.

Also, specify the IPP printing settings in PageScope Web Connection. (Print-
ing can be performed with the default settings.)

1 Start up PageScope Web Connection.
2 Click the [Admin Mode] button.

3 Enter the administrator password, and Log in to the Administrator
mode.

4 On the Network tab, click “IPP”.
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Specify settings for the following:

IPP Print: Set whether to perform IPP printing. Select “Enable” here.
Printer Name: Specify the printer name (up to 127 alphanumeric char-
acters).

Printer Location: Specify the printer location (up to 127 alphanumeric
characters).

Printer Information: Specify the printer manufacturer details (up to 127
alphanumeric characters).

Printer URI: The URI of the printer that can be used for IPP printing is
displayed.

Operations Supported: Specify print operations supported by IPP.
Accept Print Job: Set whether to use the IPP reception function.

Installing the Printer Driver

For IPP printing, reinstall the printer driver.

Insert the Windows printer driver CD-ROM into the computer’s CD-
ROM drive.

— Konica Minolta PCL Driver: User Software CD-ROM
— Konica Minolta PostScript Driver: PostScript Printer Driver CD-
ROM

For Windows 2000, click the [Start] button, point to “Settings”, and
then click “Printers”.

For Windows XP/Server 2003, click the [Start] button, and then click
“Printers and Faxes”.

For Windows 2000/Server 2003, double-click the “Add Printer” icon.
For Windows XP, click “Add a printer” on the “Printer Tasks” menu.

The “Add Printer Wizard” starts up.
Click the [Next] button.

In the Local or Network Printer dialog box, select “Network printer”,
and then click the [Next] button.

In the Locate Your Printer dialog box, select “Connect to a printer on
the Internet or on your intranet”.

In the “URL” field, enter the URL for this machine in the following for-
mat, and then click the [Next] button.

— http://<IP_address_for_this_machine>/ipp
Example: If the IP address for this machine is 192.168.1.20
http://192.168.1.20/ipp

C351
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8
9
10

11

12

13

When the confirmation dialog box appears, click the [OK] button.
Click the [Have Disk] button.

Click the [Browse] button, specify the folder on the CD-ROM that con-
tains the printer driver, and then click the “OK” button.

Konica Minolta PCL driver: User Software CD-ROM
“Driver\Drivers\bizhubC351” folder

Konica Minolta PostScript driver: PostScript Printer Driver CD-ROM
“Driver\Drivers” folder

Check that the printer name is displayed in the “Printers” list, and then
click the [Next] button.

Select whether to set the printer as the default printer, and then click
the [Next] button.

Click the [Finish] button to exit the Add Printer Wizard.

Once the settings for the printer have been specified, you can use the printer
in the same way as a default local printer. Also, if you set up the printer for
sharing in Windows, it can be used as a network printer by other Windows
computers over the network.

C351
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3.7  Printing With NetWare
The printer controller supports the following environments.
Network Printing in a NetWare Environment
NetWare Version Protocol Used Emulation Service Mode
NetWare 4.x IPX NDS/Bindery Pserver/Nprinter
NetWare 5.x/6 IPX NDS Pserver
TCP/IP NDPS(lpr)
Note
Before using bindery emulation, check that bindery emulation is compat-
ible with the NetWare server.

For Remote Printer Mode With NetWare 4.x Bindery Emulation

1 From a client computer, log on with Supervisor permissions to access
the NetWare server where the Pserver is registered.

2  start up Pconsole.

3 From the “Available Options” list, select “Quick Setup”, and then click
the [Enter] button.

4 Enterthe appropriate names in the “Printer Server Name”, “Printer
Name”, “Print Queue Name”, and “Print Queue Volume” fields, select
“Other/Unknown” from the “Printer type” field, and then save the spec-
ified settings.

5 Click the [Esc] button to quit Pconsole.

Use the NetWare server console to load PSERVER.NLM.

7 For queue user privileges, printer notification option, assignment of
multiple queues, and passwords, refer to the NetWare documentation,
and specify settings as necessary.

C351 3-15
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3

8  In Administrator mode of PageScope Web Connection, select “Net-
Ware” from the Network tab, and then specify the following settings.

ST

ren Cereer | lame VR AL

[y

o O T Mme® rr i

Fanlerw T . -
Fmdrrr

Pl L Faem g

-
Fradamed 1T T Sl jmres
Frobeesd 1T} T | ST

By e

Froum [Lanas s

By smamm

NetWare Print: Select “Enable”.

Frame Type: Select “Auto ”. (Select the frame type according to the
network environment.)

Mode: Select “Nprinter/Rprinter”.

Print Server Name: Specify the print server name created in step 4.
Print Server Password: Specify only when setting from the NetWare
Server.

Print Queue Scan Rate: Specify “1”. (Change as necessary.)
Bindery/NDS: Select “Bindery/NDS”.

Preferred File Server: Specify the name of the file server that connects
to the Pserver.

Restart this machine (turn it off, then on again).

— When turning the main power switch OFF then ON, wait for 10 sec-
onds or longer before turning it ON again; otherwise the copier may
not function normally.
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10 Use the NetWare server console to display the print server screen, and

then check that the created printer is shown as “Waiting for Job” for
the connected printer (0).

For Print Server Mode With NetWare 4.x Bindery Emulation

Before using bindery emulation, check that bindery emulation is compatible
with the NetWare server.

1

2

From a client computer, log on with Supervisor permissions to access
the NetWare server where the Pserver is registered.

Start up Pconsole.

From the “Available Options” list, select “Quick Setup”, and then click
the [Enter] button.

Enter the appropriate names in the “Printer Server Name”, “Printer
Name”, “Print Queue Name”, and “Print Queue Volume” fields, select
“Other/Unknown” from the “Printer type” field, and then save the spec-
ified settings.

Click the [Esc] button to quit Pconsole.

C351
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3

6 In Administrator mode of PageScope Web Connection, select “Net-
Ware” from the Network tab, and then specify the following settings.
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NetWare Print: Select “Enable”.

Frame Type: Select “Auto”. (Select the frame type according to the net-
work environment.)

Mode: Select “Pserver”.

Print Server Name: Specify the print server name created in step 4.
Print Server Password: Specify only when setting from the NetWare
server.

Print Queue Scan Rate: Specify “1”. (Change as necessary.)
Bindery/NDS: Select “Bindery/NDS”.

Preferred File Server: Specify the name of the file server that connects
to the Pserver.

7 Restart this machine (turn the main power off, then on again).

— When turning the main power switch OFF then ON, wait for 10 sec-
onds or longer before turning it ON again; otherwise the copier may
not function normally.

8  Use the NetWare server console to load MONITOR.NLM.

9 Select the connection information and, in the active connection col-
umn, check that the created Pserver is connected.
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For NetWare 4.x Remote Printer Mode (NDS)
1 Log on to NetWare as an administrator from a client computer.
2 Start up NWadmin.

3 Select either the organization or organizational unit container that of-
fers the print service, and then click “Print Services Quick Setup” on
the “Tools” menu.

4 Enterthe appropriate names in the “Printer Server Name”, “Printer
Name”, “Print Queue Name”, and “Print Queue Volume” fields, select
“Other/Unknown” from the “Printer type” field, and then save the spec-
ified settings.

5 For queue user privileges, printer notification option, assignment of
multiple queues, and passwords, refer to the NetWare documentation,
and specify settings as necessary.

6 In Administrator mode of PageScope Web Connection, select “Net-
Ware” from the Network tab, and then specify the following settings.
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NetWare Print: Select “Enable”.

Frame Type: Select “Auto”. (Select the frame type according to the net-
work environment.)

Mode: Select “Nprinter/Rprinter”.

Print Server Name: Specify the print server name created in step 4.
Print Server Password: Specify only when setting from the NetWare
server.

Print Queue Scan Rate: Specify “1”. (Change if necessary.)
Bindery/NDS: Select “NDS”.

Preferred NDS Context Name: Specify the name of the context that
connects to Pserver.

Preferred NDS Tree Name: Specify the name of the tree that Pserver
logs on to.

Printer Number: Specify “255”. (Set the number assigned to the printer
(0 to 254) or 255.)

Restart this machine (turn the main power off, then on again).

—  When turning the main power switch OFF then ON, wait for 10 sec-
onds or longer before turning it ON again; otherwise the copier may
not function normally.

Use the NetWare server console to load PSERVER.NLM.
Use the NetWare server console to display the print server screen, and

then check that “C351” (created printer) is shown as “Waiting for Job”
for the connected printer (0).

For NetWare 4.x/5.x/6 Print Server Mode (NDS)

To use the Print Server mode, the IPX protocol must be loaded on the Net-
Ware server.

Log on to NetWare as an administrator from a client computer.
Start up NWadmin.

Select either the organization or organizational unit container that of-
fers the print service, and then click “Print Services Quick Setup (non-
NDPS)” on the “Tools” menu.

Enter the appropriate names in the “Printer Server Name”, “Printer
Name”, “Print Queue Name”, and “Print Queue Volume” fields, select
“Other/Unknown” from the “Printer Type” field, and then click the [Cre-
ate] button.

C351
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3

5  For queue user privileges, printer notification option, assignment of
multiple queues, and passwords, refer to the NetWare documentation,

and specify settings as necessary.

6 In Administrator mode of PageScope Web Connection, select
“NetWare” from the Network tab, and then specify the following

settings.
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NetWare Print: Select “Enable”.

Frame Type: Select “Auto”. (Select the frame type according to the net-

work environment.)
Mode: Select “Pserver”.

Print Server Name: Specify the print server name created in step 4.
Print Server Password: Specify only when setting from the NetWare

server.

Print Queue Scan Rate: Specify “1”. (Change as necessary.)

Bindery/NDS: Select “NDS”.

Preferred NDS Context Name: Specify the name of the context that

connects to Pserver.

Preferred NDS Tree Name: Specify the name of the tree that Pserver

logs on to.
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Restart this machine (turn the main power off, then on again).

— When turning the main power switch OFF then ON, wait for 10 sec-
onds or longer before turning it ON again; otherwise the copier may
not function normally.

Use the NetWare server console to load MONITOR.NLM.

Select the connection information and, in the active connection col-
umn, check that the created Pserver is connected.
For NetWare 5.x/6 Novell Distributed Print Service (NDPS)

Before specifying settings for NDPS, check that the NDPS broker and NDPS
manager have been created and loaded.

Also, before performing the following procedure, check that the TCP/IP pro-
tocol has been set in the NetWare server, and check that the IP address has
been set for this machine and that this machine is on.

Log on to NetWare as an administrator from a client computer.

Start up NWadmin.

Right-click the organization or organizational unit container where you
will create the printer agent, and then click “NDPS Printer” on the “Cre-
ate” sub-menu.

In the “NDPS Printer Name” box, enter the printer name.

In the “Printer Agent Source” column, select “Create a New Printer
Agent”, and then click the “Create” button.

Check the printer agent name, and then in the “NDPS Manager Name”
box, browse through the NDPS manager names, and register one.

In the “Gateway Types”, select “Novell Printer Gateway”, and then reg-
ister it.

In the Configure Novell PDS for Printer Agent window, select “(None)”
for the printer type and “Novell Port Handler” for the port handler type,
and then register the settings.

In “Connection type”, select “Remote (LPR on IP)”, and then register it.
Enter the IP address set for this machine as the host address, enter

“Print” as the printer name, and then click the [Finish] button to register
the settings.

C351
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11 The printer driver registration screen appears. Select “None” for each

operating system to complete the registration.

...

Note

For settings for the queue user rights, printer notification option, assign-
ment of multiple queues, and passwords, refer to the NetWare documen-
tation, and set them as necessary.

Setting Up a Client (Windows) Settings When Using the NetWare Server

1

For Windows 98SE/Me/2000/NT 4.0, click the [Start] button, point to
“Settings”, and then click “Printers”.

For Windows XP/Server 2003, click the [Start] button, and then click
“Printers and Faxes”.

For Windows 98SE/Me/2000/NT 4.0/Server 2003, double-click the
“Add Printer” icon.
For Windows XP, click “Add a printer” on the “Printer Tasks” menu.

The “Add Printer Wizard” starts up.

In the port settings, browse the network, and specify the name of the
created queue (or NDPS printer name).

In the “Printer Model” list, specify the folder on the CD-ROM that con-
tains the printer driver for the operating system and printer driver to be
used.

—  For Windows 98SE/Me
Konica Minolta PCL driver: User Software CD-ROM
“Driver\Drivers\bizhubC351” folder
PostScript driver: PostScript Printer Driver CD-ROM “Driver\PS-
PPD” folder

—  For Windows NT4.0/2000/XP/Server 2003
Konica Minolta PCL driver: User Software CD-ROM
“Driver\Drivers\bizhubC351” folder
PostScript driver: PostScript Printer Driver CD-ROM “Driver\Driv-
ers” folder

Follow the on-screen instructions to complete the installation.

C351
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3.8

Printing With Macintosh

Operations on This Machine

Set the IP address for this machine. For the setting procedure, refer to “Set-
ting the IP Address for This Machine” on page 3-5.

In PageScope Web Connection, specify the settings described below for Ap-
pleTalk.

1
2

Start up PageScope Web Connection.
Click the [Admin Mode] button.

Enter the administrator password, and log in to the Administrator
mode.

On the Network tab, click “AppleTalk”.
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Specify settings for the following:

AppleTalk: Set whether to use AppleTalk. Select “Enable” here.
Printer Name: Specify the printer name (up to 31 alphanumeric charac-
ters).

Zone Name: Specify the zone being connected to (up to 31 alphanu-
meric characters).

C351
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6 To apply the settings, restart this machine (turn it off, then on again).

— When turning the main power switch OFF then ON, wait for 10 sec-
onds or longer before turning it ON again; otherwise the copier may
not function normally.

Setting the Macintosh computer

Use the Macintosh computer that is connected to specify the TCP/IP and
AppleTalk settings.

...

Reminder
For network sefttings, consult the network administrator.

For printer driver installation, refer to “Installing the Printer Driver” on
page 2-1.

For Mac OS X

On the Apple menu, select “System Preferences”.

Click the “Network” icon.

From “Show”, select “Built-in Ethernet”.

Click the AppleTalk tab.

Check that the “Make AppleTalk Active” check box is selected.

Click the TCP/IP tab.

N O OO~ O =

Select the items from “Configure” that correspond to the network set-
tings for the Macintosh computer that is connected to the network, and
then set the IP address and subnet mask.

8  Click the close button at the top left of the dialog box.

The “Apply configuration changes?” message appears.

9 Clickthe [Apply] button.
The AppleTalk and Ethernet settings are saved.
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For Mac OS 9.2

1

O~ OD

On the Apple menu, point to “Control Panel”, and then click “Apple-
Talk”.

From the “Connect via” drop-down list, select “Ethernet”.
On the Apple menu, point to “Control Panel”, and then click “TCP/IP”.
From the “Connect via” drop-down list, select “Ethernet”.
Select the items from “Configure” that correspond to the network set-
tings for the Macintosh computer that is connected to the network, and

then set the IP address and subnet mask.

Click the close button at the top left of the dialog box.

The “Save changes to the current configuration?” message appears.

Click the [Save] button.

C351
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4

Various Printing Methods

4.1 Printing Operations
For Windows
Data can be printed from an application.
Print jobs are specified from the application software.
1 Open the data in the application, “File”, and then click “Print”.
2 Check that the printer name has been selected in “Printer Name” or
“Select Printer”.
— If the printer is not selected, click to select the printer.
= o X
s @
sk Feach Powdl 1 il Ln.":".ﬁ.".
e [fog e
g Narsge
=1 Vumitew of popess (1 -
R
I Pages 1 i‘ 2
E"‘l-lﬂrl't#rmnr-l_.u:lml- _HJ;"_IJ
[0 R I
= |
3 Specify the page range and the number of copies to print.
— The Print dialog box differs depending on the application.
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4 Clickthe [Preferences] button or the [Properties] button to change the
printer driver settings as necessary.

— By clicking the [Preferences] button or the [Properties] button on
the Print dialog box, you can specify the settings of each model on
the printer driver dialog box that appears. For details, refer to “Set-
ting Up the PCL Driver” on page 5-1, “Setting Up the PostScript
Driver (Windows)” on page 6-1 or “Setting Up the PPD Driver (Win-
dows)” on page 7-1.

5 Click the [Print] button.

The Data indicator of this machine flashes.

Test Printing

Printing is possible when the printer driver is installed and the network set-
tings have been specified. To check that connection has been made proper-
ly, you can print the standard Windows test page.

Print a test page from the printer driver Properties dialog box.
1 For Windows 98SE/Me/2000/NT 4.0, click the [Start] button, point to
“Settings”, and then click “Printers”.

For Windows XP/Server 2003, click the [Start] button, and then click
“Printers and Faxes”.

2 Right-click the icon of the installed printer, and then click “Properties”.

3 Clickthe General tab, and then click the [Print Test Page] button or the
[Print Test] button.

The test page is printed and the confirmation dialog box appears.

4 Check the printout, and then click the [OK] button or the [Yes] button.

...

Note
If the test page is not printed properly, check that the printer driver has
been installed properly and that the network settings are complete.

C351
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For Macintosh

Printing is possible when the printer driver is installed and the network set-
tings have been specified. Print jobs are specified from the application soft-

ware.
For Mac OS X
1 Open the data in the application, “File”, and then click “Print”.

2 Check that the printer name has been selected.

Primoer: | WONAMBMOLTA CI51 )
Preinli Sigesdip Tl‘
Coias & Pages _-: |
Copai | l'@ﬁmlun‘.
Pagei & aii
Fromi | TS |
7 Provaew Savr A POH L Cirrewl i P

3 Specify the print range and the number of copies to print, and then
click the [Print] button.

The Data indicator of this machine flashes.

V...

Note
If the printer name does not appear in the list, select the printer in Print

Center or the Printer Setup Utility. For details, refer to “Selecting a Print-
er” on page 2-18.

The Print dialog box differs depending on the application.
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For Mac OS 9.2
1 Open the data in the application, “File”, and then click “Print”.
2 Check that the printer name has been selected.

3  Select “General”.

8.7.1

Printer: [ KONICAMINOLTA C351 =i Destination:
r [ General i]

Copies:D [ Collated
Pages: @ All

Paper Source: @ All pages from: [Auto Select i]
Q) First page from: | Tray 1 3]
Remaining from: [Trm,r 1 ¥ ]

Save Settings

4 Specify the Pages and the number of copies to print, and then click the
[Print] button.

The Data indicator of this machine flashes.

V...

Note
If the printer name does not appear in the list, select the printer from the
Chooser window. For details, refer fo “Selecting a Printer” on page 2-18.

The Print dialog box differs depending on the application.

The settings can be saved by clicking the [Save Settings] button.

C351
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4.2  Setting the Printing Functions

The functions of this machine such as sorting and folding can be set when
printing from a computer. Depending on the operating system running on the
connected computer, the setting procedure of this machine’s functions may
differ.

Function List

The function list contains a summary of the main settings related to printing
and printer driver support.

...

Note

The function names in this list are based on those displayed by the PCL
printer driver in Windows XP. In addition, the items and setting values dis-
played may differ depending on whether the options are installed or the

settings are available.
Function Overview Printer Driver
PCL PostS | PPD
cript
Orientation Selects the print orientation. O O O
Original Size Specifies the size of the original document. O O O
Output Size Specifies the output paper size. O O O
Zoom Prints enlarged or reduced. O O O
Paper Source Selects the paper source for printing. O O O
Paper Type Settings | Specifies the paper type of the paper O O O
source.
Binding Position Selects the binding position. O O O
Print Type Selects the print type (simplex, duplex, or O O O
booklet).
Combination Prints multiple pages on one page. O O O
File Margin Sets Margins for punch holes and staples. O
Staple Staples documents. O O O
Hole-Punch Punches holes in documents. O O O
Output Method For non-conventional printing, selects the O O (Mac
(Job Management) special output format for secured OS X
documents or saves data in a box. only)
Copies Specifies the number of copies to print. O O O
Output Tray Selects the tray where to output the printed O O O
pages.
C351 4-5
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Function Overview Printer Driver
PCL PostS | PPD
cript
Collate Specifies whether to print multiple copies in O O O
sets.
Offset When printing multiple copies, shifts the O O O
output position of each set.
Skip Blank Pages Does not print blank pages in data. O
User Authentication/| Printing is performed after the registered O O (Mac
Account Track user ID and password are entered. OS X
only)
Front Cover Page Attaches a front cover page. O O O
Back Cover Page Attaches a back cover page. O O O
Overlay Prints the original document on top of form O
data that was created separately.
Watermark Prints a watermark (text stamp) on the page O O
being printed.
Distribution Number | Prints the number of the copy. O
Stamping
Select Color Selects color printing and monochrome O (No (No
printing. two two
color color
selec- | selec-
tion) tion)
Original Image Type | Prints with a quality suitable for the selected O O O
original document.
Quality Adjustment | Adjusts the image quality. O O O
Glossy Mode Prints with a gloss. O O O
Use Printer Fonts Specifies the replacement of TrueType fonts O O O
with printer fonts.
FAX Sends data as a fax. O
User Authentication/| Performs user authentication and account O O (Mac
Account Track track operations. 0s X
only)
C351 4-6
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Function Overview

An overview of each function is summarized in this section.

Orientation

You can specify “Portrait” or “Landscape” as the orientation of the page be-
ing printed.

ABCD ABCDEF

Portrait Landscape

Operating System | Printer Driver Refer to
Windows Konica Minolta PCL “Specifying the Setup Tab Settings” on
page 5-5
Konica Minolta PostScript | “Specifying the Setup Tab Settings” on
page 6-7
PostScript PPD “Specifying the Paper Tab Settings” on
page 7-4
Mac OS X PostScript PPD “Page Attributes (Basic Settings)” on
page 9-5
Mac OS 9.2 “Page Attributes (Basic Settings)” on
page 8-6
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Original Size and Output Size

You can specify the original document size and the output paper size. By
specifying each size, you can specify the enlargement and reduction ratio.

Original size

*

Output size

Operating System

Printer Driver

Refer to

Windows

Konica Minolta PCL

“Specifying the Setup Tab Settings” on
page 5-5

Konica Minolta PostScript | “Specifying the Setup Tab Settings” on

page 6-7

PostScript PPD

“Specifying the Paper Tab Settings” on
page 7-4

Mac OS X

Mac 0S 9.2

PostScript PPD

“Page Attributes (Basic Settings)” on
page 9-5

“Page Attributes (Basic Settings)” on
page 8-6

...

Note

Only the output paper sizes can be specified with the PostScript PPD
ariver for Windows and the Macintosh.

C351
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Zoom (Enlargement and Reduction)

You can specify the enlargement or reduction ratio using numeric values.

EN

rd

>
@
O
o

Reduced

Original Enlarged

>
w
O
@)

N

>
W
A

ABCD

Operating System | Printer Driver Refer to
Windows Konica Minolta PCL “Specifying the Setup Tab Settings” on
page 5-5
Konica Minolta PostScript | “Specifying the Setup Tab Settings” on
page 6-7
PostScript PPD “Graphics Tab” on page 7-2
Mac OS X PostScript PPD “Page Attributes (Basic Settings)” on
page 9-5
Mac OS 9.2 “Page Attributes (Basic Settings)” on
page 8-6

C351
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Input Tray (Paper Source)

You can select the input tray as the paper source for printing. When changing
the paper type, you can select an input tray according to the paper type.

Operating System | Printer Driver Refer to
Windows Konica Minolta PCL “Specifying the Setup Tab Settings” on
page 5-5
Konica Minolta PostScript | “Specifying the Setup Tab Settings” on
page 6-7
PostScript PPD “Specifying the Paper Tab Settings” on
page 7-4
Mac OS X PostScript PPD “Paper Feed” on page 9-9
Mac OS 9.2 “General (Basic Settings)” on page 8-9

Paper Type
You can specify the paper type being printed.

Operating System | Printer Driver Refer to
Windows Konica Minolta PCL “Specifying the Setup Tab Settings” on
page 5-5
Konica Minolta PostScript | “Specifying the Setup Tab Settings” on
page 6-7
PostScript PPD “Specifying the Paper Tab Settings” on
page 7-4

V...

Note
With the Konica Minolta PCL driver for Windows, the paper type settings
can be pre-set by specifying the paper type of the paper drawer.
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Print Type (Duplex Printing/Booklet Printing)

You can print onto both sides of a page or in a booklet format (two facing
pages or center binding). This comes in handy when you want to bind multi-
ple-page documents.

The binding area can be specified by specifying the binding position.
Duplex Printing

Print data Printout Print data Printout
@Z 212
Left binding/Right binding Top binding

Booklet Printing

Print data Printout

1@1 5'@'

Operating System | Printer Driver Refer to
Windows Konica Minolta PCL “Specifying the Setup Tab Settings” on
page 5-5
Konica Minolta PostScript | “Specifying the Layout Tab Settings” on
page 6-14
PostScript PPD “Specifying the Device Options Tab Set-
tings” on page 7-5
Mac OS X PostScript PPD “Finishing” on page 9-11
Mac 0S 9.2 “Printer Specific Options (Finishing Options

1 to 4)” on page 8-11
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Printing Multiple Pages on One Page

You can print multiple document pages on one page. This comes in handy
when you want to reduce the number of output pages.

1 5 1 2 2 3
- 3 4 4 5 6
4in1 6int
1 2 3 1234
5678
4 5 6
9 101112
7 8 9 13141516
16in1

Operating System | Printer Driver

Refer to

Windows Konica Minolta PCL

“Specifying the Setup Tab Settings” on
page 5-5

Konica Minolta PostScript

“Specifying the Layout Tab Settings” on
page 6-14

PostScript PPD

“Specifying the Layout Tab Settings” on
page 6-14

Mac OS X PostScript PPD

Mac 0S 9.2

“Layout (Printing Multiple Pages on One
Page)” on page 9-8

“Layout (Printing Multiple Pages on One
Page)” on page 8-10

C351
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Stapling and Hole Punching

Documents can be stapled together or holes can be punched into the docu-

ment.

By specifying the file margin, you can specify the margin for stapling or hole

punching.

Stapling

Hole punching

‘ABCDEF

...

Note

The staple function is available only when the optional finisher is installed.

The hole punch function is available only when optional finisher FS-507
or FS-603 is installed. When using optional finisher FS-603, the punch kit

must be installed.
Operating System | Printer Driver Refer to
Windows Konica Minolta PCL “Specifying the Setup Tab Settings” on
page 5-5
Konica Minolta PostScript | “Specifying the Layout Tab Settings” on
page 6-14
PostScript PPD “Specifying the Device Options Tab Set-
tings” on page 7-5
Mac OS X PostScript PPD “Finishing” on page 9-11
Mac OS 9.2

“Printer Specific Options (Finishing Options
1 to 4)” on page 8-11

C351
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Output Method (Job Management)

You can select “Secured Print”, which requires a password to print, or “Save
in User Box”, which saves documents in a document folder.

Operating System | Printer Driver Refer to
Windows Konica Minolta PCL “Specifying the Setup Tab Settings” on
page 5-5
Konica Minolta PostScript | “Specifying the Setup Tab Settings” on
page 6-7
PostScript PPD “Specifying the Device Options Tab Set-
tings” on page 7-5
Mac OS X “Security” on page 9-9

Sorting (Collating) and Classifying (Offset)

You can print the complete document sets the specified number of times or

each page the specified number of times.

By specifying offset, the output position can be shifted and output to the
front and back for each copy. (Multiple paper sources are used when a shift-
ing finisher is installed and when no finisher is installed.)

Collate

ABCD

Offset

>
vy}
9
@)

Operating System

Printer Driver

Refer to

Windows

Konica Minolta PCL

“Specifying the Setup Tab Settings” on
page 5-5

Konica Minolta PostScript

“Specifying the Setup Tab Settings” on
page 6-7

PostScript PPD

“Specifying the Device Options Tab Set-
tings” on page 7-5

Mac OS X

Mac 0S 9.2

PostScript PPD

“Copies & Pages (General Settings)” on
page 9-7 and “Finishing” on page 9-11

“Copies & Pages (General Settings)” on
page 9-7 and “Printer Specific Options (Fin-
ishing Options 1 to 4)” on page 8-11
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Skip Blank Pages (Saving Paper)

Does not print blank pages in the data.

Operating System | Printer Driver Refer to
Windows Konica Minolta PCL “Specifying the Setup Tab Settings” on
page 5-5

Authentication

When the authentication settings have been applied on this machine, you
must enter the required user ID and password.

Operating System | Printer Driver Refer to
Windows Konica Minolta PCL “Specifying the Setup Tab Settings” on
page 5-5
Konica Minolta PostScript | “Specifying the Setup Tab Settings” on
page 6-7
Mac OS X PostScript PPD “Security” on page 9-9

Front Cover, Back Cover, and Interleaf Settings

A front cover and back cover can be added and pages can be inserted be-
tween pages. (The interleaf setting is only available with the PCL printer driv-
er.)

Front cover Back cover

ABCD

>
os}
(@]
@)

Operating System | Printer Driver Refer to

Windows Konica Minolta PCL “Specifying the Per Page Setting Tab Set-
tings” on page 5-16

Konica Minolta PostScript | “Specifying the Per Page Setting Tab Set-
tings” on page 6-18

PostScript PPD “Specifying the Device Options Tab Set-
tings” on page 7-5
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Operating System

Printer Driver

Refer to

Mac OS X PostScript PPD “Setup” on page 9-14
Mac 0S 9.2 “Printer Specific Options (Finishing Options
1 to 4)” on page 8-11
Overlay

Prints the original document on top of form data that was created separately.

Form data

Created data

— | @&

Operating System

Printer Driver

Refer to

Windows

Konica Minolta PCL

“Specifying the Overlay Tab Settings” on
page 5-18

Watermark

Prints a watermark (text stamp) on the page being printed.

C351
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Operating System

Printer Driver

Refer to

Windows

Konica Minolta PCL

“Specifying the Watermark Tab Settings”
on page 5-22

Konica Minolta PostScript

“Specifying the Watermark Tab Settings”
on page 6-19

Quality Adjustment

Adjusts the image quality.

Operating System

Printer Driver

Refer to

Windows Konica Minolta PCL “Specifying the Quality Tab Settings” on
page 5-25
Konica Minolta PostScript | “Specifying the Quality Tab Settings” on
page 6-21
PostScript PPD “Specifying the Device Options Tab Set-
tings” on page 7-5
Mac OS X PostScript PPD “Quality” on page 9-12
Mac 0S 9.2 “Printer Specific Options (Finishing Options

1 to 4)” on page 8-11

Use Printer Fonts (Substitute Fonts)

Specifies the replacement of TrueType fonts with printer fonts.

Operating System | Printer Driver Refer to
Windows Konica Minolta PCL “Specifying the Font Tab Settings” on
page 5-27
Konica Minolta PostScript | “Specifying the Quality Tab Settings” on
page 6-21
PostScript PPD “Fonts Tab” on page 7-3
Mac 0S 9.2 PostScript PPD “PostScript Options” on page 8-8

Account Track

Specifies when this machine is operating

in Account Track.

Operating System

Printer Driver

Refer to

Windows Konica Minolta PCL “Specifying the Setup Tab Settings” on
page 5-5
Konica Minolta PostScript | “Specifying the Setup Tab Settings” on
page 6-7
Mac OS X Konica Minolta PostScript | “Security” on page 9-9

C351
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For Windows

The functions of this machine that can be used when printing can be speci-
fied in the printer driver setup dialog box, which can be displayed from the
Printers window (for Windows XP/Server 2003, Printers and Faxes window).

Settings specified in the printer driver setup dialog box displayed using the
procedure described below will be applied when printing from any applica-
tion.

1 For Windows 98SE/Me/2000/NT 4.0, click the [Start] button, point to
“Settings”, and then click “Printers”.
For Windows XP/Server 2003, click the [Start] button, and then click
“Printers and Faxes”.

2 For Windows 98SE/Me, right-click the icon of the installed printer, and
then click “Properties”.
For Windows 2000/XP/Server 2003, right-click the icon of the installed
printer, and then click “Printing Preferences”.
For Windows 4.0, right-click the icon of the installed printer, and then
click “Document Default”.

The following printer driver setting dialog box appears.

For the settings that can be specified with each printer driver, refer to the fol-

lowing:

e Konica Minolta PCL Driver: “Setting Up the PCL Driver” on page 5-1

e Konica Minolta PostScript Driver: “Setting Up the PostScript Driver (Win-
dows)” on page 6-1

e Konica Minolta PPD Driver: “Setting Up the PPD Driver (Windows)” on
page 7-1

C351
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PCL Driver
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PostScript PPD Driver

KONICA MINOLTA C351 PS[P) Properties 2lxl
Graphics I Fants I Device Options I PostScript |
General I Details I Color M anagement Paper

Paper size:  Letter [8.50 % 11.00 in]
RENDENEE =
12418 T abloid Legal Letter Statement

Kl [ o

— Layout
Dalup Elrgup ("gup

— Orientation
% Partrait

A
 Landscape ™| Rictated
Paper source: I AutoSelect Tray ;I
LCopies: |1 _|:;' Unprintable Area... |
More Options.... | About.. | Restare Defaults |

QK I Cancel | Apply |

V...

Note
Use each tab in the dialog box to set up the printer driver.

To specify custom settings, click Print in the application, and then click
the [Properties] button or the [Preferences] button on the Print dialog box.
The settings specified on the Print dialog box apply only to the current
file.

When setting up the installed options in Windows 2000/XP/NT 4.0/Server
2003, right-click the icon of the installed printer, and then click “Proper-
ties”.
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For Macintosh

The functions of this machine that can be used when printing can be speci-
fied on the Print dialog box or the Page Setup dialog box.

The settings can only be applied while using the application. When the ap-
plication is exited, the settings return to their default settings.

To display the Print dialog box
Open the data in the application, “File”, and then click “Print”.

Prscer: | COMMAMBMOLTA C351 H
i

S

Peirkati’ | Sigediurg _"
I

Cogmias, & Paged

Copss | g M Coltated
Pagei & aii
Fraem | o ]
7 Prrviarw Sarer A PO Tax Cirrwl r-ﬂ_'l'l' -!

To display the Page Setup dialog box
Open the data in the application, “File”, and then click “Page Setup” or “Pa-

per Setup”.
Sertings | Pags Alrnbites '_{:l
Format for | BONCABINGG TA C351 |
O BNCEL TA CASE
Paper 5w | B 172xll o

B %0 m w85 080 bn

Chrst i tepen Ii ||i-| 1-l

Seake | 100 "

LT Cancel ‘—-E
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For the settings that can be specified with each printer driver, refer to the fol-

lowing:
e OS X: “Setting Up the PPD Driver (Mac OS X)” on page 9-1
e (OS 9.2: “Setting Up the PPD Driver (Mac OS 9.2)” on page 8-1

...

Note
The contents of the Print dialog box and the Page Setup dialog box may

differ.

Depending on the application, the Page Setup dialog box can be dis-
played by selecting “Paper Setup”— “Options” from the “File” menu.
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U
5  Setting Up the PCL Driver

5.1 Settings

Common Settings

The following describes the common settings and buttons that are displayed

on all tabs.
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Button Function
OK Click this button to close the dialog box and apply any settings
that have been changed.
Cancel Click this button to cancel any settings that have been changed
and close the dialog box.
Help Click this button to display the help for each item on the cur-

rently displayed dialog box.

Save/Restore Setting

Click this button to save the current settings and to view them
at a later time.

Restore Defaults

Click this button to return the settings to their defaults, which
were selected when the driver was installed.

C351
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Button Function

View When “Paper” is selected, a preview of the page layout as
specified in the current settings is displayed and a preview im-
age of the print job can be checked.

When “Printer” is selected, a printer figure is displayed showing
any options, such as the paper drawer, that are installed on this
machine.

View: & Papsr Piinter View:  Paper & el

81/2:11
(8541 Tinch]

Paper Printer

...

Note
To enable any installed options, you must specify the Option settings. For
details, refer to “Specifying the Option Tab Settings” on page 5-42.

Setup Tab

Item Function

Paper Specifies the orientation, paper size, paper source, and
paper type.

Binding Specifies the folding format such as the binding position,
duplex printing, booklet printing, printing multiple pages
on one page, file margin, stapling, or hole punching.

Output Specifies the output format such as the output method,
number of copies, output tray, collate, or offset.

Per Page Setting Tab

Item Function

Front Cover Page Attaches a front cover page.

Back Cover Page Attaches a back cover page.

Per Page Setting Specifies the paper to be inserted into a print document.
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Overlay Tab
Item Function
Overlay Specifies overlay printing.
Watermark Tab
Item Function
Watermark Prints a watermark (text stamp) on the document being

printed.

Distribution Number Stamping

Prints the number of the copy.

Quality Tab
Item Function
Select Color Specifies the color for printing.

Original Image Type

Specifies the contents of the original document. Prints
with a quality suitable for the original document.

Quality Adjustment

Adjusts the image quality. You can select “Simple” to ad-
just entire documents and “Detailed” to adjust the charac-
ters, photos, and charts of each document.

Glossy Mode Prints with a gloss.

Pattern Selects the print pattern.
Font Tab

Item Function

Use Printer Fonts

Selects whether to use TrueType fonts or the printer fonts
when printing.

Download Font Format

Selects whether the fonts are downloaded to the printer
as bitmap or outline.

FAX Tab

Item

Function

Mode Selection

Selects whether to print or send a fax.

Fax Mode Settings

Specifies the fax resolution and transmission conditions.

FAX Cover Sheet Specifies the fax cover sheet.
Recipients Enters the recipient.
Phone Book Registers recipients in the Phonebook.

C351
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Item

Function

Recipients

Displays registered numbers for the recipient or Phone-
book.

Version Tab

Item Function
Version Displays the version of the printer driver.
Option Tab
Item Function
Option Specifies the options that are installed on this machine.

Option Information

Automatically specifies the printer driver option settings.

V...

Note

To display the Option tab in Windows 2000/XFP/NT 4.0/Server 2003, right-
click the icon of the installed printer, and then click “Properties”.

C351
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5.2 Specifying the Setup Tab Settings
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Printing to Suit the Paper Size
You can enlarge or reduce documents created when printing to match the
output paper size.
1 Click the Setup tab.
2 Fromthe “Original Size” and “Output Size” drop-down lists, select the
desired settings.
— You can also specify any enlargement or reduction ration in the
“Zoom” box.
C351
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Saving a Custom Size

A custom size can be specified and saved in advance as described below.

1 From the “Output Size” drop-down list, select “Custom Size Settings”.

The Custom Size Settings dialog box appears.

2 Specify settings for the following:

List of Custom Sizes: Select the size for the custom size being set.
Custom Size Name: Input the name of the custom size being regis-
tered.

Size: Specify the width and length of the custom size according to the
selected measurement units.

3 Click the [OK] button.

...

Note

The custom size settings can only be specified from the printer driver set-
up dialog box, which can be displayed from the Printers window (for Win-
dows XFP/Server 2003, Printers and Faxes window).
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Selecting the Paper Source

When changing the paper type, you can register it to an input tray and you
will be able to select the input tray according to the desired paper type.

1 Click the Setup tab.

2 Fromthe “Paper Source” drop-down list, select the paper drawer that
contains the paper to be used.

Setting the Paper Source of the Paper Type

Follow the procedure described below to assign a paper type to a paper
drawer.

1 Click the [Paper Type Settings] button.

2 Selectthe “Paper Source” being changed, and then click the [Edit] but-

ton.
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3 Select the desired setting from the “Paper Type” drop-down list, and
then click the [OK] button.
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If “Transparency” is selected as the paper type, you can specify
transparency interleaving.

When the “Transparency Interleave” check box is selected, the
Transparency Interleave Settings dialog box appears, allowing you to
select the source of the interleaf paper.

The Transparency Interleave Settings dialog box can also be displayed
by clicking the [Settings] button.

Specifying Duplex/Booklet Printing

You can print a document onto both sides of a page or in a booklet format
(two facing pages). This comes in handy when you want to bind multiple-
page documents.

1 Click the Setup tab.

2 From the “Print Type” drop-down list, select “Double-sided” or “Book-
let”.

V...

Note
The binding orfentation can be specified from the “Binding Position”
drop-down list.

When optional finisher FS-603 is installed and “Booklet” is specified, you
can specify “Center Binding” for binding in the center of a page.

C351
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Printing Multiple Pages on One Page (N in 1)

You can print multiple-page documents on one page. This comes in handy
when you want to reduce the number of output pages.

1 Click the Setup tab.

2 Select the “Combination” check box.

3 From the “Combination” drop-down list, select the number of pages to

be printed on one page.

To change the border line and printing order settings, select “Details”,
and then change the settings in the dialog box that appears.

¥
e
F
i

V...

Note

When printing a job that contains pages of different sizes and orienta-
tions, images may be missing or overlapping when the document is print-
ed.

C351
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Setting the File Margin
File margins are added to the document before it is printed.

1 Click the Setup tab.
2 Select the “File Margin” check box.
3 To set the width of the file margin, click the [Details] button, and then

specify the desired settings in the File Margin Details dialog box that
appears.
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Front Side/Back Side: Sets the file margin values. By clearing the “Save
Value for Front and Back Sides” check box, you can specify separate
values for the front and back sides.

Shift Mode: Selects the printing process for the document.
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Stapling
Multiple-page documents can be stapled.

The staple function is available only when the optional finisher is installed.
1 Click the Setup tab.
2 Select the “Staple” check box.

3  Fromthe drop-down list, specify the number of staples and the sta-
pling position.

...

Note
Depending on the selected Binding Position setting, different stapling po-
sitions are available.

Number of pages that can be stapled when FS-507 is installed: Up to 50
pages on 8-1/2 x 11 & or smaller plain paper, and up to 25 pages on 8-
1/2 x 14 or larger paper. Number of pages that can be stapled when FS-
603 /s installed: Up to 50 pages on 8-1/2 x 11 & or smaller plain paper,
and up to 25 pages on 8-1/2 x 14 or larger paper.

Hole Punching

Holes can be punched into the printed document.

The hole punch function is available only when optional finisher FS-507 or
FS-603 is installed. When using optional finisher FS-603, the punch kit must
be installed.

1 Click the Setup tab.

2 Select the “Hole-Punch” check box.

3  Fromthe drop-down list, specify the number of punched holes.

C351
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Selecting the Output Method

Not only can you print directly, but you can select “Secured Print”, which re-
quires a password to print, or “Save in User Box”, which saves documents
in the document folder.

1 Click the Setup tab.

2 Fromthe “Output Method” drop-down list, select the output method.

—  Print: Prints immediately.

— Secured Print: Saves the document to be printed in the secured
document box of this machine. When printing, you are required to
enter the user ID and password in this machine’s control panel. Se-
lect when printing highly confidential documents. (Up to 100 docu-
ments)

— Savein User Box: Saves the document to be printed in a box on this
machine.

— Savein User Box and Print: Saves the document in a box and prints
at the same time.

— Proof and Print: After part of the document has been printed, this
machine stops printing temporarily. Select to avoid misprinting
large print jobs.

Secured Printing

If “Secured Print” was selected, enter the ID and password in the dialog box
that appeared.
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Note

To print the document, specify [Secured Print] in the Box mode of this
machine, and then enter the ID and password. For detalls, refer to “Print
Job Management” on page 10-73.

For details on the box functions of this machine, refer to the User’s Guide
[Box Operations].

C351
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Save in User Box

=  When “Save in User Box” or “Save in User Box and Print” is selected,
specify the file name and box number in the dialog box that appears for
entering the file name and box number.
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V...

Note
For details on the box functions of this machine, refer to the User’s Guide
[Box Operations].

Proof and Printing

-  When a print job is sent, this machine stops printing temporarily after
part of the document has been printed. The remaining print job is
stored in this machine as a print job. When printing multiple copies, you
can print the remaining part of the print job after checking the print re-
sults.

...

Note

To print the document, specify the document in the Job mode of this ma-
chine, and then enter the ID and password. For details, refer to “Print Job
Management” on page 10-73.
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Specifying User Authentication Settings

If user authentication settings have been specified on this machine, a user
name must be entered.

1 Click the Setup tab.
2 Click the [User Authentication/Account Track] button.

3 Select the “User Authentication” check box, and then enter the user
name and password.
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4 Click the [OK] button.

V...

Note
If this machine has been set to permit public users, the machine can be

used without a user name and password.

For user authentication settings, consult the administrator of this ma-
chine.
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Specifying Account Track Settings

If account track settings have been specified on this machine, you must en-

ter an account password in order to print a job.

1 Click the Setup tab.

2 Click the [User Authentication/Account Track] button.

3 Select the “Account Track” check box, and then enter the department
name and password.

— Adefault password can be registered and used rather than entering
a password for each job.
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4 Click the [OK] button.

V...

Note

If a print job is sent using an account name or password that is not a reg-
Istered account on this machine or if a job is sent without the “Account
Track” check box selected, an error will occur. Check the Log List using
this machine’s control panel.
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5.3 Specifying the Per Page Setting Tab Settings
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Printing Documents with a Front Cover/Back Cover
1 Click the Per Page Setting tab.
2 Select the “Front Cover Page” and “Back Cover Page” check boxes.
3 7o print on the front cover and back cover, select “Printed”. To only
add a blank page, select “Blank”.
4 Select the input tray that contains the loaded paper for the front cover
and back cover.
C351 5-16
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Printing Multiple Pages

The “Per Page Setting” function comes in handy when you want to change
the input tray during a print job when printing multiple pages.

Per Page Setting

You can specify the print type and input tray for each page.

1
2

Click the Per Page Setting tab.
Select the “Per Page Setting” check box.
From the “List Name” drop-down list, select the name of the desired

list.

— When changing the list name, click the [Edit List Name] button after
selecting the list name, and then apply the settings on the dialog
box that appears.

Click the [Add] button, and then specify the page number, print type,
and paper source in the dialog box that appears.
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V...

Note
For an existing list, click the [Edit] button to change the selected page
settings, or click the [Delete] button to delete them.

Click [T] or [L] to change the page number starting with the smallest page
number.
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5.4 Specifying the Overlay Tab Settings

Printing Different Original Documents Together (Overlay)

An original document can be printed on top of form data that was created
separately. This function is handy for fax cover letters and form letters.

You must pre-register forms to be printed. For details, refer to “Editing
Forms” on page 5-20.

1 Create the print data using any application.
2 From the “File” menu, select “Print”.

3  Selectthe printer in “Select Printer”, and then click the [Properties] but-
ton or the [Preferences] button.

4 Click the Overlay tab.

5  select “Print Overlay”.

C351
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6 From the list, select the form that you want to print.
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Select the file name, and then click the [OK] button.
— The Print dialog box appears again.

Click the [OK] button.

Overlay printing is performed.

C351
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Editing Forms

Creating Forms

To use forms, the data for using forms must be pre-registered. To register a
form, select the “Create Overlay” check box, and then specify the document
that you want to register.

1 Create the form data using any application.

2 From the “File” menu, select “Print”.

3 Selectthe printer in “Select Printer”, and then click the [Properties] but-
ton or the [Preferences] button.

4 Click the Overlay tab.

5  Select the “Create Overlay”.

6 Click the [Browse Files] button.
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7 Specify the storage location for the form data, and then enter the file
name in the “File name” box.
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8  Clickthe [Save] button.

9  Selectthe file, and then click the [OK] button.

— The Print dialog box appears again.

10 Clickthe [OK] button.

Instead of executing a print job, the form data is saved. The file exten-
sion is “.kmf”.

N

Note
From the Overlay tab, the selected form data can be deleted by clicking
the [Delete Overiay File] button.

C351 Download from Www.Somanuals.com. All Manuals Search And Download. 5-21



Setting Up

the PCL Driver

5.5 Specifying the Watermark Tab Settings

Printing a Watermark

You can print specific text in the background as a watermark.

1

2
3
4

Click the Watermark tab.

Select the “Watermark” check box.

From the drop-down list, select the watermark that you want to print.

Specify the desired settings for “Type” and “1st Page Only”.

Overwrite: The background of the watermark is printed in white.

Transparent: The background of the watermark is transparent.

C351
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Editing a Watermark

You can change the fonts and position of the watermark and you can register
a new one.

1 Click the Watermark tab.

2 Select the “Watermark” check box.
3 Click the [Edit] button.
4

Specify settings for the following:
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[Add]: Click to enter a new watermark in the watermark text box.
[Delete]: Click to delete the selected watermark.

Font Settings: Specifies the font and font size.

Text Angle: Specifies the watermark print angle.

Position: Specifies the watermark position with the horizontal and ver-
tical scroll bars.

Text Color: Specifies the watermark text color.
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Printing the Document Number

When printing multiple copies, you can print the number of each document.
1 Click the Watermark tab.
2 Select the “Distribution Number Stamping” check box.

3 Specify settings for the following:

Pages to Print: Specifies the pages where the numbering is to be print-
ed.

Starting Number: Specifies the starting number.

Color: Specifies the color of the number being printed.

V...

Note
The “Numbering” check box is not available if the “Collate” check box is
not selected on the Setup tab.
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5.6 Specifying the Quality Tab Settings
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Specifying Settings
1 Click the Quality tab.

2 Specify settings for the following:

Item Function

Select Color Specifies the color for printing.

Color: Prints in color.

Grayscale: Prints in grayscale.

2 Color: Prints the two colors selected from the drop-down list.

Original Image Type Specifies the contents of the original document. Prints with a
quality suitable for the original document.

Document: Prints with a quality suitable for documents with
many characters.

Photo: Prints with a quality suitable for photos.

DTP: Prints with a quality suitable for documents produced us-
ing DTP.

WEB: Prints with a quality suitable to Web page printing.
CAD: Prints with a quality suitable for CAD data printing.

Quality Adjustment Adjusts the image quality.
Simple: Adjusts the entire document.
Detailed: Adjusts the text, photos, and charts of each object in

a document.
Glossy Mode Prints using a gloss finish.
Pattern Selects the print pattern.
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To adjust the quality, select “Simple” or “Detailed”, and then click the
[Settings] button beside the desired setting. In the Quality Adjustment
Settings dialog box that appears, specify the brightness and color balance.
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To adjust the quality, select “Detailed”, and then click the [Settings] button
beside “Figure/Table/Graph”. In the Quality Adjustment Settings dialog box
that appears, you can specify the color settings and screen/smoothing set-
tings, and the corresponding text or photo settings.
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5.7 Specifying the Font Tab Settings
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Specifying Settings

You can replace the TrueType fonts used in Windows with the printer fonts
of this machine.

Using the printer fonts will shorten the printing time, however, there may be
a difference in the screen display and the print results.

1 Click the “Font” tab.

2 Select the “Use Printer Fonts” check box.

3 Selectthe TrueType font that you want to replace.
4

From the “Printer Font to Use” drop-down list, select the printer font to
replace the TrueType font.

(&)

Click the [OK] button.

Note
Using the printer fonts will shorten the printing time, however, there may
be a difference in the screen display and the print results.

When using TrueType fonts, select from the “Download Font Format”
drop-down list the font type to be downloaded to the printer.
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5.8 Specifying the FAX Tab Settings

Sending a Fax

You can send your created data by fax.

To use the fax function, you must install the optional fax kit onto this ma-
chine. In addition, you must enable the fax kit on the Option tab after instal-
lation. For details, refer to “Specifying the Option Tab Settings” on

page 5-42.

1 Create the data you want to send using any application.

2 From the “File” menu, select “Print”.

3 Selectthe printer in “Select Printer”, and then click the [Properties] but-
ton or the [Preferences] button.

4 Click the “FAX” tab.

5 Under “Mode Selection”, select “FAX”.

— When “Custom Size” is selected from the “Output Paper” drop-
down list on the Setup tab, the fax function cannot be set up.

— For details on the fax functions of this machine, refer to the User’s
Guide [Facsimile Operations].

A confirmation message appears.
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6 Check the information, and then click the [OK] button.
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7 From the “Resolution” drop-down list, select the desired setting.

8  Click the Details button.
The [Fax Mode Details] dialog box appears.

9 7o print a file after a fax is sent, select the “Print Recipient File” check

box.
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10 To set the time when the fax is to be sent, select the “Timer Send”
check box, and then specify the time that you want the fax to be sent
in the “Send Time” boxes.

— By clicking the [Reflect Current Time] button, the current time set
on the computer is displayed in the “Send Time” boxes.

— When using “Timer Send”, check that the time set on the computer
is synchronized with the time on this machine. If the transmission
time is earlier than the current time of this machine, the fax is sent
the next day.
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11 when transmitting a confidential fax, select the “Sub-Address” and
“Send ID” check boxes, and then enter the sub address and
transmission ID. It is possible to send confidential communications to
another fax model using F codes.

— Up to 20 characters (numbers 0 through 9) can be entered in the
“Sub Address” text box.

— Up to 20 characters (numbers 0 through 9, # and *) can be entered
in the “Send ID” text box.

12 Click the [OK] button.

The Printing Preferences dialog box appears again.

13 Specify the fax destination.

You can directly enter the fax recipient or you can select one from the
Phonebook.

To enter the fax recipient directly, continue with step 14. To select a fax
recipient from the Phonebook, skip to step 15.

14 Under “Direct Entry”, enter the appropriate information in the “Name”
and “FAX Number” text boxes, and then click the [Add Recipients] but-
ton.

You can save up to 100 recipients in the “Recipients” list. After entering
the recipient information, skip to step 19.

— Up to 38 characters (numbers 0 through 9, hyphens (-), spaces, #,
*, E, P, and T) can be entered in the “FAX Number” text box.
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15

Click the [Phone Book] button.

— For details on registering recipients in the Phonebook, refer to

“Registering a Recipient in the Phonebook” on page 5-37.
The Phonebook dialog box appears.

16
17

Select the recipient or group where the fax is to be sent.

Click the [Add Recipients] button.

The selected recipient is displayed in “Recipients” list.
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18 select the recipient and then click the [OK] button.

— Ifagroup is selected, all the members of the group are displayed in

the “Recipients” list.
The Printing Preferences dialog box appears again.

19 Check that the file recipient appears in the “Recipients” list.

— To delete a recipient, select the recipient to be deleted from in the

“Recipients” list, and then click the [Delete] button.

It is not necessary to change the settings for the “ECM”, “Interna-
tional Transmission Mode”, and “V.34” check boxes. For details,
refer to the “User’s Guide [Fax Operations]”.
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20 When adding a cover sheet, select the “FAX Cover Sheet” check box.

— For setting up a fax cover sheet, refer to “Creating a Cover Sheet”
on page 5-33.

21 Click the [OK] button.

The Print dialog box appears again.

22 Click the [OK] button.
The FAX Send Confirmation dialog box appears.
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23 Click the [OK] button.

The fax is sent to the specified recipient.

V...

Note

When a fax transmission error occurs, a TX Report is automatically print-
ed. If you do not want the error report to be printed automatically, set “TX
Report” to “OFF” in the Report Settings screen from this machine’s con-
trol panel.

C351
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Creating a Cover Sheet

You can create a fax cover sheet and attach it to the fax message.

1 From the Printing Preferences dialog box, select the “FAX Cover
Sheet” check box on the FAX tab.

2 Clickthe [Setting] button.
The FAX Cover Sheet Setting dialog box appears.

3 Fromthe “Style” drop-down list, select the cover sheet format.
Styles include 00 to 03 (03 is for English).

4 Select the “Subject” check box, and then enter the subject of the doc-
ument being transmitted.

— Up to 64 characters can be entered in the “Subject” text box. In
Windows 98SE/Me, you can enter up to 64 characters.

5  Under “Recipient Information”, you can specify the recipient informa-
tion, such as the person’s name, for the cover sheet that is to be includ-
ed. The information shown in the “Recipients” list on the FAX tab is
entered on the cover sheet.

— Standard: Selects the standard recipient information. Select
“Standard”, and then select from the drop-down list the text to be
entered in the recipient information line. You can also enter charac-
ters.

C351
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— Details: Specify the recipient information individually. Select “De-
tails”, and then select the “Company”, “Department”, “Name”, or
“FAX Number” check box for the information to be entered in the
recipient information line. By clicking the [Settings] button, you can
select “Load with Joint Name”, “Change Each Recipient”, or “Load
Set Information” in the Destination Information Settings dialog box.
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— The first recipient cover sheet is displayed as a sample in the “Pre-
view” box.

- Up to 10 individual cover sheets can be created if “Change Each
Recipient” is selected. When sending 11 or more faxes with “Load
with Joint Name” or “Change Each Recipient” selected, the infor-
mation specified for “Standard” appears in the recipient information
line.

— If “Change Each Recipient” is selected, “Print Recipient File” can-
not be selected from on the Fax Mode Details dialog box, displayed
from the FAX tab.

— If “Destination” is not specified, “Load Set Information” cannot be
selected.

— Depending on the type of characters entered and the settings spec-
ified with “Style”, all characters entered may not be displayed on
the cover sheet. After entering the information, check that the infor-
mation is displayed properly in the image in the “Preview” box.

6 Select the “Company”, “Department”, “Name”, “Phone”, “FAX
Number”, or “E-mail” check box under “Sender Information” for the in-
formation that you want to enter in the sender information line, and then
click the [Settings] button to enter the main information to be sent on
the cover sheet.
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Depending on the type of characters entered and the settings spec-
ified with “Style”, all characters entered may not be displayed on
the cover sheet. After entering the information, check that the infor-
mation is displayed properly in the image in the “Preview” box.

Up to 40 characters can be entered for each item. In Windows
98SE/Me, you can enter up to 40 characters.
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The entered sender information appears in the image in the “Preview”
box.

7 To enter the current date on the cover sheet, select the “Date” check
box.

8 To enter the number of pages being sent, select the “Pages” check
box, and then specify the number of pages.

9 Towritea message on the cover sheet, enter the message in the “Com-
ment” text box.

If more that 25 characters are entered per ling, the characters may
not be displayed correctly on the cover sheet. Check the text in the
image in the “Preview” box, and then insert a return to adjust the
number of characters per line.

Up to 640 characters can be entered in the “Comments” text box.
In Windows 98SE/Me, you can enter up to 640 characters. A return
is equivalent to two characters.

C351
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10 1o arrange cover sheets with a company logo, maps, or other images,
select the “Image” check box, click the [Browse] button, and then
specify the file.

— You can adjust the position of the image by specifying numerical
values in the “X” and “Y” boxes, and you can adjust the image size
between 50% and 800% by specifying a zoom ratio in the “Zoom”
box.

11 Click the [Check] button to check the current settings.

The Check FAX Cover Sheet dialog box appears, and the cover sheet
is displayed at a larger size.
Check the contents of the cover sheet and make any changes to the
image as necessary.

12 Click the [OK] button.

The FAX Cover Sheet Setting dialog box appears again.
13 Select the cover sheet size in “Cover Size” drop-down list.

14 Click the [OK] button.

The Printing Preferences dialog box appears again.

...

Note
To erase all of the changed settings, click the [Restore Defaults] button
on the FAX Cover Sheet Setting dialog box.
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Registering a Recipient in the Phonebook

You can register the recipient of a fax message in the Phonebook.

Registering Recipient Information

1 In the Printing Preferences dialog box, click the [Phone Book] button in

the

FAX tab.

The Phonebook dialog box appears.
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2 Click the [Personal] button.

The [Personal Information] dialog box appears.

3 Enterthe appropriate information in the “Name”, “Fax No.”, “Compa-

nyn

, and “Department” text boxes. You can enter titles in the “Name”

text box.

It is not necessary to change the settings for the “ECM”, “Int. Tx”,

and “V.34” check boxes. For details, refer to the User’s Guide [Fac-
simile Operations].

Up to 40 characters can be entered in the “Name”, “Company”, and
“Department” text boxes.

C351
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— Up to 38 characters (numbers 0 through 9, hyphens (-), spaces, #,
*, E, P, and T) can be entered in the “Fax No.” text box.
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4 Click the [OK] button.

The recipient is registered and appears in the “Recipient” list.

5 Click the [OK] button.

The Save As dialog box appears.
Specify the storage location and enter the file name.

7 Clickthe [Save] button.

The Phonebook is saved as a file.

V...

Note

By clicking the [Folder] button in step 2, you can create a folder and
arrange the recipient information. To move the recipient into a folder,
right-click the recipient name in the directory tree on the left-side of the
dialog box, and then select “Copy” or “Cut”. Select the target folder, and
then select “Paste” to register the recipient in the folder.

Up to 40 characters can be entered as the folder name.
A folder can be up to three layers deep.

7o edit the recipient information and folder, select the desired data, and
then click the [Edlit] button.

To delete recipient information or a folder, select the recipient or folder
being deleted, and then click the [Delete] button.

C351
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When a recipient is registered in the Phonebook for the first time, the
Save As dialog box, described in step 5, appears so that the Phonebook
can be saved as a file. The Save As dialog box does not appear the next
time that the Phonebook is changed since the Phonebook file is
automatically overwritten.

The saved Phonebook file is automatically displayed the next time that
you open the Phonebook. To open a different Phonebook, select “Open
from the “File” menu in the Phonebook dialog box. By saving multiple
Phonebook files, you can switch between Phonebooks.

”

A new Phonebook can be created by clicking “New” in the “File” menu
on the Phonebook dialog box. You can save a file under a different name
by clicking “Save As” in the “File” menu.

The file extension for the Phonebook files is “.csv”.

C351
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5

Registering a Group

You can pre-register the recipients to which you want to send the same fax.

This is called a “group”.

1 On the Phonebook dialog box, select the recipient to be registered in

the group.

The selected recipient is highlighted.

2 Right-click the selected recipient, and then, from the “Add Group” sub-

menu, select the group where the recipient is to be registered.

The recipient is copied into the selected group.
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N

Note
Ten groups have been set. You cannot add or delete any group.

A total of 100 recipients can be registered in all 10 groups.

When a recipient is registered in the Phonebook for the first time, the
Save As dialog box appears so that the Phonebook can be saved as a
file. For details, refer to "Registering a Recipient in the Phonebook” on
page 5-37.

To change the group name, right-click the name of the group in the di-
rectory tree on the left-side of the dialog box, and then click “Edit”.

To delete a recipient from a group, click the group from which the recip-
lent is to be deleted, right-click the name of the recipient in the directory
tree on the left-side of the dialog box, and then click “Delete from Group”.

C351
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5.9 Specifying the Option Tab Settings

=57 T ~
S b

You can specify the options installed on this machine so that they can be

used from the printer driver.
Note
Ifthe installed options are not set from the Option tab, the option function
cannot be used with the printer driver. When installing options, be sure to
make the proper settings.

Specifying Settings

1 For Windows 98SE/Me/2000/NT 4.0, click the [Start] button, point to

“Settings”, and then click “Printers”. For Windows XP/Server 2003,
click the [Start] button, and then click “Printers and Faxes”.

2 Right-click the printer icon, and then click “Properties”.

3 Click the Option tab.

4 Select the installed option from the drop-down list.
Note
To automatically set the installed options, enter the printer name or IP ad-
dress of this machine in the “Printer Name or IP Address” box under “Op-
tion Information”, and then click the [Gather Option Information] button.
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5.10 Saving the Driver Settings

For PCL drivers, you can save the setting values of the changed driver and

recall them as necessary.

Saving the Driver Settings

1 Change the driver settings from the Setup tab and the Per Page Setting

tab.

2 Clickthe [Save/Restore Setting] button, and then select “Save Current
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3 Enter the file name in the “Name” text box.
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Enter a message in the “Comment” text box as necessary.

Specify a folder in the “Save Location” box, and then click the [OK] but-
ton.

The settings are registered in a library.

N

Note
The file extension is “.ksf”.

You can save up to 25 items in the library.

Up to 40 characters can be entered in the “Name” text box. In Windows
98SE/Me, you can enter up to 40 characters.

Up to 512 characters can be entered in the “Comments” text box. In Win-
dows 98SE/Me, you can enter up to 512 characters.

Restore the Settings

1 Click the [Save/Restore Setting] button on the Printing Preferences di-
alog box, and then select “Restore Saved Setting”.

2 Fromthe “Library” list, select the desired settings file.

3 Click the [OK] button.

The setting values are recalled, and the Printing Preferences dialog box
appears again.

Deleting the Settings

1

2
3

Click the [Save/Restore Setting] button on the Printing Preferences di-
alog box, and then select “Edit Library”.

From the “Library” list, select the desired settings file to be deleted.

Click the [Delete] button.

Note

Even if the settings file is deleted from the “Library” list, it will remain on
the hard disk of your computer. By specifying the file name in “Save Set-
ting File in Library”, you can save it in the “Library” list.
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6  Setting Up the PostScript Driver (Win-

dows)

6.1 Settings

Common Settings

The following describes the common settings and buttons that are displayed

on all tabs.

defopwad TRUE Lapd | Pm Page leiey | wemmanh | Gy | demm

Ll s sl CH R E_l_-l

=

arianr ]
R} et 1 = n.
E (& Lod - .
g bz L-'h-ﬂ ] Catm
| FraiL -

[hdgd "om % ] O

e i o Lo =
. ey .
yoe :

i -
Yoo

Fagm jjmaw [ =
duy -

Fopm Cmn | b i s
o P L

Button

Function

OK

Click this button to close the dialog box and apply any settings
that have been changed.

Cancel

Click this button to cancel any settings that have been changed
and close the dialog box.

Help

Click this button to display the help for each item on the cur-
rently displayed dialog box.

Save

Click this button to save the current settings and to view them
at a later time.

Edit

Click this button to change the saved settings.
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Button Function

Default Click this button to return the settings to their defaults, which
were selected when the driver was installed.

View When the [Paper] button is clicked, a preview of the page layout

as specified in the current settings is displayed and a preview
image of the print job can be checked.

When the [Printer] button is clicked, a printer figure is displayed
showing any options, such as the paper drawer, that are in-
stalled on this machine.

HDD

Paper Printer

V...

Note

To enable any installed options, you must specify the Option settings. For
details, refer to “Specifying the Option Tab Settings” on page 6-235.

Setup Tab
Item Function
Orientation Specifies the orientation of the image being printed on the paper.
Original Size Specifies the size of the original document.
Output Size Specifies the output paper size. Automatically enlarges or reduces
when the Original Size setting is changed.
Zoom Specifies the enlargement and reduction ratio.

Paper Source

Selects the paper source for printing.

Paper Type Selects the paper type for printing.

Copies Specifies the number of copies to print.

Collate Specifies whether to print multiple copies in sets.

Offset When printing multiple copies, shifts the output position of each set.

C351
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Item

Function

Output Tray

Selects the tray where to output the printed pages.

Output Method

Specifies output methods, such as “Secured Print” and “Save in
User Box”.

User Authentication/

Specifies the user ID and password for “User Authentication” and

Account Track password and box name for “Secured Print” and “Save in User Box”.
Layout Tab
Item Function

Combination

You can print multiple document pages on one page. Details can be
specified in Combination Details.

Rotate 180

Prints the image rotated 180°.

Double Sides

Specifies duplex printing.

Binding Position

Specifies binding position.

Staple

Specifies stapling.

Center Staple and Fold

Specifies the folding settings.

Hole-Punch Specifies hole punching.
Per Page Setting Tab
Item Function

Front Cover Page

Attaches a front cover page.

Paper Source

Selects the input tray for the front cover.

Back Cover Page

Attaches a back cover page.

Paper Source

Selects the input tray for the back cover.

Transparency Interleave

Outputs and inserts interleafs when printing overhead projector
transparencies.

Paper Source

Selects the input tray for the transparency interleaves.

Watermark Tab
Item Function
Watermark Prints a watermark (text stamp) on the page being printed. Water-
marks can be added, changed, or deleted.
Transparent Prints the watermark with a transparent background.

1st Page Only

Prints the watermark on the first page only.

Repeat

Prints several watermarks on a single page.

C351
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Quality Tab
Item Function
Select Color Specifies the color for printing.

Original Image Type

Specifies the contents of the original document.
Prints with a quality suitable for the original document.

Quality Adjustment

Adjusts the image quality. You can select “Simple” to adjust the en-
tire document or “Detailed” to separately adjust the text, photos,
and charts in the document.

Glossy Mode

Prints with a glossy finish.

Use Printer Fonts

Selects whether to use TrueType fonts or the printer fonts when
printing.

Download Fonts

Selects whether the fonts are downloaded to the printer as bitmap
or outline.

Advanced Tab

Item

Function

Detailed Print Function

Specifies whether to enable detailed print functions (booklet).

PostScript Output Op-
tions

Specifies the PostScript file output format.

PostScript Error Handler
Transmission

Specifies whether to print an error report when a PostScript error oc-
curs.

Horizontal Reverse Print-
ing

Reverses horizontally, then prints.

PostScript Pass Through

Allows applications to print directly without using a printer driver.

Device Settings Tab

Item

Function

Font Substitute List

Specifies the replacement of TrueType fonts with printer fonts.

Usable PostScript Mem-
ory

Specifies the usable PostScript memory size.

Output Protocol

Specifies the protocol for transmitting to the printer.

Send CTRL-D Before Job

Specifies whether to reset printer before printing.

Send CTRL-D After Job

Specifies whether to reset printer after printing.

Covert gray text to Post-
Script gray

Specifies whether to convert gray text in a document to PostScript
gray.

Covert gray graphics to
PostScript gray

Specifies whether to convert gray graphics in a document to Post-
Script gray.

Covert Euro Currency
Symbol to PostScript
Fonts

Specifies whether to convert the Euro currency symbol in a docu-
ment to PostScript fonts.
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Item

Function

Job Timeout

Printer stops printing when a print job is not completed within the
specified time.

Print Queue Timeout

Printer stops printing when the printer does not receive data within
the specified time from when the job was sent. Minimum Font Size
Downloaded as Outline.

Minimum Font Size
Downloaded as Outline

Specifies the minimum font size (pixels) when downloading Tru-
eType fonts as outline fonts. Fonts smaller than the minimum spec-
ified size are downloaded as bitmap fonts.

Maximum Font Size
Download as Bitmap

Specifies the maximum font size (pixels) when downloading Tru-
eType fonts as bitmap fonts. Fonts larger than the maximum spec-
ified size are downloaded as outline fonts.

N

Note

To display the Device Settings tab in Windows 2000/XP/NT 4.0/Server
2003, right-click the icon of the installed printer, and then click “Proper-

ties”.
Option Tab
Item Function
Option Specifies the options that are installed on this machine.

Gather Option Informa-
tion

Communicates with this machine and reads the status of the in-
stalled options.

PageScope Web Con-
nection

Starts up PageScope Web Connection.

...

Note

To display the Device Information tab in Windows 2000/XP/NT 4.0/Server
2003, right-click the icon of the installed printer, and then click “Proper-

ties”.

You cannot click the [Gather Option Information] button if you are not
connected to or able to communicate with this machine.
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Settings Tab

Item

Function

Displays message when
a prohibited action oc-
curs.

Displays a message when you want to perform a function that can-
not be set when the printer driver is being used.

Use the Server Property
Paper

Uses the added registered paper in [Server Properties].

N

Note

To display the Settings tab in Windows 2000/XP/NT 4.0/Server 2003,
right-click the icon of the installed printer, and then click “Properties”.

C351
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6.2 Specifying the Setup Tab Settings
B viiriing Pratuieres
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Printing to Suit the Paper Size
You can enlarge or reduce documents created when printing to match the
output paper size.
1 Click the Setup tab.
2 Fromthe “Original Size” and “Output Size” drop-down lists, select the
desired settings.
— You can also specify any enlargement or reduction ration in the
“Zoom” box.
C351 6-7
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Saving a Custom Size

A custom size can be specified and saved in advance as described below.

1 From the “Original Size” and “Output Size” drop-down lists, select
“Custom Size Settings”.

The Custom Size Settings dialog box appears.

2 Specify settings for the following:

— Size: Specify the width and length of the custom size according to
the selected measurement units.
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3 Click the [OK] button.
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Selecting the Output Method

Not only can you print directly, but you can select “Secured Print”, which re-
quires a password to print, or “Save in User Box”, which saves documents
in the document folder.

1 Click the Setup tab.

2 Fromthe “Output Method” drop-down list, select the output method.

Print: Prints immediately.

Secured Print: Saves the document to be printed in the secured
document box of this machine. When printing, you are required to
enter the user ID and password in this machine’s control panel. Se-
lect when printing highly confidential documents. (Up to 100 docu-
ments)

Save in User Box: Saves the document to be printed a box on this
machine.

Save in User Box and Print: Saves the document in a box at the
same time.

Proof and Print: After a part of the document has been printed, this
machine stops printing temporarily. Select to avoid misprinting
large print jobs.

C351
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6

Secured Printing

-  If“Secured Print” was selected, enter the ID and password in the dialog

box that appeared.
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Note

To print the document, specify [Secured Print] in the Box mode of this
machine, and then enter the ID and password. For details, refer to “Print

Job Management” on page 10-73.

For details on the box functions of this machine, refer to the User’s Guide

[Box Operations].

Save in User Box

=  When “Save in User Box” or “Save in User Box and Print” is selected,
specify the file name and box number in the dialog box that appears for

entering the file name and user box number.
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Note

For details on the box functions of this machine, refer to the User’s Guide

[/Box Operations].
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Proof and Printing

-  When a print job is sent, this machine stops printing temporarily after
part of the document has been printed. The remaining print job is
stored in this machine as a print job. When printing multiple copies, you
can print the remaining part of the print job after checking the print re-
sults.

...

Note

To print the document, specify the document in the Job mode of this ma-
chine, and then enter the ID and password. For details, refer to “Print Job
Management” on page 10-73.
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6

S

pecifying User Authentication Settings

If user authentication settings have been specified on this machine, a user
name must be entered.

1 Click the Setup tab.
2 Click the User Authentication/Account Track button.
3 Select the “User Authentication” check box, and then enter the user

name and password.
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Note

If this machine has been set to permit public users, the machine can be

used without a user name and password.

For user authentication settings, consult the administrator of this ma-

chine.
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Specifying Account Track Settings

If account track settings have been specified on this machine, you must en-
ter an account password in order to print a job.

1 Click the Setup tab.
2 Click the User Authentication/Account Track button.

3 Select the “Account Track” check box, and then enter the department
name and password.
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6.3 Specifying the Layout Tab Settings
defpwes] | Jmg LECY PuPage ey olsweps | iy | demes
Uisig & NETTE. - |_f=
[
ﬂ o -
™ Fpass VI L
] -
L pelomn Laiies Db Db el ¥ il
'|__I PR J = -
Bdeg P o P
Pl _J e - - =
L -n!-.T ] | s
o [ cess | == |
Printing Multiple Pages on One Page (N in 1)
You can print multiple document pages on one page. You can also specify
the “Booklet” setting to fold the printouts in two to make a booklet.
1  Click the Layout tab.
2 From the “Combination” drop-down list, select the number of pages to
be printed on one page.
C351 6-14

Download from Www.Somanuals.com. All Manuals Search And Download.



Setting Up the PostScript Driver (Windows) 6

To change the border line and printing order settings, click the [Com-
bination Details] button, and then change the settings in the dialog box
that appears.
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Note

When printing a job that contains pages of different sizes and orienta-
tions, images may be missing or overiapping when the document is print-
ed.

When optional finisher FS-603 is installed and “Booklet” is specified, you
can specify “Center Binding” for binding in the center of a page.

C351 6-15
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Duplex Printing
You can print a document onto both sides of a page. This comes in handy
when you want to bind multiple-page documents.

1 Click the Layout tab.

2 From the “Double Sides” drop-down list, select “Double-Sided”.

Note
The binding orfentation can be specified from the “Binding Position”
drop-down list.

Setting the File Margin

File margins are added to the document before it is printed.
1 Click the Layout tab.

2 Fromthe “Binding Position” drop-down list, select the position of the
binding margin.

Stapling
Multiple-page documents can be stapled.

The staple function is available only when optional finisher FS-507 or FS-603
is installed.

1 Click the Layout tab.

2 Fromthe “Staple” drop-down list, specify the number of staples and
the stapling position.

...

Note
Depending on the selected Binding Position setting, different stapling po-
sitions are available.

Number of pages that can be stapled when FS-507 is installed: Up to 50
pages on 8-1/2 x 11 ca or smaller plain paper, and up to 25 pages on 8-
1/2 x 14 or larger paper. Number of pages that can be stapled when FS-
603 /s installed: Up to 50 pages on 8-1/2 x 11 & or smaller plain paper,
and up to 25 pages on 8-1/2 x 14 or larger paper.

C351
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Hole Punching
Holes can be punched into the printed document.

The hole punch function is available only when optional finisher FS-507 or
FS-603 is installed. When using optional finisher FS-603, the punch kit must
be installed.

1 Click the Layout tab.

2 From the “Hole-Punch” drop-down list, select the number of punched
holes.

...

Note
Depending on the selected Binding Position setting, different hole-
punching positions are available.

C351
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6.4 Specifying the Per Page Setting Tab Settings
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Printing Documents with a Front Cover/Back Cover
1 Click the Per Page Setting tab.
2 From the “Front Cover Page” and “Back Cover Page” drop-down lists,
select the desired printing settings.
To print on the front cover and back cover, select “Printed”. To only
add a blank page, select “Blank”.
3  Selectthe input tray that contains the loaded paper for the front cover
and back cover.
C351 6-18
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6.5

Specifying the Watermark Tab Settings
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Printing a Watermark

You can print specific text in the background as a watermark.
1 Click the Watermark tab.
2 From the drop-down list, select the watermark that you want to print.

3 Specify settings for the following:

Transparent: The watermark is transparent.
1st Page Only: Prints the watermark only on the first page.
Repeat: Prints several watermarks on one page.

V...

Note
If “Booklet” was selected in the “Combination” drop-down list, the water-
mark is not printed.

C351
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6

Editing a Watermark

You can change the fonts and position of the watermark and you can register

a new one.
1 Click the Watermark tab.
2  Tocreatea watermark, click the [Add] button.
- To change a watermark, select the watermark to be changed, and
then click the [Edit] button.
3 Specify settings for the following:
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Watermark Name: Specifies the watermark name being registered.
Watermark Text: Specifies the watermark text.

Font Name, Size, Style, Angle, Color, and Frame: Specifies the font,
font size, style, text angle, color, and frame of the watermark.
Position: Specifies the watermark position with the horizontal and ver-
tical scroll bars.

Sharing: Specifies whether to register the watermark as public or pri-
vate.

V...

Note
Only the administrator can select a setting under “Sharing”.
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6.6

Specifying the Quality Tab Settings
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Specifying Settings
1 Click the Quality tab.

2 Specify settings for the following:

— Original Image Type
Specifies the contents of the original document. Prints with a qual-
ity suitable for the original document.
Document: Prints with a quality suitable for documents with many
characters.
Photo: Prints with a quality suitable for photos.
DTP: Prints with a quality suitable for documents produced using
DTP.
Web: Appropriate for printing web pages. Smoothly reproduces
low resolution images.
CAD: Appropriate for originals composed of fine lines. Reproduces
images with high resolution.

— Select Color
Color: Prints in color.
Grayscale: Prints in grayscale.

— Quality Adjustment
Detailed: Separately adjusts the quality of each item (text, photos,
and charts) in the document.

— Glossy Mode
Prints using a gloss finish.

C351
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Font Settings
You can replace the TrueType fonts used in Windows with the printer fonts
of this machine.

1 Click the [Font Settings] button.

2 Specify settings for the following:

Download Font Format: Select the TrueType downloading method.
User Printer Fonts: Replace TrueType fonts with the printer fonts.

N

Note
Using the printer fonts will shorten the printing time, however, there may
be a difference in the screen display and the print results.

When using TrueType fonts, select from the “Download Font Format”
drop-down list the font type to be downloaded to the printer.

Specify the font replacement list from the Device Settings tab.

C351
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6.7 Specifying the Option Tab Settings
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You can specify the options installed on this machine so that they can be
used from the printer driver.

V...

Note

Ifthe installed options are not set from the Option tab, the option function
cannot be used with the printer driver. When installing options, be sure to
make the proper settings.

Specifying Settings

1 For Windows 2000/NT 4.0, click the [Start] button, point to “Settings”,
and then click “Printers”.

— For Windows XP/Server 2003, click the [Start] button, and then
click “Printers and Faxes”.

2 Right-click the printer icon, and then click “Properties”.
3 Click the Option tab.

4 Select the installed option from the drop-down list.
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N

Note

The installed option can be automatically registered in the “Option” list by
clicking the [Gather Option Information] button when connected to this
machine.
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6.8 Saving the Driver Settings

For PostScript drivers, you can save the setting values of the changed driver
and recall them as necessary.

Saving the Driver Settings
1 Change the driver settings from the Setup tab and the Layout tab.

2 Click the [Save] button.
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3 Enter the file name in the “Name” text box.

HE =

L sl

4  Entera message in the “Comment” text box as necessary.
5 Specify whether to register the watermark as public or private.

6 Click the [OK] button.

The settings are registered in a library.

...

Note
The file extension is “.ksf”.

You can save up to 25 items.

Only the administrator can select a setting under “Sharing”.

Restore the Settings
-  Select the settings to restore from the “Easy Set” drop-down list on the
Printing Preferences dialog box.

The setting values are recalled, and the Printing Preferences dialog box
appears again.
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Changing the Settings
1 On the Printing Preferences dialog box, click the [Edit] button.

2 Fromthe list, select the file that you want to change, and then change
the setting. To delete the file, click the [Delete] button.

3 Click the [Options] button, check the settings to recall, and then click
the [OK] button.
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4 Click the [OK] button.
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O
7  Setting Up the PPD Driver (Windows)

71 Settings

KONICA MINOLTA C351 PS[P) Properties 2=l
Graphics I Fonts I Device Dptions I PostScript |
General I Dretailz I Color Management Paper
Paper zige:  Letter [8.50 % 11.00 in]
100 5
12418 Tabloid Legal Statement
Kl [ 2
— Layout
Dalup Elrgup rgup
r— Qrientation
' Portrait
A
" Landscape I~ | Botated
Faper zource: | AutoSelect Tray ;I
LCopies: |1 _|::' Unprintable Area... |
Iore Options... | About.... | Fiestore Defaults |
QK I Cancel | Lpply |
Paper Tab
Item Function
Paper size Specifies the paper size.
Layout Specifies the number of pages printed on one page.
Orientation Specifies the orientation.
Rotated Rotates the paper.
Paper source Selects the input tray.
Copies Specifies the number of copies to print.
More Options Specifies the paper type and output device.

C351
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Graphics Tab
Item Function
Resolution Specifies the print resolution.

Color Control

Specifies whether to adjust the color to that on the screen.

Halftone Specifies the halftone number of lines and the pattern angle.
Other Prints a negative or mirror image.
Magnification Specifies the enlargement and reduction ratio.

Device Options Tab

To specify the following printer-specific options, right-click the printer icon in
the Printers window, and then click “Properties” in the menu that appeared.

Item Function
Collate Specifies whether to print multiple copies in sets.
Offset When printing multiple copies, shifts the output position of each set.

Binding Position

Specifies the binding position.

Duplex Specifies duplex printing.
Special Mode Specifies booklet printing.
Staple Performs stapling.

Hole Punch Performs hole punching.
Fold Performs folding.

Front Cover

Attaches a front cover page.

Front Cover Tray

Selects the input tray for the front cover.

Back Cover

Attaches a back cover page.

Back Cover Tray

Selects the input tray for the back cover.

OHP Interleaving

Inserts interleaves between overhead projector transparencies.

OHP Interleaving Tray

Selects the input tray for the transparency interleaves.

Stop

Stops printing temporarily after part of the document has been print-
ed so that the proof print can be checked.

Color Selection

Specifies whether to print in color or grayscale.

Gloss Mode

Prints using a gloss finish.

Original Document Type

Prints with a quality suitable for the original document.

Color Matching (Text)

Adjusts the color quality of the text in a document.

Grayscale (Text)

Specifies whether to enable grayscale of the text in a document.

Screening (Text)

Specifies screening of the text in a document.

Color Matching (Photo)

Adjusts the color quality of photos in a document.

C351
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Item

Function

Grayscale (Photo)

Specifies whether to enable grayscale of photos in a document.

Screening (Photo)

Specifies screening of photos in a document.

Smoothing (Photo)

Specifies smoothing of photos in a document.

Color Matching (Charts
and Graphs)

Adjusts the color quality of a chart and graph in a document to the
text or photo settings.

Smoothing (Charts and
Graphs)

Adjusts the smoothing process of a chart and graph in a document
to the text or photo settings.

You can specify the following options by right-clicking the printer icon in the
Printers window, then clicking “Properties”.

Item

Function

Usable Printer Memory

Specifies the memory installed on this machine.

Usable Option Specifies the options installed on this machine.
PostScript Tab
Item Function

PostScript Output Meth-
od

Specifies the PostScript file output method.

PostScript Header

Specifies whether to transmit header information to the printer.

Print PostScript Error In-
formation

Specifies whether to print PostScript error reports.

PostScript Timeout Val- | Specifies the time for a timeout.
ue
Fonts Tab
Item Function
Send TrueType fonts to | Prints the font specified in the Font Substitution Table with the print-

the printer according to
font Substitution Table

er fonts.
The Font Substitution Table can be specified by clicking the [Edit the
Table] button.

Always use built-in print-
er fonts instead of Tru-
eType fonts

Prints all fonts with printer fonts.

Always use TrueType
fonts

The printer fonts are not substituted.

Send Fonts As

Specifies the font transmission method.

C351
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7.2 Specifying the Paper Tab Settings

You can specify the orientation and number of pages to be printed on one
page when printing.

Specifying Settings

1 Click the Paper tab.

KONICA MINDLTA C351 PS(P) Properties 2=l
Paper |Graphics| Device Dptionsl PostScriptI
Paper zige:  Letter [8.50 % 11.00 in]
12418 Tabloid Legal Letter Statement
Kl L i
— Layout
B @ B
r— Qrientation
' Portrait
A
" Landscape I~ | Botated
Faper zource: | AutoSelect Tray ;I
LCopies: |1 _|::' Unprintable Area... |
Iore Options... | About.... | Fiestore Defaults |

QK I Cancel | Lpply |

2 Specify settings for the following:

Paper size: Specifies the paper size.

Layout: Specifies printing multiple pages on one page (N in 1 printing).
Orientation: Specifies the orientation

Rotated: Rotates the paper.

Paper source: Selects the input tray.

Copies: Specifies the number of copies to print.

More Options: Specifies the paper type and output device.

C351
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7.3 Specifying the Device Options Tab Settings

You can specify advanced functions such as the finisher function and color
adjustments from the Device Options tab.

Specifying Setting
1 Click the Device Options tab.

2  Selecta function, and then select the setting from the “Change setting
for” drop-down list.

KONICA MINDLTA C351 PS(P) Properties 21l

Paper I Graphics Device Options | PostScriptI

Frinter feature:

| Oiffset il
Binding Poszition Left Binding LI

Change zetting for: Collated

On =

Fiestore Defaults |
QK I Cancel | Lpply |

N

Note
For the items and functions that can be specified, refer to “Settings” on
page 7-1.
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N

Note
The fold function is available only when optional finisher FS-507 or FS-

603 /s installed.

Number of pages that can be stapled when FS-507 is installed: Up to 50
pages on 8-1/2 x 11 ca or smaller plain paper, and up to 25 pages on 8-
1/2 x 14 or larger paper. Number of pages that can be stapled when FS-
603 /s installed: Up to 50 pages on 8-1/2 x 11 & or smaller plain paper,

and up to 25 pages on 8-1/2 x 14 or larger paper.

The hole punch function is available only when optional finisher FS-507
or FS-603 is installed. When using optional finisher FS-603, the punch kit
must be installed.

C351
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7.4 Specifying the Options

You can specify the options installed on this machine so that they can be
used from the printer driver.

If the installed options are not set from the Device Options tab, the option
function cannot be used with the printer driver. When installing options, be
sure to make the proper settings.

Specifying Settings

1 For Windows 98SE/Me, click the [Start] button, point to “Settings”, and
then click “Printers”.

2 Right-click the printer icon, and then click “Properties”.
3 Click the Device Options tab.

4 selecta function, and then select the setting from the “Change setting
for” drop-down list.

KONICA MINOLTA C351 PS(P) Properties 2=l
General I Dretailz l Color kM anagement I Paper I
Graphics I Faonts Device Options | PostScript

Awailable printer memary [in KB I E

r— Printer feature:

Offset off
Binding Poszition Left Binding LI

Change zetting for: Collated

[ o =

— Installable option

Nane

LChange setting for: Paper Sources

Mone =

Fiestore Defaults |
QK I Cancel | Lpply |

...

Note

For the items and functions that can be specifieqd, refer to “Settings” on
page 7-1.
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8

Setting Up the PPD Driver (Mac OS 9.2)

8.1 Settings
The functions of this machine can be specified on the Paper Setup and Print
dialog boxes displayed from an application.
The settings can only be applied while using the application. When the ap-
plication is exited, the settings return to their defaults.
Page Setup Dialog Box
LaserWriter 8 Page Setup Betic]
- | Page Attributes i]
Formatfor: [ KONICAMINOLTA C351 | %]
Paper: [Letter i]
% Orientation:
Scale:%
(T
C351 8-1
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Page Setup ltems

Menu Item Function
Page Attributes Paper Specifies the paper size.

Orientation Specifies the orientation.

Scale Specifies the enlargement and reduction ratio.
PostScript Options | Flip Horizontal Prints the image flipped horizontally.

Flip Vertical

Prints the image flipped vertically.

Invert Image

Prints a negative image.

Substitute Fonts

Replaces some fonts with printer fonts.

Smooth Text

Smooths text data.

Smooth Graphics

Smooths graphic data.

Precision Bitmap

Corrects jagged graphic images.

Alignment
Unlimited Download-| Does not limit downloading screen fonts.
able Fonts
Custom Page Sizes| Units Selects the specified unit.
Paper Size Specifies any paper size.
Margins Specifies the paper margins.

Custom Page Size
Name

Enters the registered name for the specified paper
size and margin after the [OK] button is clicked.

...

Note

Depending on the application, “Page Setup” may be displayed as “Paper
Setup”. In addition, you may have to select “Paper Setup”— “Options”
from the “File” menu.

The dialog boxes differ depending on the application.

C351
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Print Dialog Box

8.7.1
Printer: [ KONICAMINOLTA C351 =i Destination:
r [ General i]

Copies:D [ Collated
Pages: @ All

) From:
Paper Source: @ All pages from: [ Auto Select

Ak

() First page from: [ Tray 1

E13

E13

Remaining from: [ Tray 1

Save Settings

]

Print ltem
Menu Item Function
General Copies Specifies the number of copies to print.
Collated Prints multiple copies in sets.
Pages Specifies the print range to print.
Paper Source Selects the input tray.
Color Matching Color Selection Specifies the color for printing.

Matching Style

Selects the matching method.

Printer Profile

Specifies the color adjustment profile of the out-
put device.

Background Print-
ing

Printing Method

Specifies background printing.

Print Time

Specifies the priority level and print time.

Save as File

Format

Specifies the output format of the PostScript
file.

PostScript Level

Specifies the PostScript level.

Data Format

Specifies the format to save a document.

Save Fonts

Specifies whether to include the font data on a
file.

Font Settings

Font Settings

Adds information to the font key.

Font Download

Specifies the conditions to download fonts.

C351
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Menu Item Function
Layout Pages per sheet Specifies the number of pages to print on one
page.
Layout direction Specifies the page order for printing multiple
pages on one page.
Border Specifies the borders around pages.
Job Logging When a PostScript Specifies the PostScript error report conditions.
Error Occurs
Operation Record Specifies the conditions for the operation record
to be saved.
Operation Record File | Specifies the folder to which the operation
record is to be saved.
Cover Page Print Cover Attaches a cover.

Cover Paper Source

Selects the cover input tray.

Finishing Options 1

Offset

Specifies offset.

Output Tray

Selects the output tray.

Binding Position

Selects the binding position.

Duplex

Performs duplex printing.

Combination

Selects booklet printing.

Staple Performs stapling.
Punch Performs hole punching.
Finishing Options 2 | Fold Performs folding.

Front Cover

Attaches a front cover page.

Front Cover Tray

Selects the input tray for the front cover.

Back Cover

Attaches a back cover page.

Back Cover Tray

Selects the input tray for the back cover.

OHP Interleaving

Inserts interleaves between overhead projector
transparencies.

OHP Interleaving Tray

Selects the input tray for the transparency inter-
leaves.

C351
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Menu Item Function
Finishing Options 3 | Stop Stops printing temporarily after part of the doc-
ument has been printed so that the proof print
can be checked.
Resolution Specifies the print resolution.

Color Selection

Specifies whether to print in color or grayscale.

Gloss Mode

Prints using a gloss finish.

Original Document
Type

Prints with a quality suitable for the original doc-
ument.

Color Matching (Text)

Adjusts the color quality of the text in a docu-
ment.

Grayscale (Text)

Specifies whether to enable grayscale of the text
in a document.

...

Note

The dialog boxes differ depending on the application.

C351
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8.2 Page Setup
Page Attributes (Basic Settings)
1 Select “Paper Setup” or “Page Setup” from the “File” menu.

2  Select “Page Attributes”.

LaserWriter 8 Page Setup

=+ Page Attributes S
PostScript™ Options
Custom Page 5izes
Paper: [Letter i]

fi\:j orientation:
Sl:ale:%

(T

Formatfor: [ KONICAMINOLTA C351 | %]

3 Specify settings for the following:

Paper: Specifies the paper size.
Orientation: Specifies the orientation.
Scale: Specifies the enlargement and reduction ratio.

LaserWriter 8 Page Setup Betic]

- | Page Attributes i]

Formatfor: [ KONICAMINOLTA C351 | %]

Paper: [Letter i]

fi\:j orientation:
Sl:ale:%

(T

...

Note
The folding function can be selected from the screen that is displayed
when “Layout” is selected in the Print dialog box.

C351
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Custom Page Sizes

1 Select “Paper Setup” or “Page Setup” from the “File” menu.

2 Select “Custom Page Sizes”.

3 Specify settings for the following:

Paper Size: Specifies the paper size.
Margins: Specifies the paper margins.
Custom Page Size Name: Enter the registered name for the specified

paper size and margin, and then click the [OK] button.

Units: Selects the specified unit.

Paper Size
Width:

Height:

3.5

5.51

Width offset: 0

Height offset: 0

Margins

Custom Page 5ize Name: ICustom Page Size 1 I

(Ccancer J ok J|

4 Click the [OK] button.

This registers the custom page settings, and allows you to select the
paper in the screen that appears when “Page Attributes” is selected.

C351
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PostScript Options
1 Select “Paper Setup” or “Page Setup” from the “File” menu.
2  Select “PostScript Options”.

3 Specify settings for the following:

Visual Effects: Provides “Flip Horizontal”, “Flip Vertical”, and “Invert
Image” (negative image).

Substitute Fonts: Replaces some fonts with printer fonts.

Smooth Text: Smooths text data.

Smooth Graphics: Smooths graphic data.

Precision Bitmap Alignment: Corrects jagged graphic images.
Unlimited Downloadable Fonts: Does not limit downloading screen
fonts.

LaserWriter 8 Page Setup Betic]

- | PostScript™ Options i]

Visual Effects:

[ Flip Horizontal
[ Flip Vertical
[ Invert Image

Image & Text:

[ Substitute Fonts

[ Smooth Text

[ Smooth Graphics

[ Precision Bitmap Alignment
[ Unlimited Downloadable Fonts

(T

Ed
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8.3 Printing
General (Basic Settings)
1 From the “File” menu, select “Print”.

2 Select “General”.

8.7.1

Printer: [ KONICAMINOLTA C351 =i Destination:

Background Printing
Color Matching 4 Collated
Cover Page
Font Settings
Job Logging To:

Layout J |—|

Save as File

s from: [Auto Select

Ak

Finishing Options 1
Finishing Options 2
Finishing Options 3 ing from: [Trm,r 1
Finishing Options 4

(o

gefrom: |Tray 1

E13

E13

3 Specify settings for the following:

Copies: Specifies the number of copies to print.
Collated: Prints multiple copies in sets.

Pages: Specifies the print range to print.

Paper Source: Selects the input tray.

8.7.1
Printer: [ KONICAMINOLTA C351 =i Destination:
r [ General i]
Copies:D [ Collated
Pages: @ All

Paper Source: @ All pages from: [Auto Select

Ak

() First page from: [ Tray 1

E13

Remaining from: [ Tray 1

E13

(o

C351
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Layout (Printing Multiple Pages on One Page)

You can specify printing multiple pages on one page of paper or duplex
printing.

1 From the “File” menu, select “Print”.

2  Select “Layout”.

3 Specify settings for the following:

Pages per sheet: Specifies the number of pages to print on one page.
Layout direction: Specifies the document page order.
Border: Specifies the borders around pages.

8.7.1

Printer: [ KONICAMINOLTA C351 =i Destination:
r [ Layout i]

Layout direction:
Save Settings |

C351
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Printer Specific Options (Finishing Options 1 to 4)

You can specify printer-specific options. You can specify this option when
using the staple or hole punch functions of this machine.

From the “File” menu, select “Print”.
Select “Finishing Options 1 to 4”.

Specify settings for the following:

Offset: Specifies offset.

Output Tray: Selects the output tray.

Binding Position: Specifies the binding position.

Duplex: Performs duplex printing.

Combination: Specifies booklet printing.

Staple: Performs stapling.

Punch: Performs hole punching.

Fold: Performs folding.

Front Cover: Attaches a front cover page.

Front Cover Tray: Selects the input tray for the front cover.

Back Cover: Attaches a back cover page.

Back Cover Tray: Selects the input tray for the back cover.
Transparency Interleaving: Inserts interleaves between overhead pro-
jector transparencies.

Transparency Interleaving Tray: Selects the input tray for the transpar-
ency interleaves.

Temporary Stop: Stops printing temporarily after part of the document
has been printed so that the proof print can be checked.

Resolution: Specifies the resolution.

Color Selection: Specifies whether to print in color or grayscale.
Glossy Mode: Prints using a gloss finish.

Original ImageType: Prints with a quality suitable for the original docu-
ment.

Color Matching (Text): Adjusts the color quality of the text in a docu-
ment.

Grayscale (Text): Specifies whether to enable grayscale of the text in a
document.

Screening (Text): Specifies screening of the text in a document.

Color Matching (Photo): Adjusts the color quality of photos in a docu-
ment.

Grayscale (Photo): Specifies whether to enable grayscale of photos in
a document.Screening (Photo): Specifies screening of photos in a doc-
ument.

Smoothing (Photo): Specifies smoothing of photos in a document.
Color Matching (Charts and Graphs): Adjusts the color quality of a chart
and graph in a document to the text or photo settings.

C351
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8

Smoothing (Charts and Graphs): Adjusts the smoothing process of a

chart and graph in a document to the text or photo settings.

8.7.1

Printer: [ KONICAMINOLTA C351 =i Destination:

- [ Finishing Options 1 B

Offset:

Output Tray:
Binding Position:
Duplex:

Combination:

Punch: _

Crone J

C351
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8.4  Setting Options

You can specify the options installed on this machine so that they can be
used from the printer driver.

...

Reminder

If the installed options on this machine are not set from the Installable Op-
tions screen, the option function cannot be used with the printer driver.
When installing options, be sure to make the proper settings.

Specifying Settings

1 On the Apple menu, click “Chooser”.
2 Select the printer name.

3 Click the [Setup] button.
4

Click the [Configure] button.

The setting screen for adding options appears.

Current Printer Description File (PPD) Selected:
— “KONICAMINOLTAC351V0.0.7.ppd™

Installable Options

Paper Sources:
Finisher:
Punch Unit:
Printer HDD:

Cancel ] H 0K ]l

5  Selectthe option that is installed on this machine.

6 Click the [OK] button.

The Chooser window appears again.

7 Close the Chooser window.

C351
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N

Note
The option settings are displayed automatically the first time the printer
driver is selected. For details, refer to “Selecting a Printer” on page 2-18.

C351
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I
9  Setting Up the PPD Driver (Mac OS X)

9.1 Settings

The functions of this machine can be specified on the Paper Setup and Print
dialog boxes displayed from the application.

The settings can only be applied while using the application. When the ap-
plication is exited, the settings return to their defaults.

Page Setup Dialog Box

SaTindgs Fisps AlEribulen i‘l

Format for | so0eC AR TA © 35 3|
EDRSCA MiROLTA CHE1

Paper Saxec | B 0/3nil i

A% in w 00080 bn

=
Chisk vt it by I-Il lT:-l |
%

Seaks |00

T Carewl H—‘

Page Setup ltems

Menu Item Function
Page Attributes Paper Size Specifies the paper size.

Orientation Specifies the orientation.

Scale Specifies the enlargement and reduction ratio.
Custom Paper Size | Paper Size Specifies any paper size.

Printer Margins Specifies the paper margins.

C351
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N

Note

Depending on the application, “Page Setup” may be displayed as “Paper
Setup”. In addition, you may have to select “Paper Setup”— “Options”
from the “File” menu.

The dialog boxes differ depending on the application.

Print Dialog Box

PFremngr

Preinli Sigesdip

Coigintss & Pl i

EOMICAMBMOLTA C351

Copas || & Cottated
Pagei & aii
Fromi | in
7 Provaew Sarvr A PO L i P
Print ltem

Menu Item Function
Copies & Pages Copies Specifies the number of copies to print.

Collated Prints multiple copies in sets.

Pages Specifies the print range to print.
Layout Pages per Sheet Specifies the number of pages to print on one

page.

Layout Direction Specifies the document page order.

Border Specifies the borders around pages.
Output Options Output format Specifies the format of the file being output.
Scheduler! Print Document Specifies the print time.

Preferred Order Specifies the priority level.
Paper Processing'1 Reverse Page Prints pages in the reverse order.

Order

Print Selects the pages for printing.

C351
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Menu

Item

Function

CoIorSync'1

Color Conversion

Specifies the color conversion method.

Quartz Filter

Specifies the color for printing.

Cover Page*1

Print Cover Page

Specifies whether to attach a cover page.

Cover Page Type

Selects to print “Confidential” or other comments
on the cover page.

Error Handling

PostScript Error

Specifies whether to print an error report when a
PostScript error occurs.

Paper Feed All pages from Selects the input tray.
First page from Selects the input tray.
Remaining from Selects the input tray.

Output Settings Collate Prints multiple copies in sets.
Offset Specifies offset.
Duplex Performs duplex printing.
Output Tray Selects the output tray.
Binding Position Specifies the binding position.
Combination Specifies booklet printing.
Staple Performs stapling.
Punch Performs hole punching.
Fold Performs folding.

Quality Resolution Specifies the resolution.
Glossy Mode Prints using a gloss finish.

Original Image Type

Prints with a quality suitable for the original docu-
ment.

Color Matching
(Text)

Adjusts the color quality of the text in a document.

Pure Black (Text)

Specifies whether to enable grayscale of the text in
a document.

Screen (Text)

Specifies screening of the text in a document.

Color Matching
(Photo)

Adjusts the color quality of photos in a document.

Pure Black (Photo)

Specifies whether to enable grayscale of photos in
a document.

Screen (Photo)

Specifies screening of photos in a document.

Smoothing (Photo)

Specifies smoothing of photos in a document.

Color Setting
(Graphic)

Adijusts the color quality of a chart and graph in a
document to the text or photo settings.

Smoothing (Graph-
ic)

Adjusts the smoothing process of a chart and
graph in a document to the text or photo settings.

Download from Www.Somanuals.com. All Manuals Search And Download.
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Menu Item Function
Setup Media Selects the paper type.
Front Cover Page Attaches a front cover page.
Paper Tray (Front Selects the input tray for the front cover.
Cover Page)
Back Cover Page Attaches a back cover page.
Paper Tray (Back Selects the input tray for the back cover.
Cover Page)
Transparency Inter- | Inserts interleaves between overhead projector
leave transparencies.
Paper Tray (Trans- | Selects the input tray for the transparency inter-
parency Interleave) | leaves.
Security Output Method Specifies output methods, such as “Secure Print”

and “Save in User Box”.

Secure Print Set-
tings

Specifies user ID and password for “Secure Print”.

Save in User Box
Settings

Specifies the file name and box name for “Save in
User Box”.

User Authentication

Checks if user authentication settings have been
applied and specifies user ID and password.

Account Track

Checks if account track settings have been ap-
plied and specifies the department name and
password.

V...

Note

The dialog boxes differ depending on the application.

The items indicated by “*1” are displayed only in Mac OS 10.3.

C351
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9.2 Page Setup
Page Attributes (Basic Settings)
1  Sselect “Page Setup” or “Paper Setup” from the “File” menu.

2 Select “Page Attributes”.

sewoo: TR
Custom Faper Size ]

Fuﬂr::l:in-l| Summary '
| Save As Defau |

Papersze IR T E

B50 i x 0.0 in

Chrst rvi it e Ii @ T

scie [jog | ®

@ (Cance ) ()

3 Specify settings for the following:

Paper Size: Specifies the paper size.
Orientation: Specifies the orientation.
Scale: Specifies the enlargement and reduction ratio.

Serings: | Page Arributes iR

Format for | sOMCABIRGE TA 351 |
KDWSCA MIROLTA C351

Paper 5ire | B §idwii $I
A0 inx 0003 in

Chrst rvi it e Ii @ T

scie [jog | ®

@ (e )
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Custom Paper Size

1 Select “Page Setup” or “Paper Setup” from the “File” menu.

2 Select “Custom Paper Size”.
3 Click the [New] button.
4 Enterthe paper size name.
5 Specify settings for the following:
Paper Size: Specifies any paper size.
Printer Margins: Specifies the paper margins.
Serongs | Custem Paper Lirs l_f:l
T
Durrr
Thwem
[
Paper Sare Prionar Blarge
Fbghi. 1.0 1 L] Taw O.F¥ b
Wisth i w8 i - o s
lerinem 0157 [
T Cancwl Ii_&_:l

6 Click the [Save] button.

7 Click the [OK] button.

This registers the custom paper size which allows you to select the pa-
per size in the screen that appears when “Page Attributes” is selected.

C351
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9.3 Printing
Copies & Pages (General Settings)
1 From the “File” menu, select “Print”.
2 Select “Copies & Pages”.

Frimegr: | WONCAMUTA (351

ol
[T ST SR gy o

Larwast
Caplas Durtpat Ciptaseny
Srheduler
Papst Handling |
ColorSym
Corery Fage
1 Error Hasdling
® (i) (3 ioerro Camcel | (0T
Finiihing
Sebap
Secarnty
Sumramary

3 Specify settings for the following:

Copies: Specifies the number of copies to print.
Collated: Print multiple copies in sets.
Pages: Specifies the print range to print.

PFreper: | DM AMMOLTL TS

Pty | Sigesfiurd

L RCIRE

Cops & Pages

Copas [} | B Cattated
Pages: & aii

AFrem ] o 1]

'_7.‘3' I_Pr-n-wli: I.i.luwmfﬁl' ) [ Fam | Crriwl | @
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Layout (Printing Multiple Pages on One Page)

You can print multiple pages on one sheet.
1 From the “File” menu, select “Print”.
2 Select “Layout”.

3 Specify settings for the following:

Pages per Sheet: Specifies the number of pages to print on one page.
Layout Direction: Specifies the document page order.
Border: Specifies the borders around pages.

Primcer | EOMNCAMIBOLTA (351 =]
Freirti | Sigestsrd =
Layout _: |
Pagei ped vt | ] :_:__'
Largun Dimtion F'i! 5 A N
Eorger | Monwe _H
17 Fresmw S M PO  Fax Cascel E i a— .]
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Paper Feed

You can specify the input tray for printing.

1 From the “File” menu, select “Print”.
2  Select “Paper Feed”.
3 Specify settings for the following:
All pages from: Selects the input tray to print all pages.
First page from: Selects the input tray to print the first page.
Remaining from: Selects the input tray to print from the second page.
Frasoer: | RONCAMBOILTA C351 o
Peeiati LYFE T, ] TI
Papei Feed 2]
55 aji pages Frpem Ao SRle TI
Firnt page From
B rvia e TG
Frovare Laror ha BOH Fas Ll £ P
Security

Not only can you print directly, but you can select “Secure Print”, which re-
quires a password to print, “Save in User Box”, which saves documents in a
box, “Proof and Print”, which prints the first set of multiple copies and tem-
porarily stops printing, “Authentication Settings”, which requires user au-
thentication, and “Account Track Settings”, which manages the number of
printed pages.

1
2

From the “File” menu, select “Print”.
Select “Security”.

Specify settings for the following:

Output Method: Specifies conditions for “Secure Print” and “Save in
User Box”.

Secure Print Settings: Enters ID and password when “Secure Print” is
selected from the “Output Method” drop-down list. Enter the ID and
password on this machine's control panel when printing. (Up to 100
documents)

C351
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Save in User Box Settings: Enters file name and box number when
“Save in User Box” or “Save in User Box and Print” is selected from the
“Output Method” drop-down list.

User Authentication: Registers the user name and password when user
authentication settings have been applied on this machine and when
the check box is selected. If this machine has been set to permit public
users, the machine can be used without a user name and password.
Account Track: Registers the access name and password when ac-
count track settings have been applied on this machine and when the
check box is selected.

Frister: | EONCAMINDLTA C351 T
PreLEry s LT, -l

YL LTy 3

wffud i lhod Pl

h_l'l_lur Autherssanagn '!‘ Arrount Track

= P Lhoer Drpasimend Kame
Begapeard e

Panvardnd

Enharnded Sedaiily

T Prewas Sarew A PO [ Larsi E:ﬂ;:\-*

...

Note
Print the document from the control panel of this machine. For details, re-
fer to “Print Job Management” on page 10-73.

For details on the box functions of this machine, refer to the User’s Guide
[Box Operations].

C351
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9

Finishing

You can specify these options when using the staple or hole punch finisher
functions of this machine.

1
2

From the “File” menu, select “Print”.
Select “Finishing”.

Specify settings for the following:

Collate: Prints multiple copies in sets.

Offset: Specifies offset.

Duplex: Performs duplex printing.

Output Tray: Selects the output tray.

Binding Position: Specifies the binding position.
Combination: Specifies booklet printing.
Staple: Performs stapling.

Punch: Performs hole punching.

Fold: Performs folding.

Privoer | wOMCALINOLTA 351 +
Prviati! | Simndard TI
Fafed marig =H
d.!'.-:ﬂll.‘.r
_! Off et
Duplex
Bindiesg Position Left Binding P |
Lo ipn _|_'|I'I =|
Frivatw Sarvee A4 FOF _ Fun Cancel &—‘
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Quality

1 From the “File” menu, select “Print”.
2  Select “Quality”.

3 Specify settings for the following:

Resolution: Specifies the resolution.

Glossy Mode: Prints using a gloss finish.

Original Image Type: Prints with a quality suitable for the original doc-
ument.

Color Matching (Text): Adjusts the color quality of the text in a docu-
ment.

Pure Black (Text): Specifies whether to enable grayscale of the text in
a document.

Screen (Text): Specifies screening of the text in a document.

Color Matching (Photo): Adjusts the color quality of photos in a docu-
ment.

Pure Black (Photo): Specifies whether to enable grayscale of photos in
a document.

Screen (Photo): Specifies screening of photos in a document.
Smoothing (Photo): Specifies smoothing of photos in a document.
Color Setting (Graphic): Adjusts the color quality of a chart and graph
in a document to the text or photo settings.

C351
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Smoothing (Graphic): Adjusts the smoothing process of a chart and
graph in a document to the text or photo settings.

Primoer: | RONCAMINOLTA C351 =
|m ﬂ
Wbl [EET i
bt ke Lrint .
_iClouny Mods
Onginal Image Type R L]
Calor Matching (Tesir Autn ]
Purw Blick (Teati Aart I3
Sorwan (Testi it i
Cbor Manhing Phecs) At [
Pere Wlsck (Photsn huro )
SO (PR Autg — )
Color Satiing iGraphicl. | Auts i
Lewathing iCraghich Autn 3
(7)) (Preview ) (Savemarof | [ fan | | Cancel | {EiRrn
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Setup

You can specify the cover settings.

1
2

From the “File” menu, select “Print”.
Select “Setup”.

Specify settings for the following:

Paper Type: Selects the paper type.

Front Cover Page: Attaches a front cover page.

Paper Tray (Front Cover Page): Selects the input tray for the front cov-
er.

Back Cover Page: Attaches a back cover page.

Paper Tray (Back Cover Page): Selects the input tray for the back cov-
er.

Transparency Interleave: Inserts interleaves between overhead projec-
tor transparencies.

Paper Tray (Transparency Interleave): Selects the input tray for the
transparency interleaves.

-

Prisper: | OONCAMBRDLTA C359

e

Prickiti’ | Sipesdisig

Lt 5
Pigit Tippeit Plam Fapes _I|
Front Coger Page Primt gt .:1_
Fazer Tray (Froee Cower Pageh. | OHT i
Lath Cowrr Page Priragid v
Fapstr Tray (hack Coreer Pape) CHY 'ii
Freveew | | Save da FOF Fan Canel | firint=)
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9.4  Setting Options

You can specify the options installed on this machine so that they can be
used from the printer driver.

...

Reminder

If the installed options on this machine are not set from the Installable Op-
tions screen, the option function cannot be used with the printer driver.
When installing options, be sure to make the proper settings.

Specifying Settings

1

2

5

Open Print Center or Printer Setup Utility, located in “Applications” —
“Utilities” of “Hard Disk” and specify the printer model.

From the “Printer” menu, select “Show Info”.

The “Printer Info” dialog box appears.
Select “Installable Options”.

Select the option that is installed on this machine.

%) Pkl efa

EONCAMBNOLTA C351

il fahin i mms &

Faper Tairres -0 T‘

Fisishebi | F5=603 _!!
Pusch Uair. | 2 Helei Typs :l‘l
= Prireas OO

Appily § hanges

Click the [Apply Changes] button or click [ @ ] to close the Printer info
dialog box.
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9.5 Saving the Driver Settings
For Mac OS X drivers, you can save the setting values of the changed driver
and recall them as necessary.
Saving the Driver Settings
1 Change the driver settings in “Copies & Pages” and “Layout”.
2 From “Presets”, click “Save as”.
P EOSECA MINTH.TA T3M 'Tl
Presets | o Standard “e
Lopei & Fepen
T
L op=r
Fage
“fom: | L -H |
-'l- "Pewviem ) (Save maFOF_ ) 'E*wl'-@
3 Enter the “Save Preset As”.
Sarvl Powert
Sarew Preast Al
Luandyre 1
Cancel | 0N
4 Click the “OK” button.
The setting are registered in the preset settings.
Restore the settings
=  Select “Presets” from the “Print” dialog box to recall the settings.
The settings are recalled, and the printer driver dialog box appears
again.
C351 9-16
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Changing the settings

1 Select “Presets” from the “Print” dialog box to change the settings.
2 Change the driver settings in “Copies & Pages” and “Layout”.

3 From “Presets”, click “Save”.

To delete, click “Delete”. To change the name, click “Rename”.
The preset settings are changed.

C351
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[
10 Various Settings

10.1 Print Settings in Utility Mode

You can change the various print settings on the control panel of this ma-
chine.

Default Settings
To display the Utility Setting screen

Press the [Utility/Counter] key.

Utility/

Counter

(=)
O

Touch [2 User Setting].

User Setting

C351

Download from Www.Somanuals.com. All Manuals Search And Download. 10-1



Various Settings 1 0

The User Setting screen appears.

User Setting

N

Note
In Utility mode, an item can also be selected by pressing the key in the

keypad for the number beside the desired button. For “2 User Setting”,
press the [2] key in the keypad.

To quit specifying the Utility mode setting, touch [Exit] in the sub display
area or press the [Utility/Counter] key. Otherwise, cancel the Utility mode
by touching [Close] in each screen until the screen for the Copy, Fax,
Scan or Box mode appears.

PDL Setting

You can specify the PDL (Printer Description Language) setting. (Default set-
ting: Auto)

On the Utility Setting screen, touch [6 Printer Setting].

— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [1 Basic Setting].

Touch [PDL Setting].

Basic Setting
Select it

C351
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Touch the button for the desired setting.

— Auto: Automatically switches between PCL and PS.
— PCL: Only uses PCL.
— PS: Only uses PS.

Basic Setting
Select item and adjust setting

Spool Print Jobs 3
n _HDD before RIP 3

a4 /A3 «+LTR/LGR
AULO Switch

Number of Sets

You can specify the default number of copies when no setting has been
specified from the printer driver. (Default setting: 1 set)

On the Utility Setting screen, touch [6 Printer Setting].

— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [1 Basic Setting].

Touch [Number of Sets].

Basic Setting
Select it
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Press the [C] (clear) key to erase the value, and then use the keypad to
type in the default number of copies (between 1 and 999 sets).

— If a value outside of the allowable range is specified, the message
“Input Error” appears. Type in a value within the allowable range.

Humber of Sets to Print
Enter number of sets to print when it is not specified by print driver.

Touch [OK].

The default number of copies is set.
To cancel changes to the settings, touch [Cancel].

Original Direction

You can specify the default image orientation. (Default setting: Portrait)

On the Utility Setting screen, touch [6 Printer Setting].

— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [1 Basic Setting].

Touch [Original Direction].

Basic Seth

Portrait

10-4
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Touch the button for the desired setting.

— Portrait: The image is printed vertically on the page.
Landscape: The image is printed horizontally on the page.

Basic Setting
Select item and adjust setting

Spool Setting

You can set whether or not a spool is used. (Default setting: ON)

On the Utility Setting screen, touch [6 Printer Setting].

— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [1 Basic Setting].

Touch [Spool Print Jobs in HDD before RIP].

Basic Setting

Portrait

Touch the button for the desired setting.

— ON: When the next job is received while processing a job, the print
data is stored in the HDD.
OFF: The print data is not stored in the HDD.

C351 10-5
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N

Note
Be sure not to change the setting to “OFF”. Printing may not be possible.

Basic Setting
Select item and adjust setting.

PDL Setting

Spool Print Jobs
An HDD before BLP

Paper Size Change

You can specify whether similar paper sizes 8-1/2 x 11 and A4, and 11 x 17
and A3 are substituted for each other when there is no paper of the size
specified with the printer driver. (Default setting: OFF)

v/ The image may be defected since printing is forced.

On the Utility Setting screen, touch [6 Printer Setting].

— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [1 Basic Setting].
Touch [A4/A3 « — LTR/LGR Auto Switch)].

Basic Setting
Select item and adjust setting.

PDL Setting

Spool Print Jobs
in HDD before HLIP

10-6
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Touch the button for the desired setting.

Basic Setting
Select item and adjust setting

PDL Setting

Humber of Sets 3

Portrait

Paper Tray

You can specify the input tray to use when none has been specified with the
printer driver. (Default setting: Auto)

On the Utility Setting screen, touch [6 Printer Setting].

— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [2 Paper Setting].

Touch [Paper Tray].

Paper Setting
Select item and adjust setting

Paper Tray

efault Paper Size,

2-Sided Print

Bind Direction

10-7
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Touch the button for the desired paper drawer.

— To select the input tray automatically, touch [Auto].

Default Paper Tray

gelect paper tray to be ed when it not specified from

hE& print driver

Touch [OK].

— To cancel changes to the settings, touch [Cancell.

C351 10-8
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Default Paper Size
You can specify the paper size to use when no setting has been specified
from the printer driver. (Default setting: 8-1/2 x 11)
On the Utility Setting screen, touch [6 Printer Setting].
— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [2 Paper Setting].

Touch [Default Paper Size].

Paper Setting
Select item and adjust setting

Paper Tray

Left Bind

Touch the button for the desired setting.

— Toselect “8K”, “16K”, “envB5”, “envC5”, “envDL”, “envCom10”, or
“env Monarch”, touch [Other Sizes].

Paper Size
Select paper size to be used when it is not specified from
The 1 inG dr -

Touch [OK].

— To cancel changes to the settings, touch [Cancell.

10-9
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2-Sided Print
You can specify the default duplex printing setting. (Default setting: OFF)

On the Utility Setting screen, touch [6 Printer Setting].

— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [2 Paper Setting].

Touch [2-Sided Print].

Paper Setting
Select item and adjust setting.

efault Paper Sizej

Touch the button for the desired setting.

Paper Setting
Select item and adjust setting.

Bind Direction Left Bind

C351 10-10
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Bind Direction

You can specify the default binding position for duplex printing. (Default set-
ting: Left Bind)

On the Utility Setting screen, touch [6 Printer Setting].

— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [2 Paper Setting].

Touch [Bind Direction].

Paper Setting
Select item and adjust setting

Paper Tray

Touch the button for the desired setting.

Paper Setting
Select item and adjust setting

Paper Tray

10-11
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Staple

You can specify the staple settings. (Default setting: OFF)

On the Utility Setting screen, touch [6 Printer Setting].

— For details on displaying the Utility Setting screen, refer to “To dis-

play the Utility Setting screen” on page 10-1.

Touch [2 Paper Setting].

Touch [Staple].

Paper Setting
Select item and adjust setting

Paper Tray

efault Paper Size,

Left Bind

Touch the button for the desired setting.

Paper Setting
Select item and adjust setting

Paper Tray

C351
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Hole-Punch

You can specify the hole punching settings. (Default setting: OFF)

On the Utility Setting screen, touch [6 Printer Setting].

— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [2 Paper Setting].

Touch [ [¢] ] or [ [+ ], and then touch [Hole-Punch].

Paper Setting
Select item and adjust setting

Touch the button for the desired setting.

Paper Setting
Select it
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Typeface

You can specify the font to use when no setting has been specified from the
printer driver. (Default setting: Courier)

On the Utility Setting screen, touch [6 Printer Setting].

— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [3 PCL Setting].

Touch [1 Typeface].

Touch the button for the desired setting.

— Touch[ @ ]or[ |+] ] and then touch the button for the desired setting.
— You can check the selected font number and font size units.

Typeface
Select default foi

Touch [OK].

— To cancel changes to the settings, touch [Cancell.
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Symbol Set

You can specify the font symbol set to use when no setting has been spec-
ified from the printer driver. (Default setting: PC-8, Code Page 437)

On the Utility Setting screen, touch [6 Printer Setting].

— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [3 PCL Setting].

Touch [2 Symbol Set].

PCL Setting

Typeface

Touch the button for the desired setting.
— Touch [[+]] or [+ ], and then touch the button for the desired set-
ting.

Symbol Set
Select default symbol set.

Touch [OK].

— To cancel changes to the settings, touch [Cancell.
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Font Size

You can specify the font size to use when no setting has been specified from
the printer driver. (Default settings: Scalable Font — 12.00 point; Bitmap Font
—-10.00 pitch)

On the Utility Setting screen, touch [6 Printer Setting].

— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [3 PCL Setting].

Touch [3 Font Size].

PCL Sektting

Press the [C] (clear) key to erase the value, and then use the keypad to
type in the default font size (Scalable Font: between 4.00 and 999.75
points; Bitmap Font: between 0.44 and 99.00 pitches).

— Scalable Font: Specifies the font size in points.
Bitmap font: Specifies the width of the fixed-width font in pitches.
— If a value outside of the allowable range is specified, the message
“Input Error” appears. Type in a value within the allowable range.

Font Size
Use the kevpad to set the default font size.

12. 00point

Touch [OK].

The font size is set.
To cancel changes to the settings, touch [Cancel].

C351
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Line/Page

You can specify the number of lines per page when test printing. (Default set-
ting: 64 lines)

On the Utility Setting screen, touch [6 Printer Setting].

— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [3 PCL Setting].

Touch [4 Line/Page].

PCL Setting

Typeface

Press the [C] (clear) key to erase the value, and then use the keypad to
type in the default number of lines (between 5 and 128 lines).

— If a value outside of the allowable range is specified, the message
“Input Error” appears. Type in a value within the allowable range.

Line/Page
Set number of lines to print in 1 page.

Touch [OK].

The number of lines/page is set.
To cancel changes to the settings, touch [Cancel].
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CR/LF Mapping

You can specify the data substitution method when printing text data. (De-
fault setting: OFF)

Mode 1: Substitutes CR for CR-LF.
Mode 2: Substitutes LF for CR-LF.
Mode 3: Substitutes to CR-LF.
OFF: Does not perform substitution.
On the Utility Setting screen, touch [6 Printer Setting].
— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.
Touch [3 PCL Setting].

Touch [5 CR/LF Mapping].
— Touch the button for the desired setting.

PCL Sektting

Touch the button for the desired setting.

CR/LF Mapping
Set CR/LF mode for text data printing.

Touch [OK].

— To cancel changes to the settings, touch [Cancel].

C351
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PS Error Print
You can specify whether to print the error message when an error occurs
during PS rasterization. (Default setting: OFF)
On the Utility Setting screen, touch [6 Printer Setting].
— For details on displaying the Utility Setting screen, refer to “To dis-
play the Utility Setting screen” on page 10-1.

Touch [4 PS Setting].

Touch [PS Error Print].

PS Setting
Select item and adjust setting

PS Error Prinkt

Touch the button for the desired setting.

PS Setting
Select item and adjust setting
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Print Reports

You can output the following four types of reports. This report output method
is explained in the PCL font list.

On the Utility Setting screen, touch [6 Printer Setting].
Touch [5 Print Reports].

Touch the button for the desired setting.

Print Lists

— Configuration Page: Outputs a list of this machine’s settings.
Demo Page: Outputs a test page.
PCL Font List: Outputs the PCL font list.
PS Font List: Outputs the PS font list.

Touch the button for the desired paper drawer.

Configuration Page

To output a report, press the [Start] key.

C351
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10.2 Printer Settings in Administrator Mode
To display the Administrator Setting screen

Press the [Utility/Counter] key.

Utility/

Counter

—
O

Touch [3 Administrator Setting].

UtiLity

Enter the password, and then touch [OK].

Adninistrator Password
Enter the Adminisbtrator Password.

Admin.
Password

C351

Download from Www.Somanuals.com. All Manuals Search And Download. 10-21



Various Settings 1 0

The Administrator Setting screen appears.

Administrator
sSerting

Q

Detail

In Utility mode, an item can also be selected by pressing the key in the
keypad for the number beside the desired button. For “3 Administrator
Setting”, press the [3] key in the keypad.

For details on setting or changing the passwora, refer to the User’s Guide
[Copy Operations].

Q

Detail

To quit specifying the Utility mode setting, touch [Exit] in the sub display
area or press the [Utility/Counter] key. Otherwise, cancel the Utility mode
by touching [Close] in each screen until the screen for the Copy, Fax,
Scan or Box mode appears.

Print/Fax Output Settings

You can specify whether to print data after it is received or to print it simul-
taneously as it is being received.

You can specify this function for printing and for faxing. (Default settings:
Printer — Page Print; Fax — Batch Print)

On the Administrator Setting screen, touch [1 System Setting].

— For details on displaying the Administrator Setting screen, refer to
“To display the Administrator Setting screen” on page 10-21.

On the System Setting screen, touch [2 Output Setting].

On the Output Setting screen, touch [1 Print/Fax Output Settings].

C351
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The Print/Fax Output Settings screen appears.

PFinG Fax
Output Settings

‘Select item and enter setting

. Batch Print

Touch [Printer] or [Fax].

The buttons for the available settings appear.

PrintsFax_
ouGPUt Settings
Select item and enter settin

Batch Print

Touch the button for the desired setting.

The print timing setting is set.

Q

Detail

Ifthe “Administrator Security Level” parameter is set “Level 27, users can
also specify this setting. Touch [User Setting], [System Setting], [Outpout
Setting], then [Print/Fax Output Settings] to display the Print/Fax Output

Settings screen.

For details on the user access levels, refer to the User’s Guide [Copy Op-

erations].

...

Note

If “Batch Print” is selected, printing starts when all the data is received
and the print job is queued. If “Page Print” /s selected, printing starts
when the data for the first page is received and the print job is queued.

C351

Download from Www.Somanuals.com. All Manuals Search And Download.

10-23



Various Settings 1 0

Local I/F Timeout
You can set the time until a communication timeout occurs for the parallel,
USB, or network interface. (Default setting: 60 seconds)
On the Administrator Setting screen, touch [7 Printer Setting].
— For details on displaying the Administrator Setting screen, refer to
“To display the Administrator Setting screen” on page 10-21.
On the Printer Setting screen, touch [1 Local I/F Timeout].

The Local I/F Timeout screen appears.

Local I/F Timeout
Touch [Edit] and enter timeout time using the keypad.

Touch [Edit] below the setting that you are specifying.

Press the [C] (clear) key to erase the value, and then use the keypad to

type in the default length of time (between 10 and 300 seconds).

— If a value outside of the allowable range is specified, the message
“Input Error” appears. Type in a value within the allowable range.

Touch [OK].

The time until a communication timeout occurs is set.
To cancel changes to the settings, touch [Cancell.

C351 10-24
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Parallel I/F

You can specify the mode for using a parallel interface. (Default setting: ECP)

On the Administrator Setting screen, touch [7 Printer Setting].

— For details on displaying the Administrator Setting screen, refer to
“To display the Administrator Setting screen” on page 10-21.

On the Printer Setting screen, touch [2 Parallel I/F].

The Parallel I/F screen appears.

Parallel I/F
Select a parallel interface mode.

Touch the button for the desired setting.

Touch [OK].

The parallel interface mode is set.
To cancel changes to the settings, touch [Cancell.

C351 10-25
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Parallel/USB

You can specify whether to use the parallel port or the USB port. (Default set-
ting: USB)

On the Administrator Setting screen, touch [7 Printer Setting].
On the Printer Setting screen, touch [3 IEEE 1284/USB].

Touch the desired port.

IEEE 12B4/USB

V...

Note
The parallel and USB ports cannot be used simultaneously.

Capture Print Data

You can specify whether to allow or prohibit data capturing of a print job.
(Default setting: Allow)

On the Administrator Setting screen, touch [0 Security Setting].

— For details on displaying the Administrator Setting screen, refer to
“To display the Administrator Setting screen” on page 10-21.

On the Security Setting screen, touch [4 Security Details].

On the Security Details screen, touch [Print Data Capture].

10-26
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The buttons for the available settings appear.

Security Details
Select item and enter sekbting.

Password Rules

Manual Destinatio
InpLUt

Print Data Captur

Touch the button for the desired setting.

The capturing a print job is either allowed or prohibited.

V...

Note

For details on capturing a print job, consult a service technician.

C351
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10.3 Using PageScope Web Connection

PageScope Web Connection is a management utility supported by the HTTP
server built into the printer controller.

Start up a Web browser on a computer on the network and access Page-
Scope Web Connection to easily change this machine’s settings.

System Requirements

Item

System Requirements

Network

EthernetTCP/IP

Computer application

Web Browser:

Microsoft Internet Explorer 6 or later recommended (JavaScript ena-
bled, Cookies enabled)

Microsoft XML Parser MSXML3.X must be installed when using Inter-
net Explorer 5.X.

Netscape Navigator 7.02 or later (JavaScript enabled, Cookies ena-
bled)

J2RE (Java 2 Runtime Environment) required

Accessing PageScope Web Connection

PageScope Web Connection can be accessed directly from a Web browser.

Start up the Web browser.

In the Address bar, enter the IP address for this machine, and then
press the [Enter] key.

http://<IP_address_for_this_machine>/
Example: If the IP address for this machine is 192.168.1.20
http://192.168.1.20/

Q

Detail

Below is the URL after SSL/TLS is enabled.
https://<IP_address._for_this_machine>

For the procedure fo set the IP address of this machine, refer to “Setting
the IP Address for This Machine” on page 3-5.

C351
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Page

Structure

The page that appears immediately after PageScope Web Connection is ac-
cessed is called the User mode page. All users can view this page.

N

Note
By clicking [Admin modej, you can display the Administrator mode page.
For details, refer to “Logging In to Administrator Mode” on page 10-317.

The configuration of the PageScope Web Connection page is shown below.
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No. | Item Description
1 KONICA MINOLTA Logo Click the logo to jump to the following Web site (KONICA
MINOLTA Web site). http://konicaminolta.com
2 PageScope Web Click the PageScope Web Connection logo to display the
Connection Logo version information.
3 Administrator mode logon | Click to log on to Administrator mode.
button
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No.

Item

Description

Display Language

Select the display language from the drop-down list.

Status Display

Displays the status of this machine’s printer and scanner
sections using icons.

Message Display

Displays the status of the problem/error and other error
information if an error has occurred in this machine.

Help

Click to display the page specified as online Help.

Tab

Displays the categories that can be controlled by
PageScope Web Connection. The following tabs are
displayed in User mode.

e System

* Job

* Box

e Print

* Scan

Menus

Lists the information and settings for the selected tab. The
menus that appear vary depending on the tab that is
selected.

10

Information and Settings
Display

Displays the details of the item selected from the menu.

C351
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Logging In to Administrator Mode

You can switch between User mode and Administrator mode. However, you
must enter Administrator mode to specify system configurations or network
configurations.

1  Click the [Admin Mode] button.

2 Enterthe administrator password for this machine in the “Administrator
Password” box, and then click the [Login] button.
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The Administrator mode page appears.
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To return to User mode, click the [Logout] button.

N

Reminder

When logged on to Administrator mode, the control panel of this machine
/s locked and cannot be used.

Depending on the status of this machine, you may not be able to log on
to Administrator mode.

When logged on to Administrator mode, if no operation is performed for
a set length of time, a timeout occurs and you will automatically be
logged off from Administrator mode. To set the timeout time, refer to
“Network Tab — Authentication” on page 10-72.

C351
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Cache Function of Web Browsers

The newest information may not appear on the PageScope Web Connection
page due to the cache function of the Web browser. In addition, problems
can occur when the cache function is used.

When using PageScope Web Connection, disable the cache function of the
Web browser.

Q

Detail
The menus and commands may vary depending on the Web browser. For
aetaills, refer to Help for the Web browser.

Ifthe cache function is enabled on the Web browser and a timeout occurs
in Administrator mode, the timeout page may appear even when Page-
Scope Web Connection is accessed again. When this happens, the ma-
chine’s control panel remains locked, and the main power of this machine
must be turned off, then on again. To avoid such problems, disable the
cache function.

When turning the main power switch OFF then ON, wait for 10 seconds
or longer before turning it ON again, otherwise the copier may not func-
tion normally.

On Internet Explorer

On the “Tools” menu, click “Internet Options™.

On the General tab, click the [Settings] button under “Temporary Inter-
net files”.

Select “Every visit to the page”, and then click the [OK] button.
On Netscape

On the “Edit” menu, click “Preferences”.

In the “Category” box, click “Advanced”, then “Cache”.

Under “Compare the page in the cache to the page on the network?”,
select “Every time | view the page”.

User Mode

The User mode provides functions for checking and operating the machine
on a user level. You can select from five tabs (System, Job, Box, Print, or
Scan).

C351
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N

Note

This manual describes the printer related functions. For the box and
scanner functions of this machine, refer to the User’s Guide [Box Opera-
tions] and User’s Guide [Network Scanner Operations].

System Tab

On the System tab, information and settings concerning the system config-
uration of this machine are displayed.

System Tab — Summary

On the System tab, click “Summary”. In addition, this is the initial page that
appears when you access http://<IP_address_for_this_machine>/ with your
Web browser.

The Summary page shows the current system configuration and status of
this machine.
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Item Description

Device Status This area uses graphics and text to show the configuration of options
installed on this machine.

System Tab — Device Information
Click the System and then click “Device Information” in the menu.

The system configuration of this machine appears.
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Item Description
Panel Language Displays the language that the control panel screens are
displayed in.
Administrator Name Displays the administrator name.

C351 10-35

Download from Www.Somanuals.com. All Manuals Search And Download.



Various Settings

10

System Tab — Detail — Input Tray

Click the System click “Detail”, and then click “Input Tray” in the sub-menu
that appeared.

You can check the status of the paper drawers of this machine.
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Item Description
Tray Displays information for each item.
Paper Size
Media Type
Paper
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System Tab — Detail — Output Tray

Click the System click “Detail”, and then click “Output Tray” in the sub-menu
that appeared.

You can check the status of the output trays of this machine.
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Item Description
Output Tray Displays the tray name and status of each installed tray.
Option Displays whether an option is installed.
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System Tab — Detail — HDD

Click the System click “Detail”, and then click “HDD” in the sub-menu that
appeared.

You can check the status of the hard disk of this machine.
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Item Description
Name Displays the hard disk name.
Total Displays the total size of the installed hard disk.
Used Displays the amount of space used by the system.
Remain Displays the amount of free hard disk space.
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System Tab — Detail — Interface Information

Click the System click “Detail”, and then click “Interface Information” in the
sub-menu that appeared.

You can check the interface information of this machine.
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Item Description

Protocol Information

Displays the usability status of each protocol.

Network Information

Displays the network information.
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System Tab — Detail — Consumables

Click the System click “Detail”, and then click “Consumables” in the sub-

menu that appeared.

You can check the consumable information of this machine.
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Item Description

Toner (Yellow, Magenta,
Cyan, Black)

Imaging Unit (Yellow,
Magenta, Cyan, Black)

Waste Toner Bottle

Paper Dust Remover/Ozone

Filter

Punch Dust

Staple

Fusing Unit

Transfer Belt Unit

Transfer Roller Unit

Displays information for each item.
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N

Note
The status may not be displayed correctly if the consumables are not in-
stalled.

C351 10-41

Download from Www.Somanuals.com. All Manuals Search And Download.



Various Settings 1 0

System Tab — Counter

Click the System and then click “Counter” in the menu.

You can check the counters that this machine manages.

& R——y Tt Ui
Pl bl Tl
=l Cowgeinm Trna
i |
B PP - T T gl
I opr b —
My
Full Usdes Mk Ciakis BiCele  Teid
Ly 5an
T | oy
Fall Tadar 1Bk 15 U Tl
Tota
S Tan

o Ly
T
g Cam

0 ———

TR ]

s B § e

Tl Harh T e

Toa
[ =+ Fy rre :
Item Description
Total Counter Displays the total of the output counter (copies, prints, scans, and

faxes).

Copy Counter Displays each counter.
Print Counter
Scan/Fax Counter
Color Total Counter Displays the color mode counter.
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System Tab — Online Assistance

Click the System and then click “Online Assistance” in the menu.

You can check support information concerning the product.
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Item Description

Contact Name Displays information for each item.

Contact Information

Product Help URL

Corporate URL

Supplies and Accessories

Online Manual URL
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Job Tab

From the “Job” tab, you can check jobs managed by this machine.

Job Tab — Active Job

Click the Job tab, click “Active Job List” from the menu, and then select each
function (print and scanning operations).

You can check jobs that are being printed or that are queued to be printed.

Sample Print Page
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Item Description
Print Displays the print job list and details.
Scan Transmission Displays the scan job list and details.
Fax Transmission Displays the fax transmission job list and details.
Fax Receive Displays the fax reception job list and details.
HDD/Memory Displays the box job list and details.

Note

The job number that was assigned when the job was queued in this ma-
chine appears as the job number.
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Job Tab — Done Job List

Click the Job click “Done Job List” from the menu, and then select each
function (print and scanning operations).

You can check completed jobs.

Sample Print Page
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Item Description
Print Displays the print job list and details.
Scan Transmission Displays the scan job list and details.
Fax Transmission Displays the fax transmission job list and details.
Fax Receive Displays the fax reception job list and details.
HDD/Memory Displays the box job list and details.
Note

The job number that was assigned when the job was queued in this ma-
chine appears as the job number.

Click the [Detail] button to display detailed information.
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Print Tab

You can check the printer default settings and print various reports.

Print Tab — General Settings

Click the Print tab, click “General Settings” from the menu, and then select

each setting classification (general and PCL).

If a print job is sent whose settings are not specified, the settings specified

here are used for printing.

Sample General Settings Page
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Item Description

General Settings Displays information for each item.

PCL Settings

PS Settings
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Print Tab — Report Types
Click the Print and then click “Report Types” in the menu.

You can print various configuration information, the demo pages, and the
PCL font information. Select the report that you want to print, and then click
the [Print] button.
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Note
When this machine is processing a job, you may not be able to output re-
ports.
Item Description
PostScript Font List Prints the font list that is used by PostScript.
PCL Font List Prints the font list that is used by PCL.
Demo Page Prints a demo page.
Configuration Page Prints the various configuration information pages of this machine.
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Administrator Mode

In Administrator mode, you can specify system settings for this machine.
You can select from five tabs (System, Box, Print, Scan, or Network).

For details on logging on to Administrator mode, refer to “Logging In to Ad-
ministrator Mode” on page 10-31.

...

Note

This manual describes the printer related functions. For the box, scanner,
and network functions of this machine, refer to the User’s Guide [Box Op-
erations] and User’s Guide [Network Scanner Operations].

Basic Operation
1 Click a tab, and then select a item from the menu.

2 Specify settings for the displayed items. Either enter a setting directly
or select one from the drop-down list.

3 Click the [Apply] button to apply the settings.

System Tab

On the System tab, information and settings concerning the system config-
uration of this machine are displayed.
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System Tab — Date/Time — Manual Setting

Enter the time and date for this machine.
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Item Description
Year Enter the year.
Month Enter the month.
Day Enter the day.
Hour Enter the time.
Minute Enter the minutes.
Time Zone Specify the time difference from GMT.

Daylight Saving Time

Specify whether the time is in daylight savings time.
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System Tab — Date/Time — NTP Setting

The time and date of this machine can be set through passive acquisition
from the NTP server.
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Item Description
NTP Specify whether to enable automatic time acquisition by NTP.
NTP Server Address Enter the NTP server address (up to 225 characters, format:

swnrx we enx 2057 o EQDN).

NTP Server Port Enter the NTP server port (input range: 1-65535).

Click the [Adjust] button to connect at the specified conditions to the NTP
server and to set the time.
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System Tab — Administrator Password

You can change the administrator password.
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Item Description

Current Password Enter the current password.

New Password Enter the new password.

Retype New Password Reenter the new password.
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System Tab — Device Information

You can change the device information.
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Item Description
Device Name Specify the device name (up to 255 characters).
Device Location Specify the device location (up to 255 characters).
Administrator Name Specify the administrator name (up to 16 characters).
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System Tab — Online Assistance

You can changed the online support information. To display this information
click the System tab in the User mode, and then click “Online Assistance”.
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Item Description
Contact Name Specify information for each item.

Contact Information

Product Help URL

Corporate URL

Supplies and Accessories

Online Manual URL Enter the following URL.

c351/help.html

http://pagescope.com/download/webconnection/onlinehelp/
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System Tab — Import/Export

You can save (export) the information of this machine as a file or write (im-
port) the information from a file to this machine.
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Item Description
Import To import a file specify the name of the file that you want to import, and
then click the [Import] button.
Export To download a file, click the [Export] button.
Note

Only encoded binary format files can be imported using Import/Export.

C351

Download from Www.Somanuals.com. All Manuals Search And Download. 10-54



Various Settings

10

System Tab — Maintenance — Network Setting Clear

You can restore the network configuration of this machine to when it was
shipped from the factory.

To execute, click the [Clear] button.
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Note

If the settings are cleared after completing setup, you will not be able to
connect until the settings are reset.
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System Tab — Maintenance — Reset
Resets the printer controller.

To execute, click the [Reset] button.
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System Tab — E-mail Alert

When an error occurs in this machine, an e-mail is sent to the registrant.
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Item Description

Notification Address

Enter the notification destination e-mail address (up to 320
characters).

Notification Time

Specify the time until the e-mail is sent.

Tray paper Replenish Notifies when there is no paper.

JAM Notifies when a paper jam occurs.

PM Call Notifies when there is a scheduled inspection.
Add Staple Notifies when there are no staples.

Toner Supply Notifies when there is no toner.

Finisher Tray Full

Notifies that the finisher tray is full.

Service Call

Notifies when there is a service call.

Job End

Notifies that a job is complete.

Remove Punch Box
Full

Notifies that the hole punch waste must be emptied.
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Print Tab

On the Print tab, information and settings concerning the connecting inter-
face and default print settings are displayed.

Print Tab — Interface

You can change the interface timeout settings.
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Item Description
Parallel Timeout Enter the reception timeout for the parallel port (input range: 10—
1000).
Network Timeout Enter the reception timeout for the network (input range: 10—1000).
USB Timeout Enter the USB timeout (input range: 10-1000).
Parallel Setting Select the parallel port transmission method.
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Print Tab — Default Settings — General Settings

You can specify the default setting values of the printer.
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Item Description
PDL Setting Select the printer descriptive language.
Paper Tray Select the input tray.
Output Tray Select the output tray.

Double-Sided Print

Select whether to perform duplex printing.

Bind Direction

Select the position of the binding margin.

Staple Select the staple function.
Hole-Punch Select the hole punching function.
# of Sets Select the number of copies to print.

Default Paper Size

Select the paper size.

Original Direction

Select the print orientation.

Spool setting Select the spool function.
Preferred Tray Choice Selects the operation when the specified input tray has no paper.
Paper Size Change Select whether to print 8-1/2 x 11 (A4)/11 x 17 (A3) documents when

the A4 (8-1/2 x 11)/A3 (11 x 17) paper source is selected.
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Print Tab — Default Settings — PCL Settings

You can specify the default setting values of the PCL mode.
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Item Description
Font Name Select the font.
Symbol Set Select the symbol set.
Line/Page Enter the number of lines per page (input range: 5—128).
Font Pitch Enter the font pitch (input range: 0.44—99.0).

CR/LF Mapping

Select the CR/LF operation.
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Print Tab — Default Settings — PS Settings

You can specify the default setting values of the PS mode.
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Item Description
PS Error Print Specify whether to enable the printing of errors.

Scan Tab

On the Scan tab, the settings at transmission and the information and set-
tings concerning the address book limitations are displayed.

Q

Detail

If the user is prohibited from registering recipients in the address book,
the functions for registering recipients in the address menu will not ap-
pear in the menu.

For details on scanner registration, refer to the User’s Guide [Network
Scanner Operations].
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Network Tab

On the Network tab, information and settings concerning the network con-
nection are displayed.

Network Tab — TCP/IP — TCP/IP
You can specify the TCP/IP settings.
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Item Description
TCP/IP Specify whether to enable TCP/IP.
Speed Select the operation speed.
Auto IP Select when using a DHCP server.
IP Address Specify the IP address of this machine (format: . = =,
input range for ***: 0—255).
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Item

Description

Subnet Mask

Specify the subnet mask connecting to a network (format:
(ko ok 22 Cinput range for ***: 0—255).

Default Gateway

Specify the default gateway address connecting to a network
(format: “*.*** ** **” ‘input range for ***: 0—255).

RAW Port Number 1

RAW Port Number 2

RAW Port Number 3

RAW Port Number 4

RAW Port Number 5

RAW Port Number 6

Specify the RAW port number (input range: 1—65535).

Host Name

Specify the host name (up to 63 characters).

Domain Name

Specify the domain name (up to 255 characters).

DNS Server Register a maximum of three DNS servers (format: “** = = x>,
input range for ***: 0—255).
SLP Specify whether to enable SLP.
LPD Specify whether to enable LPD.
Note

To apply any changes to settings for the Network tab, restart this ma-
chine (turn the main power off, then on again).

When turning the main power switch OFF then ON, wait for 10 seconds
or longer before turning it ON again, otherwise the copier may not func-

tion normally.
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Network Tab — TCP/IP — IP Address Filtering
You can specify the IP address filter function.

You can specify the access limitations by specifying the IP address of the

host.
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Item Description
Access Permission Address Specify whether to enable authorization of an IP address
setting.
Setting Range 1—5 Enter the IP address being authorized (format: «** ** ** =
input range for ***: 0—255).
Access Refusal Address Specify whether to enable rejection of an IP address setting.
Setting Range 1—5 Enter the IP address being rejected (format: “*** ** *** *=»

input range for ***: 0—255).
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Network Tab — NetWare — NetWare

You can specify the NetWare settings.
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Item Description

NetWare Print

Specify whether to enable NetWare.

Frame Type

Select the frame type.

Mode

Select “Pserver” or “Nprinter/Rprinter” as the operation mode
of the print server.

Print Server Name

Enter the print server name (up to 63 characters, excluding /\ :
1> +=7).

Print Server Password

Specify the print server password (up to 63 characters).

Print Queue Scan Rate

Enter the print queue scan rate (input range: 1—65535
seconds).

Bindery/NDS

Select Bindery/NDS.

Preferred File Server

Enter the preferred file server name of bindery (up to 63
characters).

C351

Download from Www.Somanuals.com. All Manuals Search And Download.

10-65



Various Settings

10

Item

Description

Preferred NDS Context
Name

Enter the preferred NDS context name (up to 191 characters).

Preferred NDS Tree Name

Enter the preferred NDS tree name (up to 63 characters).

Printer Name

Enter the NPrinter/RPrinter printer name (up to 63 characters).

Printer Number

Enter the NPrinter/RPrinter printer number (input range: 0—
255).

...

Reminder

To apply any changes to settings for “NetWare Printing”, “Frame Type”,
“Print Queue Scan Rate”, “Mode”, or “Printer Number”, restart this ma-
chine (turn the main power off, then on again).

When turning the main power switch OFF then ON, wait for 10 seconds
or longer before turning it ON again,; otherwise the copier may not func-

tion normally.
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Network Tab — NetWare — NetWare Status

“NetWare Server” and “Queue Name” appear as the NetWare connection

status.
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Network Tab — IPP

You can specify the IPP print settings.

-
ﬂ P —

g ETECTE T T
- ]
ER1F 2] IFF
B e TP Tomi i @
R | - e
T g o mw g
- g pea—_— Ee ]

‘i Frmam T
- fprs el
U
L
*RALTLN
-.“—
e, gy e e
T e fel
dorem fom b g =
= 7 ekl Lok
S R TR
e [T darfae
] (e
e S e |
Item Description
IPP Print Specify whether to enable IPP printing.

Printer Name

Enter the printer name (- _ and up to 127 alphanumeric
characters).

Printer Location

Enter the printer location (up to 127 characters).

Printer Information

Enter the printer information (up to 127 characters).

Printer URI

Displays the URI of the printer that can be used for IPP printing.

Operation Support
Information

Specify the print operations supported by IPP. Setting values:
Print Job, Validate Job, Cancel Job, Get Job Attribute, Get Jobs,
Get Printer Attribute
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Network Tab — SNMP
You can specify the SNMP settings.
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Item Description
SNMP Specify whether to enable SNMP.
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Network Tab — SMB — Print
You can specify the SMP print settings.
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Item Description
SMB Print Specify whether to enable the SMB print (Window print) service.
NetBIOS Name Enter the NetBIOS name (up to 15 characters).
Print Service Name Enter the print service name (up to 13 characters).
Work Group Enter the work group name (up to 15 characters).
Reminder

To apply any changes to settings for “NetBIOS Name”, “Print Service
Name”, or “Work Group?”, restart this machine (turn the main power off,
then on again).

When turning the main power switch OFF then ON, wait for 10 seconds
or longer before turning it ON again, otherwise the copier may not func-
tion normally.
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Network Tab — AppleTalk
You can specify the AppleTalk settings.
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Item Description
AppleTalk Specify whether to enable AppleTalk.
Printer Name Enter the printer name (up to 31 alphanumeric characters,

excluding = ~).

Zone Name Specify the zone name (up to 31 characters).
Current Zone Displays the current zone name.
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Network Tab — SSL/TLS
You can specify the SSL/TLS certificate settings.

Q

Detail
For details on Network Tab—SSL/TLS, refer to the User’s Guide [Net-
work Scanner Operations].

Network Tab — Authentication

You can specify the automatic PageScope Web Connection log off time set-
tings.

Q

Detail
For details on Network Tab—Authentication, refer to the User’s Guide
[Network Scanner Operations] and User’s Guide [Box Operations].
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10.4 Print Job Management

Specifying Job Operations

=  You can specify job operations on this machine by setting a printer
driver.

...

Note

The three printer drivers that can be set on this machine are as follows:
Konica Minolta PCL Printer Driver for Windows

Konica Minolta PostScript Printer Driver for Windows 2000/XP/Server
2003

Konica Minolta Printer Driver for Mac OS X

Specifying Settings (for Windows)

Click the [Properties] button on the Print dialog box to open the printer
driver setup dialog box.

Click the Setup tab (PCL or PostScript driver).

From the “Output Method” drop-down list, select the output method.

Print: Prints immediately.

Secure Print: Enters the ID and password on this machine’s control
panel, then prints. (Up to 100 documents)

Save in User Box: Saves the document to be printed in a box on.
Save in User Box and Print: Saves the document in a box and prints at
the same time.

Proof and Print: After part of the document has been printed, this ma-
chine stops printing temporarily. Select to avoid misprinting a large vol-
ume of print jobs.

C351
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Q

Detail
For details, refer to “Selecting the Output Method” on page 5-12 and
page 6-9.
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Specifying Settings (for Mac OS X)
1 From the “File” menu, select “Print”.
2 Select “Security”.

3 Specify settings for the following:

— Print: Specifies conditions for “Secure Print” and “Box Hold”.

— Secure Print: Enters ID and password when “Secure Print” is se-
lected in “Output Method”. Enter the ID and password on this ma-
chine’s control panel when printing. (Up to 100 documents)

— Save in User Box: Enters file name and box number when “Save in
User Box” or “Save in User Box and Print” is selected in “Output
Method”.

— Proof and Print: After part of the document has been printed, this
machine stops printing temporarily. Select to avoid misprinting a
large volume of print jobs.
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Job Storage

Depending on the printer driver “Output Method” settings, a print document
can be stored in this machine as a print job.

To print a stored job, you must recall the job using this machine’s control
panel.
Recalling Jobs

For details on using the keys on the control panel, refer to the User’s Guide
[Copy Operations]. For details on the box functions of this machine, refer to
the User’s Guide [Box Operations].

Touch [Job List] on this machine’s control panel.

The Print tab appears.

Printing

Waiting

Waiting

Waiting

Waiting

Touch [Held Jobs].

Current
Jobs

C351
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3

Touch [Release Held Job].

The Release Held Job screen appears.

From the job list, select the job whose sample copy is to be printed, se-
lect [Proof Print], and then touch [OK].

— Check the print results on the printed pages.

From the job list, select the job that you want to print.

— To change the settings of the printing conditions, continue with
step 6.

— If you are not changing the settings of the printing conditions, skip
to step 9.

Touch [Change Setting].
The Change Setting screen appears.

— If the job to be removed from the Held Job list is not displayed,
touch [ fa] ] or [ [¢] ] until the desired job is displayed.

— To change the settings of or cancel multiple jobs together, select
one job, and then touch the next jobs.

— Ifanincorrect job was selected, touch the button for the selected
job again to deselect it.

C351
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7 Change the printing conditions on the Change Setting screen, and then
touch [OK].

The Change Setting screen appears again.

8 To apply the changes to the settings, touch [OK].
The Release Held Job screen appears again.
9 Touch [OK].
The stored job is changed to an active job, then printed.

— To cancel printing of the job, touch [Cancel].
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Printing With This Machine When Account Track Settings Have Been
Applied

When the account track settings on this machine have been specified, you
must enter a password when printing a job.

...

Note

If a print job is sent using a department name or password that is not a
registered account on this machine or ifa job is sent without the “Account
Track” check box selected, an error will occur. Check the “Print Log” us-
ing this machine’s control panel.

The three printer drivers that can be set on this machine are as follows:
Konica Minolta PCL Printer Driver for Windows

Konica Minolta PostScript Printer Driver for Windows 2000/XP/Server
2003

Konica Minolta Printer Driver for Mac OS X

C351
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Specifying Settings (for Windows)

1 Click the [Properties] button or the [Preferences] button on the Print di-
alog box to display the Printing Preferences dialog box.

2 Click the Setup tab.
3 Clickthe [User Authentication/Account Track] button.

4 Select the “Account Tack” check box, and then enter the department
name and password.

A default department name can be registered and used instead of en-
tering a department name for each job.
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5 After specifying the settings, click the [OK] button to begin printing.

If the entered department name is a name registered on this machine,
the job is printed and counted as a job for the account.
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Specifying Settings (for Mac OS X)
1 From the “File” menu, select “Print”.
2 Select “Security”.

3 Select the “Account Track” check box, and then specify the depart-
ment name and password.
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Job Operations in PageScope Web Connection

From PageScope Web Connection, you can also check the status of jobs be-
ing performed by this machine.

For details, refer to the following pages.
e “Job Tab — Active Job” on page 10-44
e “Job Tab — Done Job List” on page 10-45
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11.1

Troubleshooting

Unable To Print

This chapter explains the troubleshooting procedures for possible malfunc-

tions.

Perform the troubleshooting procedures described below if this machine
does not print after you have sent a print job.

Symptom

Probable Cause

Action

The message “No
printers are connect-
ed.” or “Print error”
appears.

The printer driver selected for
printing is not compatible with the
printer controller.

Check the printer name selected.

The network cable, parallel cable,
or USB cable is disconnected.

Check that the cable is connected
properly.

An error has occurred in this ma-
chine.

Check this machine’s control
panel.

Available memory space is not
sufficient.

Perform a test print to check
whether printing is possible.

The network cable, parallel cable,
or USB cable is disconnected.

Check that the cable is connected
properly.

An error has occurred in this ma-
chine.

Check this machine’s control
panel.

A postscript error ap-
pears.

Available computer memory
space is not sufficient.

Perform a test print to check
whether printing is possible.

There is an error in the application
software settings.

Refer to the user’s manual of the
application software to check the
settings.

The file printing settings are incor-
rect.

Change the settings and try to
print again.

C351
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Symptom

Probable Cause

Action

The machine does not
start printing although
the print job was com-
pleted on the compu-
ter.

The printer driver selected for
printing is not compatible with the
printer controller.

Check the printer name selected.

The network cable, parallel cable,
or US cable is disconnected.

Check that the cable is connected
properly.

An error has occurred in this ma-
chine.

Check this machine’s control
panel.

A print job is queued in this ma-
chine, delaying printing.

Check the job order on the Active
Jobs list of the machine’s control
panel.

“Save in User Box” was selected
for the print job.

Check if the print job is stored on
the Box screen of this machine’s
control panel.

“Secure Print” was selected for
the print job.

Check if the print job is held on the
Secure Print User Box screen of
this machine’s control panel.

If the account track settings have
been applied, an unregistered de-
partment name (or password)
may have been entered.

Enter the correct department
name (or password).

If the authentication settings have
been applied, an unregistered
user name (or password) may
have been entered.

Enter the correct user name (or
password).

Available computer memory
space is not sufficient.

Perform a test print to check
whether printing is possible.

The connection of this machine to
the network is not yet established
(while connecting to a network).

Consult with the network adminis-
trator.

If the problem persists after all of these procedures have been performed,
read the User’s Guide [Copy Operations].

C351
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11.2 Unable To Specify Desired Settings or Unable To Print
as Specified
Perform these troubleshooting procedures if you cannot specify the desired
settings in the printer driver, or if the print results do not represent the set-
tings that have been specified.
Note
Some of the printer driver functions cannot be combined with other func-
tions.
Symptom Probable Cause Action
A printer driver setting | Some functions cannot be com- | Do not try to select settings that
cannot be selected. bined. are not available.
The “Conflicts” mes- | An incorrect combination of func-| Check the settings and specify
sage with “Unable to | tions has been specified. the functions correctly.
Select” or “Function
Canceled” appears.
Printing is not per- Incorrect settings are specified. Check each setting in the printer
formed as specified. driver.
A combination of functions, al-
though possible in the printer driv-
er, is not possible with this
machine.
The paper size, orientation, and Enter the correct settings in the
other settings specified in the ap- | application.
plication have priority over those
specified in the printer driver.
The watermark cannot | The watermark is not correctly Check the watermark settings.
be printed. set.
The watermark density is set to a | Check the density settings.
level that is too low.
Watermarks cannot be printed in | No watermark can be printed in
graphics applications. this case.
The staple function Stapling is not possible if “Paper | Check each setting in the printer
cannot be specified. Type” is set to “Thick” or “Trans- | driver.
parency”.
The staple function requires op- Install the required optional finish-
tional finisher FS-507 or FS-603. | er and enable it using the printer
driver.
C351 11-3
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Symptom

Probable Cause

Action

Stapling cannot be
performed.

Number of pages that can be sta-
pled when FS-507 is installed: Up
to 50 pages on 8-1/2 x 11 @ or
smaller plain paper, and up to 25
pages on 8-1/2 x 14 or larger pa-
per. Number of pages that can be
stapled when FS-603 is installed:
Upto 50 pages on 8-1/2 x 11 mor
smaller plain paper, and up to 25
pages on 8-1/2 x 14 or larger pa-
per.

Number of pages that can be
center-stapled when FS-603 is in-
stalled: Up to 15 pages of plain
paper.

Change the Copies setting.

Stapling is not possible if the doc-
ument contains pages of different
sizes.

Check the document.

The stapling position
is not as expected.

The orientation setting is not cor-
rect.

Check the stapling position in the
printer driver setup dialog box.

The hole punch func-
tion cannot be speci-
fied.

Hole punching cannot be speci-
fied if “Booklet”, “Transparency”,
“Thick2”, “Thick3”, or “Envelope”
is selected.

Check each setting in the printer
driver.

If optional finisher FS-603 is in-
stalled, the punch kit PK-501 is
required.

Install the required optional finish-
er and enable it using the printer
driver.

The pages are not
punched.

Printed pages may be fed out
without being punched if the pa-
per is loaded into the paper
source with an incorrect orienta-
tion.

Check the orientation setting.

The hole punch posi-
tion is not as expect-
ed.

The orientation setting is not cor-
rect.

Check the punch position on the
Layout tab of the printer driver
setup dialog box.

The formis not printed

properly.

Available computer memory
space is not sufficient.

Simplify the form to reduce the
data size.

The image is not print-

ed properly.

Available computer memory
space is not sufficient.

Simplify the image to reduce the
data size.

Paper is not fed from
the specified paper
source.

Paper will not be fed from the
specified paper source if that pa-
per source is loaded with paper of
a different size or orientation.

Load the paper source with paper
of the appropriate size and orien-
tation.

The access humber
cannot be specified.

To specify access numbers, a
hard disk must be added in the
Option tab of the printer driver.

Add a hard disk in the Option tab
of the printer driver.

C351
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11.3 Error Message

Message

Cause and Remedy

Cannot connect to the
network.

A connection to the network could not be established.

Check if the network cable is correctly connected. In addition,check
that the Network Setting parameters on the Administrator Setting
screen have been correctly specified.
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12.1 Specifications

Item Specifications
Model Built-in printer controller
Power Supply Common with the main body
CPU PPC750 FX 600 MHz
ROM 64 MB
RAM 512 MB
Hard Disk 40 GB
Interface Standard: Ethernet (10Base-T or 100Base-TX)
Optional: USB 1.1, USB 2.0, or IEEE 1284
Frame Type Ethernet 802.2
Ethernet 802.3
Ethernet Il
Ethernet SNAP
Supported Protocols TCP/IP
IPX/SPX
NetBEUI
AppleTalk (EtherTalk)

Print Speed

35 pages/minute (color/monochrome, 8-1/2 x 11 [d paper,
and simplex) 31 pages/minute (color/monochrome, 8-1/2 x
11 [ paper, and duplex)

Fast Print Time

8.5 seconds or less (color and A4 paper)
6.8 seconds or less (monochrome and A4 paper)

Printer Language

PCL5e/c Emulation
PCL6 (XL 2.1) Emulation
PostScript 3 Emulation (3011)

Operating Environment Condi-
tions

Temperature 10 to 35°C
Humidity 15—85% RH

Resolution Data Processing

600 x 600 dpi (printing and fax operations)
400 x 400 dpi (fax operations)
200 x 200 dpi (fax operations)

Printing

600 x 1800 dpi (equivalent)

Supported Paper Sizes

Maximum Standard Size

Printer Fonts

PCL Latin 80 Fonts Postscript 3 Emulation Latin 136 Fonts

Compatible Computers

IBM PC or compatible

Supported Server

Windows NT 4.0, Windows 2000, or Windows Server 2003

Operating -
Systems Client

Windows 98 Second Edition, Windows Me, Windows 2000,
Windows XP, or Windows NT 4.0 (SP6a)
MacOS 9.2 or later or MacOS X 10.2 or 10.3

C351
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Item

Specifications

Printer Driver

PCLS6:

e Windows 98 Second Edition or Windows Me Printer
Driver

* Windows 2000, Windows XP, or Windows 2003 Printer
Driver

¢ Windows NT 4.0 (SP6) Printer Driver

PS3:

Windows 98 Second Edition or Windows Me PPD File

Windows NT 4.0 (SP6)

Windows 2000

Windows XP

Windows Server 20083 Printer Driver

MacOS 9.2 PPD File

MacOS X 10.2 or MacOS X 10.3 Printer Driver

Utility

PageScope Web Connection

Web Browsers:

Microsoft Internet Explorer 6 or later recommended (Java-
Script enabled, Cookies enabled)

Microsoft XML Parser MSXML3.X must be installed when
using Internet Explorer 5.X.

Netscape Navigator 7.02 or later (JavaScript enabled,
Cookies enabled)

J2RE (Java 2 Runtime Environment) required

C351
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KONICA MINOLTA C351
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12.3 Font List

PCL Font List

KONICA MINOLTA C351
PCL Font List P.1
Internal Fonts
Font Pitch/Point Escape Font # Font ID
Courier Scalable  <esc>(01X<esc>(s0pl0h0s0b4099T 00000
CG Times Scalable  <escs (01X<escs(s1pl2v0s0b4101lT 00001
CG Times Bold Scalable <escs(01X<escs(s1pl2v0s3belolT 00002
CG Times Italic Scalable  <escs(01X<escs (s1p12v1s0bal01T 00003
CG Times Bold ltalic Scalable  <escs(0lX<escs (s1p12v1s3bail0iT 00004
CG Omega Scalable  <esc>(0lX<esc>(s1pl2v0s0ball3T 00005
CG Omega Bold Scalable  <escs(0lX<escs (s1pl2v0s3b4ll3T 00006
CG Omega ltalic Scalable  <escs(01X<escs (51pl2vis0ball3T 00007
CG Omega Bold Italic Scalable  <esc>(01X<escs (s1pl2visiball3T 00008
Coronat Scalable  <escs (01X<esc> (s1pl2vls0ball6T 00009
Clarendon Gondensed Scalable  <escs(01X<esc>(s1p12v4s3ba140T 00010
Univers Medium Scalable  <esc»{01lX<esc>(slpl2v0sOba148T 00011
Univers Bold Scalable  <escs(0lX<escs(s1pl2v0s3baleBT 00012
Univers Medium ftalic Scalable  <esc»(0lX<esc>(S1pl2vis0b4148T 00013
Univers Bold Italic Scalable  <escs(01X<escs(s1pl2vlgib4148T 00014
Univers Med. Condensed Scalable  <escs(01K<esc» (s1pl2v4s0b4148T 00015
Univers Bold Condensed Scalable  <escs>(01X<esc> (s1p12v4s3bal4sT 00016
Univers Med. Cond. . Scalable  <escs(01X<escs (s1pl2v5s0bal48T 00017
Univers Bold Cond. It. Scalable <esc>(01X<escs (s1pl2v5s3bel48T 00018
Antique Olive Scalable  <escs(01X<esc>(s1pl2v0s0ba168T 00019
Antigue Olive Bold Scalable  <escs(01X<escs (slpl2v0sib4168T 00020
Antique Olive Italic Scalable  <esc>(01¥<escs (s1pl2vis0bal68T 00021
Garamond Antiqua Scalable <esc»(01X<esc>(s1p12v0s0ba197T 00022
Garamond Halbfett Scalable  <escs(01X<escs (s1pl2v0s3b4al97T 00023
Garamond Kursiv Scalable  <escs (01X<escs (s1pl2vlsobal97T 00024
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PS Font List

KONICA MINOLTA C351

PS Font List .1
Internal Fonts

Font Font #
Albertus MT AlbertusMT 00000
Albertus MT Italic AlbertusMT-Italic 00001
Albertus MT Light AlbertusMT-Light 00002
Antique Olive Roman AntiqueOlive-Roman 00003
Antique Olive Italic AntiqueOQlive-Italic 00004
Antique Olive Bold AntiqueOlive-Bold 00005
Antique Olive Compact AntiqueOlive-Cormpact 00006
Apple Chancery Apple-Chancery 00007
Arial ArialMT 00008
Arial Italic Arial-ltalicMT 00009
Arial Bold Arial-BoldMT 00010
Arial Bold Italic Arial-BoldltalicMT 00011
ITC Avant Garde Gothic Book AvantGarde-Book 00012
ITC Avant Garde Gothic Book Oblique AvantGarde-BookOblique 00013
ITC Avant Garde Gothic Demi AvantGarde-Demi 00014
ITC Avani Garde Gothic Demi Oblique AvantGarde-DemiOblique 00015
Bodoni Roman Bodoni 00016
Bodoni Italic Bodoni-lfalic 00017
Bodoni Bold Bodoni-Bold 00018
Bodoni Bold Italic Bodoni-Bolditalic 00019
Bodoni Poster Bodoni-Poster 00020
Bodoni Poster Compressed Bodoni-PosterCompressed 00021
ITC Bookman Light Bookman-Light 00022
ITC Bookcman Light Italic Bookman-Lightitalic 00023
ITC Bookman Demi Bookman-Demi 00024
ITC Bookman Demi Italic Bookman-Demiltalic 00025
Candid Candid (emulates Carta) 00026
Chicago Chicago 00027
Clarendon Roman Clarendon 00028
Clarendon Bold Clarendon-Bold 00029
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12.4 Glossary

Term

Definition

10Base-T/100Base-TX/
1000Base-TX

An Ethernet standard, which is a cable consisting of twisted copper
wire pairs. The transmission speed of 10Base-T is 10 Mbps, of
100Base-TX is 100 Mbps, and of 1000Base-TX is 1000 Mbps.

AppleTalk

A generic name for the protocol suite developed by Apple Computer
for computer networking.

bit

Abbreviation for Binary Digit. The smallest unit of information (data
quantity) on a computer or printer. Displays data using 0 or 1.

BMP

Abbreviation for Bitmap. A file format for saving image data which
uses the .bmp extension. Commonly used on Windows platforms.
You can specify the color depth from monochrome (2 values) to full
color (16,777,216 colors). Images are not usually compressed when
saved.

BOOTP

Abbreviation for Bootstrap Protocol. A protocol in which a client
computer on a TCP/IP network automatically specifies the network
settings from the server. Currently, DHCP, which is an advanced
protocol based on BOOTP, is mainly used.

Byte

Unit of information (data quantity) on a computer or printer. Config-
ured as 1 byte equals 8 bits.

CMYK

Abbreviation for Cyan, Magenta, Yellow, and Black. The colors in the
toner and ink used for color printing can all be represented by
changing the mixing ratio of the four colors of CMYK.

Default Gateway

A device, such as a computer or router, used as a “gateway” to ac-
cess computers not on the same LAN.

DHCP

Abbreviation for Dynamic Host Configuration Protocol. A protocol in
which a client computer on a TCP/IP network automatically specifies
the network settings from the server. With collective management of
the IP address for DHCP clients on the DHCP server, you can avoid
duplication of an address and you can build a network easily.

DNS

Abbreviation for Domain Name System. A system that acquires the
supported IP addresses from host names in a network environment.
DNS allows the user to access other computers over a network by
specifying host names, instead of difficult to memorize and under-
stand IP addresses.

DPI (dpi)

Abbreviation for Dots Per Inch. A resolution unit used by printers and
scanners. Indicates how many dots per inch are represented in an
image. The higher the value, the higher the resolution.

FTP

Abbreviation for File Transfer Protocol. A protocol for transferring
files over the Internet or an intranet on the TCP/IP network.

HTTP

Abbreviation for HyperText Transfer Protocol. A protocol used to
send and receive data between a Web server and a client (Web
browser). Documents containing images, recordings, and video clips
can be exchanged with the expressive form information.

IEEE 1284

Abbreviation for Institute of Electrical and Electronic Engineers 1284.
A parallel port standard that was developed for printers.
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Term

Definition

IPP

Abbreviation for Internet Printing Protocol. A protocol that sends and
receives print data and controls printers over the Internet on a TCP/
IP network. Data can also be sent to printers in remote areas to print
over the Internet.

IPX/SPX

Abbreviation for Internetwork Packet Exchange/Sequenced Packet
Exchange. A protocol developed by Novel, Inc. that is commonly
used under a NetWare environment.

IP Address

A code (address) that is used to identify individual network devices
over the Internet. A maximum of three digits for four numbers are
displayed such as 192.168.1.10. IP addresses are assigned to devic-
es, including computers, which are connected to the Internet.

LAN

Abbreviation for Local Area Network. A network which connects
computers on the same floor, in the same building, or in neighboring
buildings.

LPR/LPD

Abbreviation for Line Printer Request/Line Printer Daemon. A print-
ing method over a network in a Windows NT system or UNIX system.
Using TCP/IP, you can output print data from Windows or Unix to a
printer over a network.

MAC Address

Abbreviation for Media Access Control address. With a special ID
number for each Ethernet card, data can be sent and received be-
tween the cards. A number consists of 48 bits. The first 24 bits con-
sist of a special number for each manufacture controlling and
assigning |IEEE. The last 24 bits consist of a number that the manu-
facturer assigns uniquely to the card.

NDPS

Abbreviation for Novell Distributed Print Services. Provides a highly
efficient printing solution in an NDS environment. By using the NDPS
as a printer server, you can output from the desired printer, automat-
ically download the printer driver of a newly installed printer, simplify
and automate complicated management environments related to
printer use, and integrate management related to the network print-
er.

NDS

Abbreviation for Novell Directory Services. The servers and printers
on a network and the shared resources of the user’s information, as
well as the user’s access authority over these items can be consoli-
dated in the hierarchy structure.

NetBIOS

Abbreviation for Network Basic Input Output System. A communica-
tion interface developed by IBM.

NetBEUI

Abbreviation for NetBIOS Extended User Interface. A network proto-
col developed by IBM. By simply specifying the computer name, you
can build a small-scale network.

NetWare

Network operating system developed by Novell. NetWare IPX/SPX
is used as the communication protocol.

Nprinter/Rprinter

Remote printer support module for using a printer server under a
NetWare environment. Use NetWare 3.x with Rprinter, and NetWare
4.x with Nprinter.

OHP/OHT

OHP (overhead projector) transparencies which are used for presen-
tations.

0os

Abbreviation for Operating System. Basic software for controlling
the system of a computer.
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PDF Abbreviation for Portable Document Format. An electronically for-
matted document which uses the .pdf extension. Based on the Post-
Script format, you can use the free Adobe Acrobat Reader software
to view documents.

PDL Abbreviation for Page Description Language. The language for spec-
ifying the print image per page to a printer when printing using a
page printer.

PostScript A typical page-descriptive language developed by Adobe and is
commonly used for high quality printing.

PPD Abbreviation for PostScript Printer Description. A file used to de-

scribe the resolution, usable paper size, and the PostScript printer
model special information.

Proxy Server

A server that is installed to act as an intermediary connection be-
tween each client and different servers to effectively ensure security
over the entire system for Internet connections.

Pserver

Print server module under a NetWare environment that monitors,
changes, pauses, restarts, or cancels a print job.

Queue Name

Name specified to each device that allows printing when network
printing.

RIP

Abbreviation for Raster Image Processor. Process that develops pic-
ture images from described text data using the PostScript page de-
scription language. The processor is usually integrated in the printer.

RGB

Abbreviation for Red, Green, and Blue. Represents all colors by
changing the brightness ratio of the RGB 3 colors using the primary
colors used by the color representation in a monitor.

SLP

Abbreviation for Service Location Protocol. A protocol capable of
finding services over a TCP/IP network and automatically specifying
a client.

SMB

Abbreviation for Server Message Block. A protocol that shares files
and printers over a network and which is mainly used by Microsoft
Windows.

SMTP

Abbreviation for Simple Mail Transfer Protocol. A protocol for send-
ing and forwarding e-mail.

SNMP

Abbreviation for Simple Network Management Protocol. A manage-
ment protocol in a network environment using TCP/IP.

TCP/IP

Abbreviation for Transmission Control Protocol/Internet Protocol.
The de facto standard protocol used by the Internet that uses IP ad-
dresses to identify each network device.

TrueType

An outline font that was developed by Apple Computer and Micro-
soft. It is used as a standard by Macintosh and Microsoft Windows
and can be used both on a display and in print.

usB

Abbreviation for Universal Serial Bus. A general interface standard
for connecting a mouse, printer, and other devices to a computer.

Outline Font

A font using lines and curves to display an outline of a character.
Large-size characters can be displayed on a screen or printed with
no jagged edges.

Uninstall

To delete software installed on a computer

Ethernet

LAN transmission line standard
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Print Job Print request transmitted from a computer to a printing device.
Install To install hardware, operating systems, applications, printer drivers

on to a computer

Web Browser

Software such as Internet Explorer and Netscape Navigator for view-
ing Web pages.

Resolution Displays the ability to reproduce the details of images and print mat-
ter correctly.

Color Matching Technology for decreasing the difference in color among different
devices such as scanners, displays, and printers.

Brightness Brightness of a display screen

Queue Name

Required logical printer name for LPD/LPR printing

Shared Printer

A printer setup that allows the printer to be used by multiple comput-
ers connected to a server over a network.

Client A computer that uses the services provided by a server through a
network.

Grayscale Monochrome image expressive form using the gradation information
from black to white

Gateway Hardware and software used as the point where a network is con-

nected to a network. A gateway also changes data formats, ad-
dresses, and protocols according to the connected network.

Subnet Mask

The unit used to divide a TCP/IP network into small networks (sub-
networks). It is used to identify the bits in a network address that are
higher than the IP address.

Screen Font

A font for displaying text and symbols on a CRT monitor.

Spool Abbreviation for Simultaneous Peripheral Operation On-Line. For
printer output, data is not sent directly to the printer, it is temporarily
stored in another location, then sent to the printer collectively.

Driver Software that works as a bridge between a computer and a periph-
eral device.

Hard Disk Large capacity storage device for storing data. The data can be

stored even if the power is turned off.

Parallel Interface

Data transmission method for sending and receiving data of multiple
signals simultaneously. IEEE 1284 is commonly used as the printer
connection.

Peer-to-peer

A network format that allows connected devices to communicate
without using a dedicated server.

Plug-and-play

Ability to automatically find and use the appropriate driver when a
peripheral device is connected to a computer.

Printer Buffer

Memory domain temporarily used for data processing of a print job

Print Queue A software system which queues the generated print job in the de-
vices.

Frame Type Type of communication format used in a NetWare environment.
Communication is not possible if the same frame type is not used.

Preview A function that allows you to view an image before processing a print

or scan job.
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Protocol

The rules that allow computers to communicate with other comput-
ers or peripheral devices

Property

Attribute information

When using a printer driver, various functions can be specified in the
file properties.

In the file properties, you can check the attribute information of the
file.

Profile

Color attribute file

The dedicated file that contains the summarized correlation of the in-
put and output of each primary color used so that the color input and
output devices can reproduce the color.

Host Name

Displayed name of a device over a network.

Memory

Storage device for storing data temporally. When the power is
turned off the data may or may not be erased.

Local Printer

A printer connected to a parallel or USB port of a computer.
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